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Chapter 1: System Overview 
 
 

This chapter provides an overview of the FLIPR® Tetra High Throughput Cellular Screening 

System requirements. 

FLIPR Tetra systems are fluorescence- and luminescence-based microplate readers with an 

integrated 1536-, 384- or 96-pipettor. They perform rapid throughput cell-based assays while 

providing accurate and precise kinetic data. Primary applications include intracellular calcium 

mobilization and membrane potential. In addition, an expanded choice of wavelengths 

enables you to utilize a broad range of fluorescent dyes. 

The FLIPR Tetra system includes: 

Simultaneous 96-, 384- or 1536-well liquid or cell transfer 

Expanded wavelength support 

User-configurable pipettors and optics 

Agile internal plate handling 

Standard, (EMCCD) camera for fluorescence applications or Aequorin, (ICCD) camera for 

fluorescence and luminescence 

Cell suspension option 

Slim platform with minimal facilities requirements. 

An overhead pipettor delivers compound to all wells of the read plate simultaneously. A 

protocol file configured in ScreenWorks® Software—the system-control and analysis 

program for the FLIPR Tetra system—coordinates timing of compound delivery with multiple 

time-point exposures so that the resulting sequence of data points spans compound 

addition. 

ScreenWorks Software displays relative light units versus time for all 1536-, 384- or 96-wells 

on the system’s monitor. Updates occur in real-time as allowed by processing speed. Data 

can be exported as relative light units over time (time sequence), or as a single value per well 

(statistic). Export data files are in ASCII text file format for input into spreadsheet or database 

programs. 
 

Fluorescence Mode 

In fluorescence mode the system’s LEDs illuminate the bottom of a 1536-, 384- or 96-well 

‘read’ plate containing cells loaded with fluorescent dye, and measure the fluorescence in 

each well. By taking a sequence of measurements in conjunction with compound 

application, changes in fluorescence emission characteristics due to the binding of particular 

ions (for example, Ca2+, H+ or Na+) can be tracked. 

1 
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Light-emitting diodes (LEDs) in the FLIPR Tetra system produce light at distinct wavelength 

ranges to excite the fluorescent dye that has been added to the cells in the read plate wells. 

The entire well plate bottom is illuminated. Fluorescent light emitted by the dye—again, for 

the entire plate—passes through an emission filter before being captured in a CCD camera, 

standard EMCCD or Aequorin ICCD. Fluorescence is measured from each well independently, 

and converted into a numerical value. The FLIPR Tetra system can be configured with two 

LED banks and three emission filters, allowing the software configuration of up to four 

excitation/emission wavelength combinations (‘read modes’). Up to four different 

fluorescence effects can be measured within a single experiment. 
 

Luminescence Mode 

The FLIPR Tetra system also provides luminescence mode with the Aequorin, ICCD camera 

option. The instrument has a light-tight enclosure so that it can operate in luminescence 

mode and a specialized high-sensitivity ICCD camera can be installed in place of the standard 

EMCCD camera. The ICCD camera is mounted directly beneath the read plate, so images are 

taken of the entire bottom of the plate. For cell suspension experiments, an integrated Cell 

Reservoir allows uniform cell suspension to be pipetted directly into the read plate. From the 

3 filter positions available on FLIPR Tetra system, it is recommended to have one open 

position, so no filter will be used during luminescence assay. 

As with fluorescence, luminescence is measured from each well independently, and 

converted into a numerical value. 
 

System Requirements 

This section provides a brief overview of electrical, physical and environmental requirements 

of the FLIPR Tetra system. 

Electrical 

The FLIPR Tetra system consumes 5 A continuous and 9 A peak of 110 V power and requires 

90-240 VAC power source at 50-60 Hz which equates to 2.5 A continuous and up to 4.5 A peak 

at 240 VAC/50 Hz. The system is supplied with a power cord appropriate for the country it 

was shipped to. Additional shared outlets are required for computer and monitor. A power 

strip is acceptable for providing the additional outlets for the computer and monitor. 

Minimum Space 

System dimensions are as follows: 

Without Cell Suspension Module or TETRAcycler™: approximately 39 inches wide x 

27 inches deep x 70 inches high (991 mm wide x 686 mm deep x 1780 mm high). 

With Cell Suspension Module and TETRAcycler: approximately 53 inches wide x 27 inches 

deep x 70 inches high (1346 mm wide x 686 mm deep x 1780 mm high). 
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The FLIPR Tetra system is designed with rolling castors so it can be readily moved to make 

necessary adjustments and perform maintenance. Leveling feet are also installed on the 

lower instrument chassis. These feet are typically used for stabilizing the instrument when 

integrated with a robot, but can also be used to establish a uniform instrument deck level in 

situations where the lab floor is not flat. When running an experiment, please make sure the 

instrument’s feet are lowered and leveled. 

The computer and monitor are mounted to the right front side of the instrument with the 

included clamp, requiring a minimum lab space of 73 inches (1.85 m) wide x 82 inches 

(2.08 m) deep for maneuverability. 

A chiller with dimensions 11 inches wide by 13 inches deep x 13 inches high (279 mm x 

330 mm x 330 mm) is connected via a 3-foot (914 mm) long tube to the right side of the 

instrument. It can be placed anywhere within that 3-foot radius as long as the user has 

access to the on/off button on the chiller. 

A minimum 25 inch (635 mm) square footprint for tip wash bottles is required to the right 

side of the instrument. 

The cabinet should have a user access space of 48 inches (1.22 m) in front x 24 inches 

(610 mm) behind x 10 inches (254 mm) to the left for servicing the instrument. 
 

Ensure adequate personnel are present when installing or moving the system. 
Follow all necessary safety precautions and use proper moving techniques. 

WARNING! The FLIPR Tetra system can weigh as much as 860 lbs (390 kg). 
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Chapter 2: System Hardware Features 
 
 

The FLIPR Tetra system consists of a cabinet 39 inches (965 mm) wide x 27 inches (686 mm) 

deep x 70 inches (1780 mm) high, with a number of components, including wash bottles, Cell 

Suspension module, chiller, host computer and monitor, outside the cabinet. 

The cabinet has two compartments, top and bottom, accessed by manual doors on the 

front of the cabinet. 

A ‘five-position stage’ located in the top compartment is where read and source plates are 

positioned during an experiment. There are also positions for tips and tip washing, as well as 

the Cell Suspension reservoir. 

The TETRAcycler™ plate shuttle on the back wall of the top compartment can be used for 

robotically controlled carriage of compound or read plates and tips in and out of the cabinet 

during experiments. Plates are delivered to and from a landing pad outside the cabinet on 

the left hand side. 

Mounted on the back wall of the top compartment, above the TETRAcycler, is the pipettor. 

The pipettor transfers compounds from source plates to the read plate, and accesses the tip 

loading and tip washing positions. When the Cell Suspension option is installed, the pipettor 

also transfers cells in suspension from the Cell Reservoir to the read plate. 

The bottom, ‘dry’, compartment, houses the FLIPR Tetra system optics and an embedded 

computer for control of basic system functions. Two LED excitation modules, to the left and 

right, direct light up onto the base of the read plate, in the five-position stage above. Light 

emitted from the read plate passes down through emission filters directly below the plate to 

the camera (either the Standard EMCCD camera or the Aequorin ICCD camera). 

The system computer, running ScreenWorks Software, through which all user interaction 

with the system occurs, is attached to the outside right-hand side of the cabinet. Monitor 

and keyboard are on an adjustable arm attached on the right-hand side of the cabinet front. 

The Cell Suspension module, if installed, is also mounted on the lower right side of the 

instrument. This external module keeps the cells in suspension and is connected via internal 

tubing to a Cell Reservoir that is installed in Position 4 (Source Plate 3). The cells are kept in 

suspension via stirring and are pumped into the reservoir for transfer to the read plate. Up 

to 4 additional fluid bottles can also be connected to the reservoir for cleaning purposes. 

Containers for tip washer fill fluid and waste are placed outside the cabinet beneath the 

computer. 

2 
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Figure 2-1: Diagram of the complete FLIPR Tetra system 

Further information on these subsystems is presented in the following sections. 
 

Plate-Handling System 

Five-Position Stage 

For an experiment, read and source plates are placed in the five-position stage in the upper 

compartment of the FLIPR Tetra system, where the pipettor is able to transfer compound 

between them. Plates can be loaded manually through the upper compartment door, prior 

to an experiment, or robotically, as the experiment proceeds , using the TETRAcycler. 

The five positions of the stage are, from left to right: 

Position 1: Tips and/or Source Plate 1 

Position 2: Source Plate 2 

Position 3: Read Plate 

Position 4: Cell Reservoir and/or Source Plate 3 

Position 5: Tip Washer 
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Figure 2-2: The five-position stage 

Positions 1, 2 and 4 take standard, low volume, deep well and reservoir source addition 

plates. 

Tip loading and unloading occurs in Position 1, but this position can double as a source plate 

position once tips are removed. 

Position 3 opens to the optics chamber below for excitation of fluorophores in read plate 

wells and emission reading. 

Position 4 can be used for the Cell Reservoir included with the Cell Suspension option. A 

single Cell Reservoir is compatible with all of the FLIPR Tetra system pipettor heads. When 

the Cell Reservoir is not present, this position can be used as a source plate position. 

Positions 1–4 have a mechanical plate sensor to identify the presence of plates, tips or 

reservoirs. 

Robotic integration enables the TETRAcycler to exchange up to 12 source plates and tip 

racks, and one read plate, in an experiment. 

A dedicated tip wash reservoir is located in Position 5 and should be configured to match 

respective pipettor heads (96, 384 or 1536). Appropriate tip wash reservoirs are included in 

the purchase of a pipettor head. Specific hardware components associated with tip washing 

are described in Tip and Pin Tool Washing on page 24. 
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Plates and tip racks are registered with well A1 in the lower left-hand corner using a plate 

indexer found in Positions 1–4. The indexers also serve as mechanical sensors to detect plate 

or tip presence. If plates or tips are not present in a Manual Mode experiment, but 

requested by software, the instrument stops and ends the experiment. During Remote 

Mode, the system notifies the SynchroMax™ ET or third-party plate-handler that no plate or 

tip container is present and stops the instrument until plates or tips are detected. It is then 

the responsibility of the SynchroMax ET or third-party plate-handler to deliver plates or tips 

to the system. 
 

Note: Sensors can only detect plate or tip container presence. They cannot identify 

the type of plate or tips. It your responsibility to ensure that the correct plates and 

tips are loaded into position. 
 

Temperature Regulation 

Positions 1, 2 and 4, for source plates, have optional temperature control. Temperature 

settings range from ambient 5 °C (41°F) to 40 °C (104°F) . Equilibrium temperature may take 

approximately 15 minutes to reach the set temperature. 

Configure temperature regulation with the Temperature Control ON/OFF toggle command 

in the Instrument > Manual Operation menu or corresponding button. 
 

 

Plates 

FLIPR Tetra system accepts 96-, 384- and 1536-well plates that conform to the proposed ANSI 

standards submitted by the Society for Biomolecular Sciences. A sample of suitable source 

and read plates is provided in Consumables and Accessories on page 245. 

Black walled, clear-bottomed read plates provide an optimal imaging environment for 

fluorescence assays. These plates prevent signal diffraction while allowing excitation and 

signal access. Black walled, clear-bottomed plates or white walled plates can be used for 

luminescence assays. 

For 96-well read plates, an optional slit-shaped mask can be used to minimize saturation and 

edge effects associated with these plates. Simply place the mask over the read position. See 

Consumables and Accessories on page 245 for types of masks available. 

No mask is required for 1536- and 384-well plates. 

Note: The FLIPR Tetra system does not have humidified air flow. 
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Instrument Status Panel 

The Instrument Status panel, located next to the upper door handle, indicates whether or 

not the instrument is running and safe to open. It includes an emergency Interrupt button 

to stop any processes. 

Figure 2-3: The Instrument Status panel 

The panel has two lights as well as the Interrupt button. From the top of the panel these are: 

Assay Running (Locked)—Yellow light 

The FLIPR Tetra system is performing a task. The upper and lower doors are locked until 
the task finishes or is stopped using the Interrupt button. 

Assay Finished (Unlocked)—Green light 

No tasks are being run and it is safe to open the upper and lower instrument doors. 

Interrupt—Flashing yellow light then green light 

A system override to stop all tasks, so you can access the instrument. If pressed the 

yellow light flashes until the system has reached a safe state to open the doors, when 

the green light comes on. 

 

CAUTION! The Interrupt button immediately ends the experiment and should only be 

used in emergencies. The system might need to be reinitialized by selecting Reset  

from the Instrument menu prior to resuming normal instrument function. 
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Manual Mode 

In manual operation all assay components must be positioned in the five-position stage by 

hand, through the upper manual door, prior to running an experiment. Once the experiment 

starts no further plate or tip changes can be made. If you need to exchange plates or tips 

during an experiment then you must run the FLIPR Tetra system in Remote Mode, using the 

TETRAcycler to replace used tips or plates. 

The FLIPR Tetra system always starts in Manual Mode. Toggle between manual and remote 

modes with the Set Manual Mode and Set Remote Mode commands in the Instrument 

menu, or use the software buttons available. 

In Manual Mode, the TETRAcycler gripper parks itself on the plate-landing pad. 
 

Note: The top compartment door should remain closed during normal system 

operation. Do not operate the instrument if the door is open. All system functions 

halt when the door is open. 
 

Robot Integration 

To increase the number of plates you can use in an experiment (and minimize personnel 

requirements), use the TETRAcycler internal plate handler coupled with the SynchroMax ET 

or a third-party plate handler (for example, stacker system or robotic arm). One read and up 

to 12 source plates and tip racks can be shuttled in and out of the FLIPR Tetra system in one 

experiment with this method. 

When using automated delivery the SynchroMax ET or third-party plate handler delivers 

plates to, and picks them up from, the landing pad on the outside left of the instrument, 

from where the TETRAcycler shuttles them in and out of the read compartment. The shuttle 

door over the landing pad opens and closes to maintain a light-tight environment within the 

compartment. 

During automated operation the SynchroMax ET or third-party plate handler controls the 

FLIPR Tetra system by sending instructions to load protocols, run experiments, and retrieve 

plates from the landing pad. These commands are executed immediately upon receipt by the 

instrument. Persisting instrument settings cannot be made from the remote controlling 

program—these must be configured in ScreenWorks Software before control is passed to 

the plate-delivery system. 

To pass control to the plate-delivery software select Set Remote Mode in the Instrument 

menu in ScreenWorks Software. The FLIPR Tetra system remains in remote control until Set 

Manual Mode is pressed. 

The third-party plate handler software communicates with theFLIPR Tetra system computer 

via the serial communication port using TCP/IP. SynchroMax ET software is installed with 

ScreenWorks Software on the FLIPR Tetra system computer so it is able to communicate 

directly with the instrument. See Robotic Integration on page 189 for remote control syntax. 



Chapter 2: System Hardware Features 

0112-0109 K 17 

 

 

 

 

TETRAcycler™ 

The TETRAcycler is a plate gripper that runs along the back wall of the upper read 

compartment, giving it access to Positions 1–4 in the five-position stage and the landing pad 

on the outer left-hand side of the cabinet. It shifts source plates and tip containers between 

these locations when under the control of the SynchroMax ET or a third-party plate handler 

(see above). 

The TETRAcycler carries standard, low volume and deep well 96-, 384- and 1536-well plates 

that conform to propose ANSI standards submitted by the Society for Biomolecular Sciences. 

In addition, the TETRAcycler handles Molecular Devices qualified tips. Reservoirs can be used 

during robotic integration, however the TETRAcycler is not able to move these. All reservoirs 

must be loaded manually prior to running an experiment, including the Cell Reservoir. 
 

Note: While the system is compatible with plates that conform to proposed ANSI 

standards submitted by the Society for Biomolecular Sciences, some plates may not 

be handled as reliably by the TETRAcycler due to their low plate weight. During robotic 

integration, it is recommended that handling of the plates and tips by the TETRAcycler 

be evaluated for plate handling robustness prior to starting a screen. 

The upper and lower door of the FLIPR Tetra system must remain closed for the duration of 

the experiment. Plates are transported in and out of the instrument only by the TETRAcycler 

system robotic landing pad door. 
 

cause injury. 
 

 

SynchroMax ET™ 

The SynchroMax ET is a six-stack plate handler available as an optional purchase with the 

FLIPR Tetra system. It delivers plates to and from the landing pad, integrating with the 

TETRAcycler, which ferries the plates to and from their appropriate locations in the five- 

position stage. The configuration interface of the SynchroMax ET software is opened directly 

from within ScreenWorks Software, making experiment configuration straightforward. 

Observation Panel 

In order to view hardware movements in the upper top compartment while troubleshooting 

the FLIPR Tetra system, use the observation panel. Under normal operating conditions the 

upper door must be closed in order to run an experiment, ensuring no light enters the 

chamber. When the observation panel is mounted to the chamber, however, the door can 

be left open, allowing you to view movements of the pipettor and TETRAcycler. Normal 

instrument control is performed via ScreenWorks Software, SynchroMax ET, or third-party 

plate handling software. For the Aequorin ICCD camera test images are displayed. 

The observation panel is stored attached to the inside of the upper door. To mount the 

panel, remove it from the door and attach it with the four captive thumbscrews to the top 

compartment frame. 

WARNING! Do not place your fingers in the TETRAcycler shuttle door as this can 
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To acquire quality data, reaffix the observation panel to the inner door prior to running an 

experiment. 
 

camera, DO NOT touch the white door switches. Room light will damage the 
Intensifier. The door switches detect the open door to protect the camera. 

 

Note: The observation panel should only be used to view internal pipettor 

movement. It should not be used during experiments when data is being 

accumulated. Test data (in the case of the Aequorin ICCD camera) or compromised 

data (with the Standard camera) shows if not collected under dark conditions with 

closed doors. 
 

Liquid-Handling System 

Compounds are transferred from source plates or reservoir to read plates by the pipettor 

mounted on the rear wall of the top compartment, above the TETRAcycler. The pipettor 

assembly can be fitted with a standard pipettor head, to use disposable tips, or a pin tool 

head, which uses solid or slotted pins to carry compound. 

All 1536, 384, or 96 tips or pins operate at the same time, simultaneously picking up 

compound from all the wells in a source plate (or a quarter of the wells; see Compatible Plate 

Configurations on page 23) or Cell Reservoir, and similarly dispensing these simultaneously 

to the read plate. Fluid mixing steps can be configured for source plates before compound is 

picked up, and for read plates once it has been dispensed. 

Pipettor heads are user-installable and can be interchanged in approximately less than 5 

minutes; see Exchanging Pipettor and Pin Tool Heads on page 105. 

Standard Pipettor Head 

Standard pipettor heads are available in 1536-, 384- and 96-tip formats. 

The 384- and 96-pipettor heads both use disposable plastic tips. In contrast, the 1536- 

pipettor head uses a stainless steel tip block with a disposable 1536-tip gasket. 

Plastic tips can be washed or replaced between each compound addition or at the end of an 

experiment. The 1536-tip block is washed at specified times. 

Pipettor operations are controlled from within ScreenWorks Software protocols, or some 

operations, for example, loading tips, can be performed individually, directly through 

commands in the Instrument menu. Connectors on the back of the pipettor head identify 

the head format as 1536, 384, or 96 tips, so ScreenWorks Software only offers valid plate 

formats and pipetting parameters for protocol setup. 

The standard pipettor head uses air displacement to control aspiration and dispense speed 

and volume. The volume of compound to be transferred is configured in the software, and it 

is possible to draw compound from multiple source plates to dispense into one destination 

plate, or to aspirate from one plate and dispense to multiple well plates or quadrants. 

WARNING! If pretending to run in luminescence mode with the Aequorin ICCD 
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The 96- and 384-pipettor heads displace air in the disposable pipette tips. In the 1536- 

pipettor head a plunger for each of the 1536 tips presses against an elastic gasket seated on 

the tip block. When the plungers move down they create an initial seal between the gasket 

and tip block. Once the seal is created, further plunger movement causes air displacement in 

the tip block. 

Figure 2-4: Seal creation in the 1536-pipettor head 

Minimum pipettor precision is as follows: 

3% for 75 µL additions (96-well). 

4% for 25 µL additions (384-well) 

6% for 3 µL additions (1536-well) 

Performance is dependent on tip/gasket seating and can be compromised if the seal is 

broken. Use only Molecular Devices recommended tips and gaskets to ensure the highest 

accuracy and to reduce the possibility of damaging the pipettor. See Consumables and 

Accessories on page 245 for recommended tips. 
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Cell Suspension 

The Cell Suspension option consists of two components: 

The Cell Reservoir installable in Position 4 (Source 3) in the 5 position stage. 

The Cell Suspension module located externally on the right side of the instrument. 

The Cell Reservoir (see Figure 2-5) is user installable. The Cell Suspension module (see Figure 

2-6) consists of a shelf with a magnetic motor mounted underneath it, a cell flask with a 

magnetic stirrer, up to four fluid bottles for automated cleaning, and a removable cover for 

keeping cells in a dark environment. 

Figure 2-7 demonstrates how the system is connected and shows all the possible 

combinations for protocol development. 

 

Figure 2-5: Cell Reservoir 

The Cell Reservoir, which the user places in a source plate location, is filled from any of the 

bottles in the external Cell Suspension module by a pump with adjustable speed and 

direction. 

The Cell Reservoir is a special plate type that has one fluid line used for both input and 

output, and an electronic plate ID that is part of the electrical/fluidic connector which 

identifies the reservoir to the system. In the case of an overflow, an overflow trough catches 

excess fluid and pipes it to the tip washer overflow trough, which directs it to the overflow 

bottle. The reservoir is also autoclavable for cleaning purposes. 

The spinner flask contains a stirrer, which is driven by a magnetically coupled motor 

mounted in the lower part of the Cell Suspension module. The Cell Suspension stir speed can 

be set in a protocol or with manual instrument controls. Stir speed of 5 equals approximately 

1 revolution per second. From the uniform suspension in the spinner flask cells are pumped 

into the Cell Reservoir, where the pipettor head in 96, 384, or 1536 format removes the 

appropriate amount and cells are automatically pumped to a specified destination. A 

protocol in ScreenWorks Software controls the stir speed and source/destination of cell 

suspension activity. 

The cell valve selects the source for filling, or the destination for draining. There are 8 valve 

positions: flask fill (for filling the reservoir), flask drain (for draining the reservoir without 

causing air bubbles), Waste Bottle A, Waste Bottle B, and Fluid 1–4. 
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Fluid 1–4 are user specifiable, and can be cleaning solutions, water or buffer. The user can 

choose to pump cells back into the cell flask or to any other fluid bottles. Bottles for Fluid 1 

and 2 are automatically included with the Cell Suspension option. 

Cell Reservoir can be washed by either adding the Wash Reservoir process to the protocol 

(see Constructing Protocols Using FLIPR Tetra Processes on page 57), selecting Wash 

Reservoir in the Instrument > Manual Operation menu, or manually removing the reservoir 

and autoclaving it. 

Figure 2-6: Cell Suspension Module 
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Figure 2-7: Cell Suspension Module connections 

Pin Tool Head 

Pin tools are blocks of solid or slotted pins, where the pins replace the hollow tips used with 

a standard pipettor. The pins use capillary action to pick up and transfer liquid from one 

plate to another. Their ability to accurately and reliably transfer compounds in nanoliter 

volumes allows users to supply test compounds in 100% DMSO solution, removing the need 

to prepare intermediate dilution plates. 

The volume that each pin picks up is determined by the size of the pin (and, if slotted, the 

size of the slot) and the withdrawal speed of the pin from the liquid—a faster removal speed 

leaves more liquid on the pin. 

Pins for the 384 pin tool are supplied in four sizes, giving a total range (across all these sizes) 

from 84 nL to 656 nL. The 1536 pin tool has seven different pin sizes, giving a total range from 

19 nL to 117 nL. 

Each pin size has a specified volume range that it carries: 

The lowest reported volume is for a tip removal speed of 7.8 mm/s. 

The highest reported volume is for a tip removal speed of 57.0 mm/s. 

The precise volumes that will be picked up at given tip removal speeds should be determined 
by users in assay development. 
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The FLIPR Tetra system can be fitted with 384- or 1536-pin tool heads. Pin tools themselves, 

in the appropriate 384 or 1536 format, can be easily and rapidly replaced to change the pin 

size. 

All the pin tools used with the FLIPR Tetra system are available with a hydrophobic and 

lipophobic coating to prevent or reduce the nonspecific binding of proteins and lipids to the 

pins. 

In order to ensure uniform compound pick-up across the entire pin tool, pins can be 

configured to ‘float’ in source plate wells. Individual pins are not rigidly attached to the pin 

block, having a small amount of vertical movement up into the block. When set to float, the 

pin head moves down very low so that all pins sit on the bottom of the well and push up a 

little into the block. This ensures that all pins are equally immersed in their wells, for 

example, sitting on the bottom. This outcome could not be guaranteed if the pins were 

rigidly fixed to the block, given that plate bottoms are often not completely flat. 

Compatible Plate Configurations 

The 96- and 384-pipettor heads can be used with source or read plates with equal or one 

order higher well number. This is because the FLIPR Tetra system can aspirate or dispense 

into quadrants of a plate. The following combinations are possible: 

The 96-pipettor head can be used with 96- and 384-well plates. 

The 384-pipettor and pin tool head can be used with 384- and 1536-well plates. 

The 1536-pipettor head can be used only with 1536-well plates. 

Deep-well plates or reservoirs can be substituted for standard well plates. 

When compound is aspirated or delivered to a plate with a greater number of wells than the 

pipettor head, the quadrant number (1 to 4) must be entered in the protocol configuration 

in ScreenWorks Software for each dispense. 

Tip and Pin Tool Loading 

For all pipettor and pin tool heads, a sensor informs the software whether or not tips or a pin 

tool are loaded. If desired, at the start of an experiment, tips or a pin tool can be 

automatically loaded onto the pipettor head by selecting Load Tips Position in the Settings 

process. Otherwise, tip and pin tool loading or unloading must be requested as independent 

operations from the Instrument > Manual Operation menu. Directions for installation of the 

1536 tip gasket are given in Exchanging the 1536 Tip Gasket on page 113. 

Tip and pin tool loading steps can be programmed to occur between fluid transfers within 

experiment protocols. 



FLIPR Tetra High Throughput Cellular Screening System User Guide 

24 0112-0109 K 

 

 

 

 

Tip and Pin Tool Washing 

Tip or pin tool washing is controlled with the Wash Tips or Wash Pins process in 

ScreenWorks Software protocols and can be performed between fluid transfers within an 

experiment, or after the last fluid transfer, to prepare tips for the next experiment. 

Disposable tips, as well as the 1536-tip head, and 384- and 1536-pin tools, can be washed. 

The washer consists of a reservoir top of the selected pipettor format, mounted over a wash 

basin. Detailed instructions for exchanging the reservoir top are located in Uninstalling Wash 

Reservoir Top on page 111. The wash basin is connected to two solvent-supply carboys and 

two waste carboys located on the floor beneath the computer monitor. A basin beneath the 

tip washer base drains to a waste carboy, to safely remove any solvent that overflows from 

the reservoir. 

Wash solution fills the reservoir for a calibrated amount of time. Solvent is then drained from 

the reservoir after each wash cycle. Up to five wash cycles can be configured within a single 

wash process. For tips, a user-set volume of solvent is drawn up, optionally held for a time, 

and then expelled, up to 20 times. For pins, vertical motion of the tip block is used to agitate 

the wash solvent around the pins. The option is available to wash tips or pins in up to two 

solutions before reusing the tip washer. When additional wash solutions are required, tips or 

pins can be washed in a boat or reservoir, located in one of the source plate positions, using 

the Mix Fluid process. 
 

chamber may cause explosive conditions. Use of 100% isopropanol, etc., in the tip 

washer is particularly discouraged without additional ventilation. Consult your 

facilities expert to determine the appropriate ventilation to avoid explosive 

conditions. 

Pin tools are supplied with blotting stations that can be loaded into one of the plate 

positions. Blot pin steps can be configured in the protocol to remove fluid from the pins, for 

example, following pin washing. 
 

Note: A waste bottle sensor override (P/N 0700-0827) is available in the 

FLIPR Tetra system accessory kit to bypass the waste sensor and dispose waste in 

containers other than the dedicated waste carboys. 

WARNING! High volumes of volatile, flammable solvents in the reading 
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Optical System 

The FLIPR Tetra system optics are housed in the bottom compartment of the main cabinet. 

In fluorescence assays, where excitation is required, light from light-emitting diodes (LEDs) is 

directed at the base of the read plate exposed in position 3 in the 5-position stage above. 

Light emitted from the plate travels down through emission filters before being captured in 

the CCD camera. 

Figure 2-8: System Optics 

CCD Camera Options 

Two camera options are available for purchase with the FLIPR Tetra system. A standard, 

EMCCD (Electron Multiplying CCD) camera is recommended for fluorescence only 

experiments, while the more sensitive Aequorin ICCD (Intensified CCD) camera is designed 

for both fluorescence as well as luminescence assays. 
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Standard EMCCD Camera 

The CCD camera is located directly beneath the read plate on the five-position stage. The 

camera is thermoelectrically cooled and requires about five minutes to reach its operating 

temperature of -60°C (-76°F) ± 2 °C (35.6°F). 
 

temperature—this will result in noisy data. Check the camera temperature on the 
Instrument Status panel before starting an experiment. 

The camera uses frame-transfer technology that shifts pixel values from the exposed portion 

of the chip to the data processing portion. This method allows a high acquisition rate and 

eliminates the possibility of camera shutter failure. 

The camera is an integrating-type detector using temporal integration to build up the signal- 

to-noise ratio. Depending on the intensity of the emitted light (reliant on dye efficiency and 

LED power), it may be necessary to use longer camera exposures. This prevents the 

measured fluorescence signal from being dominated by detector noise. 

Images are taken of the bottom of the entire plate for a time specified in the ScreenWorks 

Software protocol; exposure time can be set from 0.05 to 30 seconds. In ratiometric 

experiments for example, where two or more wavelengths are measured, the number of 

images captured increases so that an image is taken for each wavelength at the specified 

rate. From each image a relative light value is calculated for each well. The FLIPR Tetra system 

reports relative light units (RLUs) in a range from zero to approximately 12,000. 
 

Note: Relative light units in the FLIPR Tetra system do not have the same value as 

those of previous FLIPR Tetra systems. 

The light intensity detected by each pixel on the CCD chip can be amplified using the Gain 

setting in ScreenWorks Software (Settings Process). This parameter has a range from zero to 

240. Amplification is exponential, with increments increasing as you go higher up the range. 

Fluorescence assays typically use a gain of 130 whereas luminescence assays should use 200 

as a starting point. Gain optimization should be done during assay development to 

determine optimal conditions for your screen. 

When a luminescence experiment follows a fluorescence experiment we recommend that 

you cycle the camera temperature to eliminate ghost images that may have been created 

during the fluorescence assay. Select Cycle Camera Temperature from the Instrument > 

Manual Operation menu to choose this option. The camera warms up to room temperature 

to release ghost images, prior to cooling back down to approximately -60 °C (-76°F). 
 

Note: Luminescence readings continue to be available with the Standard, EMCCD 

camera option, however camera sensitivity is not optimal for this type of experiment. 

WARNING! Do not use the camera before it has reached its operating 
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Aequorin ICCD Camera 

When this option is selected instead of the Standard camera, the ICCD camera is mounted 

directly beneath the read plate on the five-position stage, although at a slightly different 

height then the Standard EMCCD camera. This camera operates at -20 °C (-4°F) and requires 

about 5 minutes to reach that temperature. 
 

Note: The instrument will detect an error if the user tries to operate the instrument 

with the camera out of its recommended temperature range of 

-20 °C (-4°F) ± 5 °C (-41°F). 

Similar to the Standard camera, the Aequorin camera also uses frame-transfer technology 

that shifts pixel values from the exposed portion of the chip to the data processing portion. 

In this camera, however, the signal is enhanced prior to reaching the CCD chip: it is amplified 

in the intensifier. Using this method there is less noise and therefore the camera is 

significantly more sensitive then the Standard EMCCD camera. 

When using the Aequorin ICCD camera images are taken of the bottom of the plate, 

amplified in the intensifier and transferred via a fiber optic taper to the CCD chip. The gain 

control of the intensifier allows for bright signal from fluorescence as well as dim signal from 

luminescence to be enhanced accordingly, so as to provide the best signal and not saturate 

the CCD chip below. In Fluorescence mode the Gain is preset to 2000, whereas in 

Luminescence mode the Gain defaults to 280,000, but can be lowered in the event that the 

luminescence assay is very bright. 

This camera has a Gate Open % feature, adjustable in Fluorescence mode only. This feature 

controls how long the intensifier is on for each of the frames collected during the exposure 

time. This controls the signal intensity of the assay. 

The recommended value range for the ICCD camera is 40,000 to 50,000 (at maximum signal). 

This camera does not require temperature cycling when changing between Fluorescence and 

Luminescence modes. 

Both Cameras 

Once calculated, RLUs are displayed in real time in the ScreenWorks Software Analysis 

process window (within the limits of computer processing speed). Data for one wavelength 

(for example, Read mode), for all 1536, 384 or 96 wells of the read plate, are displayed in the 

Multi-Well Graph on the right side of this view. The Detail Graph can be populated by 

selecting wells in the Multi-well graph. When an experiment is completed, post-assay 

analysis can be done via ScreenWorks Software, or data can be exported. 

In normal operation images are discarded once RLU values have been measured. However, 

for quality control purposes, users can define the number of images per Read with Transfer 

Fluid step. Up to 100 images per experiment can be retained. These images can be useful for 

troubleshooting problems, such as cells  lifting from well bottoms during compound 

addition. Images are saved as *.tif files with the same name and to the same directory as the 

data file. They can be viewed by clicking the Image button in the Analysis process page when 

the resulting data file is open in ScreenWorks Software. 
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Note: The robustness of an assay is not dependent on the size of the signal. It is 

better determined by the signal-to-noise ratio. A commonly used calculation for 

determining assay robustness is the Z’ factor equation. 
 

LED Modules 

The FLIPR Tetra system has a total of four LED banks providing illumination for plate reading. 

The LED banks pulse on, two at a time, only when an image is to be captured, protecting cells 

from possible dye photo-bleaching. 

The LED banks are divided between two modules, one on either side of the read plate 

position above. LED banks in corresponding positions in either module are paired. The 

paired LED banks pulse simultaneously during an experiment, so that light strikes the read 

plate base from two directions, helping to ensure that the entire plate is maximally 

illuminated. 

Typically, the two LED bank pairs are set up with LEDs of different wavelengths, for example., 

one pair might have LEDs of range 470 nm to 495 nm, while the other pair might be 510 nm 

to 545 nm. Ratiometric experiments can be set up to use both of these wavelengths, in which 

case the paired banks fire alternately. 
 

Note: Despite the two excitation wavelengths firing alternately, output data files show 

time points for each as occurring simultaneously. 

Deflectors around the LED banks direct all light from the LEDs through excitation bandpass 

filters that further refine the wavelength. The light is then funneled into light pipes that focus 

it onto the base of the read plate. 

The FLIPR Tetra system will not operate without the full complement of LED banks installed, 

however blank LED banks can be used for one pair if only one excitation wavelength is 

available. Unless additional LED banks are ordered with a purchase, FLIPR Tetra systems are 

shipped with a set of default calcium LED banks (470–495 nm) and a set of blank LED banks. 

Configuration of LEDs for an experiment is mostly carried out in ScreenWorks Software in the 

Settings window; see Setup Read Mode on page 59 for details. LED banks can be changed by 

the user in approximately 10 minutes; refer to Exchanging LED Modules on page 116 for 

instructions. 

LEDs do not need time to warm up prior to running an experiment. Startup time is only 

dependent on the time it takes for the camera to cool down and for the stage to heat up, if 

this option is used. 

The LEDs are air-cooled by fans, however the light output varies slightly as they heat up. To 

help with the heat transfer, a piece of foam in inserted in the back of the LED bank on each 

side. Also to counteract the temperature change, a temporal correction is automatically 

applied to the LED feedback circuit to normalize the system. 

Flat field calibration is automatically applied to the read plate to adjust for non-uniformity of 

illumination across the plate. Refer to Optical Calibration on page 127 for instructions on how 

to manually calibrate the system. 
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over 30% or in the UV spectrum, unless you are viewing them through the 
observation panel. If light is seen escaping the instrument when the LED modules 

are turned on, shut down immediately and call Molecular Devices Technical 

Support. 
 

Figure 2-9: LED configuration 

Emission Filters 

A three-position filter slider holding up to three 60 mm diameter interference filters is located 

in front of the CCD camera. The slider can be alternated in front of the camera to separate 

out the emission band of the dye being used. These filters can be used with a single 

excitation wavelength or can be paired up with additional emission filters and LEDs in a 

ratiometric experiment, for example, as excitation LEDs alternate between two different 

wavelengths, filters change at the same time so that each image taken by the camera 

matches the right emission filter with the excitation LED bank. The most common 

FLIPR Tetra system configuration is a LED excitation wavelength of 470–495 nm with a 515– 

575 nm bandpass emission filter. For luminescence experiments it is also possible to run 

without the filter. 

Emission filters are user-changeable in approximately 5 minutes; see Changing Filters on 

page 120 for instructions. Once installed, filters are mechanically sensed and the filter 

configuration can be viewed in the Instrument Configuration panel in ScreenWorks 

Software. The instrument will prompt you to calibrate a new emission filter with respect to 

an LED module if they are intended to be used in an experiment. 
 

Note: If a desired filter is not available, three custom filter cassettes (P/N 0200-6221) 

are available for purchase to place filters created by an outside vendor. Once installed, 

these filters are displayed as Custom 1, Custom 2 and Custom 3 in ScreenWorks 

Software. 

WARNING! Do not look into LED banks when turned on, especially at intensities 
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Chiller  
 

Because the FLIPR Tetra system is a light-tight instrument there is very limited airflow inside 

the instrument enclosure. To provide a suitable operating environment for both the 

Standard EMCCD and Aequorin ICCD cameras, an external chiller is required. The chiller uses 

a special cooling liquid supplied with the instrument and is controlled via the embedded 

computer and instrument firmware. The chiller sits outside of the instrument and is 

connected via cable and tubing to the FLIPR Tetra system. 
 

Computer System 

Host Computer 

Apart from exchanging hardware and manual loading of plates, all normal user interaction 

with the FLIPR Tetra system is mediated through the ScreenWorks Software run on an 

external host computer, supplied with the system. The minimum configuration required is as 

follows: 

3.4 GHz processor 

Windows XP Professional or Windows 7 operating system 

2 GB of SDRAM 

160 GB hard drive 

Ethernet adapter 

DVD-CDRW drive 

1 PCI expansion slot 

Embedded Computer 

An embedded computer located in the lower chamber controls basic FLIPR Tetra system 

functions. These functions are initiated through the ScreenWorks Software control software 

installed on the host computer and sent to the embedded computer to execute the 

function. This setup allows data processing and instrument control to be performed 

separately to ensure the greatest productivity during an experiment. 
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Chapter 3: Startup and Shutdown 
 
 

This chapter provides procedures for starting up and shutting down the FLIPR Tetra High 

Throughput Cellular Screening System These procedures should be followed closely in order 

to ensure proper communication between ScreenWorks Software and the hardware. 
 

Starting Up the System 

To start the FLIPR Tetra system: 

1. Turn on the computer and monitor. 

2. Simultaneously press the CTRL+ALT+DELETE keys to launch the Windows operating system. 

3. At the prompt enter your password. 
 

Note: After installation, the default password is FLIPR. 

Wait for the operating system to finish starting-up before proceeding. 

4. Turn on the external chiller with the switch located on the left side of the chiller. 

5. Turn on the FLIPR Tetra system power switch located on the right side of the instrument. 

The system goes through an initialization cycle to register all instrument components. 

This cycle is not complete until the green Assay Finished (Unlock) light is the only light 

illuminated on the instrument status panel. 

6. Start the ScreenWorks Software by double-clicking on the desktop icon. 
 

Note: Starting the software can take several seconds. Do not repeatedly double-click 

the software icon. 
 

Note: The system is ready for use when the camera temperature in the instrument 

status window displays -60°C (-76°F) ± 2 °C (-35.6°F) for the Standard EMCCD camera, 

or -20 (-4°F) ± 5 °C (-41°F) for the Aequorin ICCD camera. 

3 
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Shutting Down the System 

To shut down the FLIPR Tetra system: 

1. At the end of a programmed experiment, wait for the Assay Finished (Unlocked) light 

on the Instrument Status Panel to turn green, indicating the experiment is finished. 

2. If the last protocol did not remove the tips from the pipettor head, Molecular Devices 

recommends making sure that you remove them using the manual command. Failure to 

remove tips can result in an error on next start. 

3. Exit ScreenWorks Software by selecting File > Exit. 

4. Turn off the computer and monitor. 

5. Turn off the FLIPR Tetra system power switch. 

6. Turn off the chiller power switch. 
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Chapter 4: Software Installation 
 
 

This chapter describes how to install ScreenWorks System Control Software. 

You must have administrative privileges on the computer to install ScreenWorks Software. 
 

Installing ScreenWorks Software 

As of version 3.1, the installer automatically uninstalls the old software version as long as it is 

same major release (3.1 to 3.2). If you are replacing ScreenWorks Software version 3.2, with 

version 4.0, manually uninstall the software. See Uninstalling ScreenWorks Software on page 

36. 

1. Double-click the ScreenWorks_4_0_x.exe ScreenWorks Software installation file. A 

Welcome to the ScreenWorks Setup Wizard dialog is displayed. 

2. Click Next. 

3. In the License Agreement dialog box, select I accept the terms of the license 

agreement, and click Next. 

4. In the Online/Offline Mode dialog, designate the default mode in which you want the 

software to start. 

In Online, ScreenWorks Software automatically looks for a connected instrument 

when the software is started. 

In Offline, ScreenWorks Software does not automatically look for a connected 

instrument. 

See Online vs. Offline Installation on page 34 for details. 

5. Click Next. 

6. In the Destination Folder dialog, the Install ScreenWorks 4.0 to field displays the default 

installation directory. To change the installation directory, click Change, navigate to the 

desired directory, then click OK. 

7. Click Next. 

8. In the Select Program Folder dialog, leave the displayed default Program Folder 

settings. Select Anyone who uses this computer to make ScreenWorks Software 

available to all users on the FLIPR Tetra system host computer, then click Next. 

9. In the Configuring the ScreenWorks installation dialog, if you want to make any 

changes, click Back to go to the previous screen, otherwise click Next to start the 

installation. 

10. When the installation is complete, the Completing the installation process dialog 

appears. Click Finish to exit the wizard. 

4 
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Activating the ScreenWorks Peak Pro License 

The ScreenWorks Peak Pro™ functionality is license-protected. The software license 

activation enables the Peak Pro functionality any time after the trial period expires. 
 

Note: There is a one time 14-day Peak Pro trial usage option in the Help menu. When 

the trial period expires, the Peak Detection functionality disappears, and the Help 

menu trial option is inactive. The rest of the ScreenWorks Software version 4.0 

remains functional. 

To activate the ScreenWorks Peak Pro Software license: 

1. Start the ScreenWorks Software application. 

2. Click the Help tab. 

3. Click Software License. 

4. If you have not started the available 14-day Peak Pro trial, the option to start the 14-day 

Peak Pro trial, or enter the product key appears. Click Yes. 

If the trial has expired, only the option to provide a software license product key 

appears. 

5. If you have internet connectivity, type the provided Product Key in the field and click 

Activate Online, and then follow the on-screen instructions. 

6. If you do not have Internet connectivity, click Activate Offline and follow the on-screen 

instructions. Activate Off line requires the following: 

Your product key 

A separate computer with Internet connectivity 

A USB drive for transferring files between the computers 

 

Online vs. Offline Installation 

The software has two start-up modes: 

Offline (Desktop) 

Online (Instrument) 

The default start-up mode is determined during software installation in the Online/Offline 

dialog. 

After the software is open, you can switch modes by selecting from the Instrument menu, 

Go Online or Go Offline. 
 

Note: Switching modes after the software is opened does not change the software 

startup mode chosen at the time of installation. To change the default startup mode 

the ScreenWorks Software must be reinstalled. 
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Online (Instrument) Mode 

When launched in this mode, ScreenWorks Software checks for instrument connections. If 

no connections are sensed, you are notified. You may then either check the connections and 

attempt to connect again, or choose to run the software in Offline mode. 

If you create a protocol in Online mode, only the current instrument settings are allowed. 

Protocols created in Offline mode with hardware settings that do not match current 

hardware settings are flagged. You must change the hardware settings to match those in the 

protocol in order to run it. 

When ScreenWorks Software is launched in Online mode and connects to the instrument, 

the default installation configuration file is overwritten using the current instrument settings 

and plate library information. 

If you are running in Online mode and then switch to Offline mode, the instrument setup 

configuration will be the last Online configuration. 
 

Note: To be able to select any configuration to generate protocols, you must install 

the software in Offline (desktop) mode. 
 

Offline (Desktop) Mode 

When ScreenWorks Software is launched in Offline mode, you can configure the following 

hardware options: 

Camera  Type 

Excitation Wavelengths 

Emission Wavelengths 

Pipettor (automatically selects matching tip washer type) 

Cell suspension 

TETRAcycler™ (automatically sets bar code reader status) 
 

Note: Regardless of the start-up mode, pipettor head and tip washer type must 

always match. If the TETRAcycler is installed, it is assumed the bar code reader is also 

connected. 
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Uninstalling ScreenWorks Software 

1. Click Start > Control Panel and double-click on Add or Remove Programs from the 

Windows Control Panel dialog. 

2. Find ScreenWorks in the list of currently installed programs and click Remove to initiate 

the uninstall process. 

3. When prompted to Uninstall ScreenWorks, click Next . 

4. In the Configuring the ScreenWorks installation dialog, Click Next. 

5. When the installation is complete, the Completing the installation process dialog 

appears. Click Finish to exit the wizard. 
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Chapter 5: ScreenWorks SoftwareOverview 
 
 

This chapter describes windows, menus, dialog boxes, and toolbar icons of the ScreenWorks 

Software. 
 

Main Screen 

The ScreenWorks Software main screen includes title, menu, and toolbars across the top, 

and a status bar at the bottom. The main working area in the middle can have up to two 

sections: 

Experiment window— central proportion of the main window, for protocol 

configuration, data viewing and analysis. 

Instrument Status Panel— at the bottom of the main work area for displaying 

instrument information. This panel includes instrument status and configuration in 

addition to the Process Explorer where processes used in the protocol definition are 

located. 
 

Figure 5-1: Main Interface Screen Diagram 

5 
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Title Bar 

The title bar extends across the top of the ScreenWorks Software window. It reports the 

application name—ScreenWorks and version number—followed by the name of the 

currently active protocol or data file, open in the Experiment window. 

Title bar color indicates whether or not the window is active: the title bar of an active window 

is typically a different color from (and usually brighter than) other window title bars for 

programs that are inactive (which might be dimmed). 

Dragging the title bar repositions the window on the screen (in window view only; if the 

window has been maximized, dragging does not work). Buttons are displayed at the right 

end of the title bar can be used to minimize the window so it appears only on the task bar, 

maximize the window to full screen, or to close the window. 

Menu Bar 

The menu bar, beneath the title bar, contains six menus that group together related 

commands. Click on a menu name to display the commands in the menu. 

See Menu Bar on page 41 for a full description of each menu command. 

Toolbar 

The toolbar, beneath the menu bar, contains tool button shortcuts for a number of main- 

menu commands. 

The toolbar can be hidden or shown from the View > Toolbar toggle command. 

The table below lists the toolbar commands. See Menu Bar on page 41 for more detailed 

descriptions of the commands. 
 

Button Name Description 
 

 

New Document Opens a new protocol file (*.fmp) with default 

settings for an assay with a single read with fluid 

transfer. 

 
Files are named Untitled[n] where n is a number. 

 

 

Open Protocol File Opens the Open File dialog to browse and open 

protocol (*.fmp) files. 

 

 

Open Data File Opens the Open File dialog to browse and open 

data (*.fmd) or image files. 

 

 

Save File Opens the Save File dialog that allows you to save 

the current file in the desired location. 
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Button Name Description 
 

 

Export File Opens the Export File dialog that allows you to 

manually export the current file in the desired 

location. 
 

 

Print Opens the Print dialog. 

 

 

Experiment Summary Displays protocol contents (process steps and 

correction) for the current protocol or data file. 

This button toggles with Experiment Setup. 
 

 

Experiment Setup Opens the Experiment Setup window to edit the 

current protocol, view or analyze data in a data file. 

This button toggles with Experiment Summary. 
 

 

Help Opens the FLIPR® Tetra System Users Guide in PDF 

format. 

 

 

Stop Stops the experiment currently running. 

 

 

Run Starts the protocol selected in the Experiment 

window. 

 

 

SynchroMax Automation Opens the SynchroMax™ Automation window to 

select the desired template to run the SynchroMax 

ET plate handler. 
 

 

Online Mode This button is displayed when System Control 

Software is in Offline Mode. Click to connect to the 

instrument and go into Online Mode. 

This button toggles with Offline Mode. 
 

 

Offline Mode This button is displayed when ScreenWorks 

Software is in Online Mode. Click to disconnect 

from the instrument and go into Offline Mode. 

This button toggles with Online Mode. 
 

 

Remote Mode InstructsScreenWorks Software to disable manual 

connection and to only receive Remote commands 

from a third-party robot. 

This button toggles with Manual Mode. 
 

 

Manual Mode Instructs ScreenWorks Software to disable remote 

connection and to only receive Manual commands 

from the ScreenWorks Software user interface. 

This button toggles with Remote Mode. 
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Button Name Description 
 

 

Calibration Opens the Calibration dialog where Flat Field 

calibrations can be performed. 

 

 

Yellow Plate Signal Test Opens the Yellow Plate Signal Test dialog to display 

the numerical results using the Yellow Plate. 

 

 

Protocol Signal Test Opens the Protocol Signal Test dialog to display the 

numerical results prior to running an experiment. 

Settings defined in this signal test can be saved to 

the protocol *.fmp file. 
 

 

Set Spinner Flask Stirring Rate Opens the Spinner Flask Control dialog where the 

stirring rate can be set. 

 

 

Set Chamber Temperature Opens the Set Temperature dialog where the 

chamber temperature can be set in degrees 

Centigrade, or disabled. 
 

 

Restore Layout 1 Restores the Experiment window layout to those 

defined as Save To Layout 1 in the View menu. 

 

 

Restore Layout 2 Restores the Experiment window layout to those 

defined as Save To Layout 2 in the View menu. 

 

 

Restore Layout 3 Restores the Experiment window layout to those 

defined as Save To Layout 3 in the View menu. 

 

 

Restore Layout 4 Restores the Experiment window layout to those 

defined as Save To Layout 4 in the View menu. 

 

Status Bar 

The status bar, across the bottom of the main window, provides tool tips for commands in 

the main menu. When you open a menu from the menu bar and place the cursor over a 

command, a description of the command is displayed in the status bar. 

The status bar can be hidden or shown from the View > Status Bar toggle command. 
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Menu Bar  
 

This section lists and explains the commands available in the Menu Bar menus. 

Some menu items can be opened with a keyboard shortcut using the ALT key to underline 

the letter in each menu title that is used to open the menu; for example, when you click ALT 

the I in the Instrument menu is underlined. Click the I key and the Instrument menu opens. 

File Menu 

The File menu contains commands that enable you to open, close, save and print 

FLIPR Tetra system data and protocol files. 
 

Option Description Keyboard 

Shortcut 

New Opens a new protocol (*.fmp) in the Experiment window, with 

default settings for one read with fluid transfer. 

New protocols are named Untitled[n], where n is a number. 

Ctrl+N 

Open Opens an Open File dialog to open a saved Protocol (*.fmp), Data 

(*.fmd) or Image (*.png) file, as selected in the submenu. By 

default, the dialog opens in the folder set in Tools > Set Default 

Directories. 

 
Note: Only data files created with ScreenWorks Software can be 

opened in ScreenWorks Software. Data files from  previous 

FLIPR Tetra system (versions 1.X through 2.X) cannot be opened. 

Ctrl+O 

Ctrl+Shift+O 

Close Closes the currently active protocol or data file, displayed in the 

foreground of the Experiment window. If modifications have been 

made to the file, you are prompted to save the modifications. 

Alt+F,C 

Save Saves the currently active protocol or data file, displayed in 

foreground of the Experiment window. Also saves If the displayed 

file is a default protocol that is untitled, the Save As dialog box is 

displayed so that you can name the file. 

Crtl+S 

Save As Opens the Save As dialog and allows you to save a protocol or data 

file under a new name or format (for example, save a data file as a 

protocol). Also allows you to save a protocol or data file as an 

earlier version of the ScreenWorks Software. When changing 

formats, select the file type from the Save as type drop-down list. 

Alt+F,S 

Save All Files Saves all of the opened protocol and data files. If the default 

protocol file was opened, the Save As dialog is displayed so that 

you can name the files. 
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Option Description Keyboard 

Shortcut 

Close All Files Closes all of the opened protocol and data files. If any of the files 

had changes since they were opened or the default protocol file 

was opened, the Save or Save As dialog is displayed so that you 

can name the files. 

 

Export Opens the Export File or Batch Export dialog, as selected in the 

submenu, to manually export data from the open data file, or 

other data files on disk; see Exporting Data on page 82. 

 

Page Setup Opens the Page Setup dialog to configure the printer and print 

settings for the document. 

Alt+F,G 

Print Preview 

Report 

Displays how the document will look when printed. Alt+F,V 

Print Report The Print Report dialog allows you to select the graphs or reports 

to print from the current data file. Having made the selection you 

can open Print Preview Report to check before printing, or open 

the Print dialog to print. 

Crtl+P 

1–6 Data Files Lists the six most recently opened data files, with the most 

recently opened at the top. 

 

7–10 Protocol 

Files 

Lists the four most recently opened protocol files, with the most 

recently opened at the top. 

 

Exit Closes ScreenWorks Software. If you have unsaved data, you will 

be prompted to save it before closing. 

Alt+F,X 

 

Saving Data Files as Protocol Files 

When the active file is a protocol file, you can add, remove, or change processes in the file, 

then save the amended protocol and run it. Protocol information stored in data files cannot 

be edited, nor used to run a new experiment, however it is possible to extract this 

information to a new protocol file. Experiments run using this file will have exactly the same 

steps as the steps used to create the data file. 

To store a data file as a protocol file, select Save As, assign a protocol name, select *.fmp as 

File Type and click Save. The stored file is stripped of all data and only associated protocol 

information is stored in the protocol file. 
 

Note: Saved changes only affect the protocol. The data file from which the protocol 

was derived remains intact. 
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View Menu 

View menu commands enable you to select which displays to show or hide in the 

FLIPR Tetra system main window. 

The keyboard shortcut is ALT+V. 
 

Option Description 

Experiment Setup Displays the Experiment Setup view of a protocol or data file, showing 

processes and associated dialogs. 

Experiment Summary Displays in the Experiment window the Experiment Summary for the 

current protocol or data file. 

 
To return to the normal view, select View > Experiment Setup. 

Save Layout Saves the proportions displayed in the Experiment window (including 

Multi-Well and Detail Graphs as well as Group Statistics window) and 

Instrument Status panel to one of four layouts. These layouts can be 

toggled between when the appropriate Restore Layout selection is 

made. 

Restore Layout Restores the screen layout to one of four proportions saved in the 

Saved Layout selection. 

Instrument Status Toggles the Instrument Status panel in and out of view (see 

Instrument Status Tab on page 53). 

Toolbar Toggles the Toolbar in and out of view (see Toolbar on page 38). 

Status Bar Toggles the Status Bar at the bottom of the main window in and out of 

view (see Status Bar on page 40). 
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Instrument Menu 

Instrument menu commands enable you to access instrument communication and manual 

dialogs. 
 

Options Description 

Go Online/Offline A toggle that switches the instrument between Online and Offline 

modes (see Online vs. Offline Installation on page 34). 

Go Online—This is displayed when ScreenWorks Software is offline. 

Click to connect the software to the instrument, giving ScreenWorks 

Software control of the instrument. 

Go Offline—This is displayed when ScreenWorks Software is connected 

to the instrument. Press to disconnect the software from the 

instrument. 

Run Experiment Instructs ScreenWorks Software to start an experiment using the 

uppermost protocol file in the experiment. 

Stop Experiment Instructs ScreenWorks Software to stop the experiment. 

 
Note: Stop Experiment should only be used in emergencies to halt an 

experiment. If used, an instrument reset may be required. 
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Options Description 

Manual Operation Commands in this submenu control specific hardware operations. 

Note: The commands are disabled if the associated hardware is not 

available. 

Load Tips—Instructs pipettor to load tips or pin tool. 

Unload Tips—Instructs pipettor to unload tips or pin tool to the load 

tips/source 3 position. It is recommended that you unload tips to a tip 

rack. If you choose to unload without one, make sure there is a 

container in the appropriate position to receive tips. 

Wash Tips—Instructs pipettor to wash tips or pin tool. A dialog box 

opens for you to configure the wash. 

Drain Wash Basin—In case of an instrument error, allows the user to 

drain the wash basin to the waste bottles. 

Yellow Plate Signal Test—Instructs the instrument to take a reading of 

the read plate for the current protocol and to display the numerical 

results in the Signal Test dialog box. For detailed information on the 

features and functions of the signal test, see Signal Test on page 46. 

Protocol Signal Test—Instructs the instrument to take a reading of the 

read plate and to display the numerical results in the Signal Test dialog 

box. Instrument settings can be saved to the open protocol. For 

detailed information on the features and functions of the protocol 

signal test, see Signal Test on page 46. 

Change Head—Instructs the pipettor head to move over the read plate 

position. In this position, the pipettor head can be exchanged to a new 

pipettor format (see Exchanging Pipettor and Pin Tool Heads on page 

105). 

Cycle Camera Temperature—Only used with EMCCD camera. Cycles 

the camera when you want to run a low-fluorescence or luminescence 

experiment immediately after  running a high-fluorescence 

experiment. In the approximately 15 minute cycle period the camera is 

raised to room temperature (20°C—25°C) (68°F—77°F) and then  

cooled to -60°C (-76°F) ± 2°C (35.6°F). 

Temperature Control—A toggle that turns heating on and off for 

positions Source Plate 1, 2 and 3. When heating is turned on a dialog 

box is displayed to enter the desired temperature. 

Cell Flask Stirring Control—Allows the user to set the stir speed rate for 

the cell flask. 

Wash Cell Reservoir—Enables the user to wash the Cell Reservoir by 

selecting the Fluid Source, Fluid Destination, Fill Speed, Drain Speed, 

along with the number of Wash Cycles and Hold Time. It also allows the 

user to pre-coat the tubes, which is recommended for the first run 

with any cells in suspension. 

Drain Cell Reservoir—In case of an instrument error or manually 

poured cells into the Cell Reservoir, allows the user to drain the Cell 

Reservoir to a specified destination. 

Note: Resetting the instrument automatically drains the Cell Reservoir 

to the waste bottle. 
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Options Description 

Set Remote/ Manual Mode A toggle that switches the instrument between manual and remote 

modes. 

Set Remote Mode—Enables you to integrate a third-party robotics 

system with FLIPR Tetra system. See Robotic Integration on page 189. 

ScreenWorks automatically goes into Remote Mode if you open 

SynchroMax Automation, however Remote Mode is not used to 

initiate communication with the SynchroMax ET. 

Set Manual Mode—Disables SynchroMax ET or third-party robotics 

control. All instrument commands must be initiated through 

ScreenWorks Software. 

SynchroMax Automation Opens the SynchroMax dialog for configuration of plate handling with 

the SynchroMax ET. See SynchroMax™ Automation on page 48. 

Reset Reinitializes the system to clear any fatal errors as designated in red at 

the bottom of the Instrument Status panel. 

Clear Error Clears minor system errors as designated in yellow at the bottom of the 

Instrument Status panel. 

Calibration Opens the Calibration dialog where Flat Field Calibration Calibrations 

can be performed. See Optical Calibration on page 127. 

Refresh Configuration Refreshes the instrument configuration. Use this command after 

hardware settings have changed. 

 

Signal Test 

The signal test has two functions: 

Checking the state of the overall system: This function is typically performed using the 

yellow test plate with the respective plate format for your assay and can be accessed 

through the Yellow Plate Signal Test option in the main menu. Outlined in the table 

below are the default settings used when performing the yellow plate signal test. These 

settings cannot be saved to a protocol for use at a later time. 

Checking initial fluorescence of a plate prior to running an assay: This function is typically 

performed to evaluate the assay plate prior to running an experiment and can be 

accessed through the Protocol Signal Test option in the main menu. Settings outlined in 

the table below will default to the settings in the currently open protocol when 

performing the protocol signal test. These settings can be saved to the open protocol for 

use at a later time. 
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The table below describes the settings in the Yellow Plate Signal Test and Protocol Signal 

Test dialog: 
 

Options Description 

Select Plate Choose the plate type from the drop-down list. 

Excitation/Emission 

Wavelength 

Select the appropriate excitation/emission wavelength pair for the 

signal test from the drop-down list. 

 
Note: Only calibrated excitation/emission wavelength pairs are 

displayed in the drop-down list. 

Reading Mode Select Fluorescence or Luminescence from the list. 

Camera Gain Select the camera gain for the signal test from the list. Typical 

Camera Gain is 1 for the EMCCD camera and 2000 for the ICCD 

camera, for the 470–495/515–575 nm excitation/emission pair 

when reading a yellow test plate. 

Gate Open This option is available only for the Aequorin ICCD camera. Typical 

Gate Open values for Fluorescence are around 6% but can be set 

to 100%. Luminescence gate is always 100%, and not user- 

adjustable. 

Excitation Intensity Select the LED intensity for the signal test from the dropdown list. 

Excitation intensity is scaled as a percentage of the total LED 

output (0–100%). Typical Excitation Intensity is 80 for the 470– 

495/515–575 nm excitation/emission pair when reading a yellow 

test plate. 

Exposure Time Enter the amount of time (in seconds) to keep the camera shutter 

open during the Signal Test. Typical Exposure Time is 0.4 seconds 

for the EMCCD camera and 0.53 seconds for the ICCD camera, for 

the 470–495/515–575 nm excitation/emission pair when reading 

a yellow test plate. 

Highlight Range Highlights well values that lie within the set statistical range. Set the 

statistical range by using the slider. 

Wells Above Range Displays the number of wells above the statistical range as 

determined by the Highlight Range. 

Wells Below Range Displays the number of wells below the statistical range 

determined by the Highlight Range. 

Maximum Displays the largest value on the signal test plate. 

Average Displays the average value on the signal test plate. 

Minimum Displays the smallest value on the signal test plate. 

Std. Dev Displays the standard deviation of the signal test plate. 

Test Signal When clicked, initiates a new signal test. 
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Options Description 

Save When clicked, saves the signal test as an ASCII text file (*.sig). 

Print When clicked, prints the signal test. 

Image Viewer Displays the CCD image showing where RLU values were derived 

for the signal test. 

Show > Hide Mask—Shows or hides the mask used in the test, 

indicating the pixel area used to derive the RLU value for each 

well. 

View Image—Refreshes signal test image. 

Diagnostics For Technical Support use only. 

 

SynchroMax™ Automation 

The SynchroMax Automation command is only enabled if you have a SynchroMax ET 

installed. 

When you open the SynchroMax dialog from Instrument > SynchroMax Automation, 

ScreenWorks Software automatically goes into Remote Mode, giving control of the 

instrument to the SynchroMax ET software. ScreenWorks Software returns to Manual Mode 

when the SynchroMax dialog closes. 

To run a series of experiments with the SynchroMax ET, first open the protocol file that you 

want to use in ScreenWorks Software. Only one protocol is used in a run, as many times as 

the SynchroMax ET supplies plates for it. 

Having prepared the protocol, open the SynchroMax dialog and select a Stack Layout 

Template. These files specify, for each plate location in the five-position stage, how many 

plates will be loaded to that position, from which stack, and where they will be delivered to 

after use. A number of Stack Layout Templates are supplied—select the one that fits your 

assay. 

When a Stack Layout Template is opened in the dialog the graphic in the dialog displays 

which stacks plates should be loaded in. You can use this as a guide for loading the plates. All 

plates in a single stack should be of the same type. 

If there are any stage positions that will use the same plate throughout the duration of the 

run, these should be loaded manually before the run begins. Stage positions that will have 

plates brought to them during the run should be empty at the start of the run. 

Before selecting Run, make sure all output racks are empty prior to beginning the 

experiment. When plates are in position and the FLIPR Tetra system ready, click Run in the 

SynchroMax dialog. After checking that the plate configuration is compatible with the 

protocol Settings configuration, the instrument runs until all plates have been used. During 

this time the Run button changes to Stop, so you can stop the run before it completes if 

necessary. 
 

Note: Stop should only be used in emergencies to halt an experiment. If used, an 

instrument reset may be required. 
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When the SynchroMax ET is active, the system will clear all plates at the end of an 

experiment. The SynchroMax remembers only those plates it loaded during the experiment 

and checks if any of those plates remain when the experiment completes. If so, they are 

removed. A reagent reservoir can be used in a source position within the FLIPR Tetra system 

as long as it is manually loaded and the SynchroMax template does not include the loading 

or removal of plates to that position. 

On completion, the Done button is enabled. Unless you want to run another set of 

experiments, press this to close the dialog and return ScreenWorks Software to Manual 

Mode. 

Tools Menu 
 

Options Description 

Set Default Directories Opens the Set Default Directories dialog to designate directories in 

which to store protocol and data files, signal tests, group templates and 

to which export files are written. 

 
The Open > Protocol, Data and Image File commands in the File menu 

open to the folders set here, as do the File > Export dialogs. In addition, 

Group Templates *.fmg can be exported and imported from the 

default folder defined in the directory. 

 
The default protocol directory is: C:\Documents and Settings\[your_ 

user_name]\My Documents\Molecular 

Devices\ScreenWorks\MyProtocols [MyData, MySignalTests, or 

MyGroupTemplates] 

 
The default data and export directories are: C:\Documents and 

Settings\[your_user_name]\My Documents\Molecular 

Devices\ScreenWorks\MyData \ 

 
The default signal test directory is: C:\Documents and Settings\[your_ 

user_name]\My Documents\Molecular 

Devices\ScreenWorks\MySignalTests 

 
The default group template directory is: C:\Documents and Settings\ 

[your_user_name]\My Documents\Molecular 

Devices\ScreenWorks\MyGroupTemplates 

 
Note: It is recommended that you save all protocol and data files on 

the local hard drive to ensure instrument function or data is not lost if 

your server fails during an experiment. 

Plate Library Opens the Plate Process Definition dialog, which lists current plate 

definitions and allows you to add additional plate definitions to the 

system. See Plate Process Definition on page 50 for details. 
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Options Description 

Open Error Log Opens an error log generated by the FLIPR Tetra system. This feature is 

for technical support and requires a password. 

Save Error Log Save error logs. Logs are saved as *.fel (FLIPR Tetra system Error Log) 

encrypted files. The files can be forwarded to Molecular Devices 

Technical Support. 

Assay Log For data files only, opens a dialog reporting when the protocol steps 

were applied. 

 
Note: This log can be accessed by selecting CTRL+SHIFT+A. 

 

Plate Process Definition 

All plates currently in the system are listed in the Plate Process Definition dialog, opened 

from Tools > Plate Library. They are categorized first into read and source plates and then 

by well-number format. 

A description of commands in the Plate Process Definition and Define Camera Parameters, 

both accessed via Tools > Plate Library is provided below. For instructions on adding a new 

read or source plate, see Data Processing Algorithms on page 237. The Plate Library is 

camera-specific, so if any plates are added with one camera type, they will not be available 

once the camera type is changed. 

The Plate Process Definition dialog is accessible only to administrators, and is password 

protected. The default user name is fliprtetra and password is flipr. 

Fifteen default plates are included with the system software: 

Default 96 

Default 96 small volume 

Default 96 no slit mask 

Default 96 boat 

Default 384 

Default 384 small volume 5X3 mask 

Default 384 small volume 3X3 mask 

Default 384 boat 

Default 384 blot 

Default 1536 

Default 1536 boat 

Default 1536 blot 

Default Cell Reservoir 96 
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Default Cell Reservoir 384 

Default Cell Reservoir 1536 

Options Description 

Close Closes the Plate Process Definition dialog. 

Open Plate Opens the Define Basic Plate Parameters dialog for the plate selected 

in the tree view. 

Copy Plate Opens the Define Basic Plate Parameters dialog allowing you to add a 

new plate (see Define Basic Plate Parameters Dialog on page 51). 

 
Note: When copying a plate, make sure that you select a plate with a 

similar well format, as the number of wells and plate mask will be 

transferred to the new plate. 

Delete Plate Deletes the plate displayed in the Plate Process Definition field. 

Collapse All Collapses the Plate Process Definition tree. 

Expand All Displays all items in the Plate Process Definition tree. 

Define Basic Plate Parameters Dialog 

This dialog opens when you select Open Plate or Copy Plate in the Plate Process Definition 

dialog. Use the dialog to inform the FLIPR Tetra system of the critical dimensions of the 

plates you are using. 
 

Note: Dimensions of default plates cannot be modified. However, the plate mask can 

be realigned. 
 

Options Description 

Plate Name Enter the name you want assigned to the new plate (maximum 

number of characters is 50). 

Plate Type Select Source Plate or Read Plate for the new plate. 

 
Source Plate—Creates a plate that does not include a plate mask. 

These plates are typically used for compound storage. 

Read Plate—Use for all plates that are read in the read position and 

require a plate mask. 
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Options Description 

Plate Specifications Area for entry of physical plate dimensions. Refer to the diagram in the 

upper right corner of the dialog. 

For best results, obtain the plate dimensions from the plate 

manufacturer. 

 
Note: Molecular Devices is not responsible for instrument 

malfunctions if plate specifications are not correct. 

 
Rows—Enter the number of rows on the plate. 

Columns—Enter the number of columns on the plate. 

Well Shape—Select the appropriate shape from the drop-down list. 

Well Volume (µL)—Enter the maximum well volume in microliters. 

X (mm)—Enter the distance (in mm) from the left side of the plate to 

the center of well A1. 

Y (mm)—Enter the distance (in mm) from the top of the plate to the 

center of well A1. 

Bottom (mm)—Enter the distance (in mm) from the bottom of the 

plate skirt to the inside of the well. 

Top (mm)—Enter the distance (in mm) from the bottom of the plate 

skirt to the top of the well. 

Well Offset (mm)—Enter the distance (in mm) from the center of one 

well to the center of adjacent well. 

 

Define Camera Parameters Dialog Box 

When Read Plate is identified as the Plate Type in the Define Basic Plate Parameters dialog, 

the Finish button is enabled. Prior to selecting Finish, a read plate with 10-8 M fluorescein 

should be placed in the read position. When selected, the instrument will read the plate and 

define a plate mask to the plate definition created. If a plate is present, but no mask can be 

defined, the plate definition will be saved as a source plate. 

Window Menu 

The commands in the Window menu allow you to change the way the Experiment window is 

viewed. The keyboard shortcut is ALT+W. 
 

Options Description Keyboard 

Shortcuts 

Cascade Aligns the open windows so that they are overlapped and 

staggered with the title bars visible. 

Alt+W,C 

Tile Divides the screen into as many segments as there are windows 

and aligns them so that they are displayed side-by-side. Each file 

occupies a segment and is visible. However, each of the file 

images will be scaled according to the number of files being 

displayed. 

Alt+W,T 

1–10 Data Files Lists the open files (up to 10)  
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Help Menu 

The Help menu provides access to the user guide and information about the software. The 

keyboard shortcut is ALT+H. 
 

Options Description 

FLIPR Tetra system User Guide (PDF) Opens a PDF version of this manual that is appropriate for 

the version of software installed. 

ScreenWorks Release Notes Opens a PDF version of the ScreenWorks Software Release 

Notes. 

About ScreenWorks Opens the About ScreenWorks dialog. This reports the 

version numbers for ScreenWorks Software, the Firmware 

EC, Firmware Motion and Remote Interface. 

MDC on the Web Displays links to a number of Molecular Devices support 

pages on the Web, such as theScreenWorks Software 

Update page, the Technical Support page, and Technical 

Support Request page. Selecting one of these commands 

opens your default web browser to the selected page. 

Show Update Reminder When this option is selected an Update Reminder is 

displayed when ScreenWorks Software is launched, 

reminding the user to check for an update to the software. 

 

Instrument Status 

The Instrument Status panel, by default located on the bottom of the main screen, reports 

the status of and settings for the FLIPR Tetra system hardware in addition to including the 

processes used to create protocols. The panel has three tabs: Instrument Status, Instrument 

Configuration and Process Explorer. 

The panel can be moved to different locations within the main ScreenWorks Software 

window, and can be hidden entirely, using the View menu command. 

Instrument Status Tab 

The current status of the system hardware components is reported in the Instrument Status 

tab. Fields below this report information about the step the instrument is at within an 

experimental run. The color-coded communication field at the bottom-right of the tab 

reports status with respect to communication between ScreenWorks Software and the 

instrument. 

Status messages and faults are reported at the bottom of the tab as well. Click the button 

here to see a list of the last thousand messages. 
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Options Description 

Stage Temp (°C) Displays the source plate position temperature of the five-position 

stage as well as the temperature it is set for, Set Point. 

Stage Status—Whether the heated stage is turned on or not. 

Camera Temp (°C) Displays the camera temperature. Operating temperature for the 

camera is -60 ± 2 °C (-76°F ± 35.6°F) for the Standard EMCCD camera 

and -20°C ± 5°C (68°F ± 41°F) for the Aequorin ICCD camera. 

Camera Status—Indicates whether the camera is turned on or off. 

Intensifier—Indicates the status of the intensifier. 

Pipettor Tips Reports when tips are loaded on the pipettor head. 

Upper Door (Inner) Reports whether the inner-upper door (observation panel) is open or 

closed. 

 
Note: The system will run as long as the inner door is closed, however 

data may not be valid if outer door is open. 

Upper Door (Outer) Reports whether the outer-upper door is open or closed. 

Lower Door Reports whether the lower door is open or closed. 

Tip Washer Indicates the status of the tip washer. 

Chiller Status Indicates whether the status of the chiller. 

Read Plate Reports when a plate is present in Position 3 (Read Plate position). 

Source Plate 1 Reports when a plate is present in Position 1 (Source Plate 1 or Tip 

Loading position). 

Source Plate 2 Reports when a plate is present in Position 2 (Source Plate 2). 

Source Plate 3 Reports when a plate is present in Position 4 (Source Plate 3 or Cell 

Reservoir). 

Cell Reservoir Indicates when the Cell Reservoir is installed. 

Chiller Temp (°C) Reports the current temperature in the chiller. 

Fill Bottle A Reports when bottle A is empty of wash solution. 

Fill Bottle B Reports when bottle B is empty of wash solution. 

Waste Bottle A Reports when waste bottle A is full. 

Waste Bottle B Reports when waste bottle B is full. 

Mode Reports whether ScreenWorks Software in Manual or Remote mode. 

Cell Flask Rate Reports the set stir rate of the cell flask. If the Cell Suspension option is 

installed and the stir rate is 0, an exclamation sign is displayed. 

Chiller Setpoint (°C) Reports the set point from the chiller. 

Fluid 1 Reports the last known state of the Fluid 1 bottle. At start the state will 

be Unknown until that Fluid is used. 
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Options Description 

Fluid 2 Reports the last known state of the Fluid 2 bottle. At start the state will 

be Unknown until that Fluid is used. 

Fluid 3 Reports the last known state of the Fluid 3 bottle. At start the state will 

be Unknown until that Fluid is used. 

Fluid 4 Reports the last known state of the Fluid 4 bottle. At start the state will 

be Unknown until that Fluid is used. 

Cell Flask Reports the last known state of the stir Cell Flask. At start the state will 

be Unknown until the Cell Flask is used. 

Status Message and 
1 

History 

Current instrument status, or fault conditions, are reported at the 

bottom of the tab. 

 
To see the full text of the message in a timed list of the last thousand 

status messages, press the button beside the colored Communication 

field. 

1. The Status History dialog can be copied to the clipboard to paste into another 

application if desired. 
 

Instrument Configuration Tab 

The Instrument Configuration tab indicates the current instrument configuration of the LED 

banks, emission filters, pipettor head and TETRAcycler. If the system is Offline, you can 

configure these settings to your preference in order to define protocols. 
 

Note: If a protocol created offline does not match instrument configuration when 

opened online, the protocol will not run until the configuration of the protocol and 

instrument match. 
 

Options Description 

Excitation Wavelengths Displays the excitation wavelengths installed on the system. 

 
Upper LEDs—Displays the wavelength range of the top set of LED banks in 

the LED modules. 

Lower LEDs—Displays the wavelength range of the lower set of LED banks 

in the LED modules. 

Emission Wavelengths Displays the emission filter wavelengths installed on the system. Up to 

three filters can be installed at the same time. 
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Options Description 

Pipettor Displays the type of pipettor head (96, 384, 1536, 384 pin tool, or 1536 

pin tool) installed on the system. 

 

Note: The pipettor head format must agree with 

the tip wash reservoir format. A warning is 

issued if these are different. 

Tip Washer Displays the type of tip washer (96, 384 or 1536) installed on the system. 

Camera Type Select from EMCCD or ICCD camera. 

Chiller Reports when a chiller is installed. 

TETRAcycler Reports when the TETRAcycler is installed. 

Bar code Reader Reports when a bar code reader is installed. on the TETRAcycler. 

Cell Reservoir Use the check box to indicate whether or not the Cell Reservoir is 

installed. 
 

Process Explorer Tab 

The Process Explorer is used to create new protocols. 

The Process Explorer displays processes that can be incorporated into experiment protocols. 

To add a process step to a protocol, drag the process into the protocol setup at the top of 

the Experiment window. See Constructing Protocols Using FLIPR Tetra Processes on page 57. 
 

Note: The processes available on the screen may change based on the instrument 

status, for example, the Wash Tips process is not shown if a tip wash malfunction has 

occurred. 
 

Experiment Window 

The Experiment window is the main working interface in ScreenWorks Software. It is used to 

create, view and edit protocols, used to control the instrument in an experiment, and to 

view data files generated in experiments. 

This section gives an overview of the Experiment window; following sections provide details 

of the configuration options for each of the process types used to construct protocols in the 

Experiment window. 

The Experiment window can have one protocol and multiple data files open at once, with 

options to view these one at a time, cascaded, or tiled (Window menu). File windows can be 

maximized, to occupy the entire Experiment window, minimized, reducing to a small section 

of title bar in the bottom left of the Experiment window, or arbitrarily sized and located 

within the Experiment window. 

Only one file is active at once. If the active file is a protocol file, it will control the experiment if 

the Instrument > Run Experiment command is given. 
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Protocol (*.fmp) and data (*.fmd) files both show the processes incorporated in them at the 

top of the file window, ordered from left to right. Clicking on the process icons brings forward 

the ‘page’ for that particular process, displaying its configuration settings. Data files differ 

from protocol files only in having recorded data to display when the Analysis process is 

selected, otherwise retaining all the protocol setup information contained in the protocol file 

that was used to generate the data. 

Besides showing the settings for the particular processes incorporated into a file, a one-page 

protocol summary can be viewed in the Experiment window with View > Experiment 

Summary. Revert to the experiment setup view with View > Experiment Setup. 

ScreenWorks Software always opens with a default protocol file, Untitled 1, containing four 

processes. This can be used to start construction of a new protocol, or closed or ignored if 

you wish to work with existing protocol or data files. 

Constructing Protocols Using FLIPR Tetra Processes 

Protocols are comprised of combinations of the following processes: 

Settings 

Analysis 

Transfer Fluid 

Mix Fluid 

Wash Reservoir 

Wash Tips or Pins 

Blot Pins (Pin Tool only) 

Pause Pipettor 

Finish with Source 

Read 

The Settings and Analysis processes are required for every protocol. They are automatically 
included as the first two processes in every new protocol file you create, and cannot be 

removed. 

Transfer Fluid, Mix Fluid, Wash Tips or Pins, Blot Pins, Pause Pipettor, Finish with Source 

and Read are all available to drag into a protocol from the Process Explorer based on the 

pipettor head type installed. Wash Reservoir is only available when the Cell Suspension 

option is installed. 

There are two processes additional to the basic set: 

Mix with TF 

Read with TF 

These perform the same functions as Mix Fluid and Read, but are created as options within 

a Transfer Fluid step, and are more closely integrated with the step, for example, a Read 

with TF is timed precisely to coincide with compound addition to the read plate. 
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New protocols always include a Transfer Fluid step with an associated Read with TF, but 

these can be removed or reordered, and of course additional steps can be dragged across 

from the Process Explorer. 

Processes can be added to the end of a protocol, or, using the right edge of a new process 

you drag over, inserted between other processes already in the protocol, providing you do 

not attempt to insert between processes that are internally linked, for example, a Transfer 

Fluid and associated Mix with TF. 

As each new process is dragged to the Experiment window, a new page with configuration 

options for the process is added to the file. The new page is automatically displayed. 

Similarly, as you click on the processes above, the sheet associated with that process, 

containing its configuration settings, comes forward. 

Deleting Processes from the Protocol 

To delete processes that are not connected, click on the process icon in the Experiment 

window and click the Delete key. 

To delete a connected process, Mix with TF or Read with TF, go to the Transfer Fluid 

process that it is associated with and deselect the option for the process. 

Process Icon Colors 

The Settings and Analysis processes’ icons are green to indicate that they are required to 

run an experiment. These processes’ are always present and cannot be deleted. 

The Transfer Fluid, Mix Fluid, Wash Tips or Pins, Wash Reservoir, Blot Pins, Pause 

Pipettor and Finish with Source processes icons are blue to indicate that they are liquid 

handling steps. These steps are always in series with each other; no two of them occur 

simultaneously. 

The Read process icon is orange to indicate that it will occur in parallel with any liquid 

handling process, if possible. However, a read can be added through the Transfer Fluid 

process to indicate the liquid handling will occur at a defined time in the experiment. These 

linked processes will not begin until all read and liquid handling steps prior to the Transfer 

Fluid linked with Read with TF are complete. 

When Mix with TF or Read with TF processes are created (from the options in a Transfer 

Fluid step), the icons of all the connected processes change to purple, to show the linkage. 
 

Settings Process 

Settings is the first process in all protocols. Use it to define read modes, plate positions, and 

data directories. You can also configure automatic printing of selected results, automatic file 

naming, and set plate temperature. 

Select the green Settings icon in the Experiment window to view the Settings page where the 

settings are made. 
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Setup Read Mode 

The Setup Read Mode table at the top of the Settings page displays settings for up to four 

read modes that the FLIPR Tetra system can perform in a single experiment. 

Each read mode defines: 

Reading mode (fluorescence or luminescence) 

Excitation and emission wavelengths (i.e., a pair of LED banks and emission filter) 

Camera gain 

Camera exposure time 

Excitation intensity 

Gate open (ICCD camera only) 

Molecular Devices FLIPR® Calcium and Membrane Potential Assay Kits use a single read 

mode, but ratiometric assays, such as the Voltage Sensor Probes, require two read modes. 

In these cases the instrument alternates between the two read modes for each time point, 

outputting two distinct sets of readings, one for each mode. ScreenWorks Software can then 

automatically calculate the ratio of the readings from each mode, for each time point. 

If you open a protocol file that uses read modes not available under the present 

configuration of your instrument, the unavailable read mode rows are displayed in red. 

Edit Read Mode 

To enable a read mode, click the check box in the far left of the Set Read Mode table. Then 

double-click in the row or select the row and press the Edit Mode button below the table to 

configure it. The Edit Read Mode dialog has the following fields: 
 

Options Description 

Read Mode Name Enter a name for the selected read mode, if desired. 

Reading Mode Select Fluorescence or Luminescence. 

Excitation/Emission Wavelength Select the desired excitation LED and emission filter wavelength 

pair from the list. 

 
Note: Only calibrated wavelength pairs are available when the 

software is in Online mode; see Calibrating the Optics on page 

128. 

 
NONE instructs the instrument to not turn on any LEDs or use an 

empty emission filter position. These are typically used when 

performing luminescence experiments. 

Excitation Intensity Select a value from the list to regulate the intensity of light 

emitted by the LED bank for a given Fluorescence read. The range 

is 20–100%. 
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Options Description 

Exposure Time Enter a time (in seconds) to regulate the time that light is 

collected and measured by the camera. A longer exposure 

increases signal intensity. 

 
Exposure time affects the read interval for data collection. For 

instance, an exposure time of 0.4 s, added to a required 0.1 s 

camera integration time, makes the highest update frequency 0.5 

s. 

 
The range is 0.05 s to 30 s. 

Camera Gain Select a value from the list to regulate the amplification of the 

camera power. Increasing the camera gain increases the signal. 

The range for the Standard EMCCD camera is 1–240. With the 

Aequorin ICCD camera installed, the Fluorescence read mode is 

preset to 2000, whereas in Luminescence mode the range is 

2000–280,000. 

Camera Gate This option is only available with the Aequorin ICCD camera in 

Fluorescence mode. It further regulates the signal intensity by 

selecting the percentage of each frame captured. 

 

Note: Differences in Camera Gain or Exposure Time between read modes drastically 

increase the minimum update time. For fastest update time, use the same gain and 

exposure time for all read modes. 
 

Assign Plate to Position 

The five-position stage has four positions for plates: one for the read plate and three for 

compound source plates. In order for the TETRAcycler and pipettor to address each position, 

a plate type must be assigned to each of the positions that will be used in your experiment. 

Current plate assignments are reported in the Assign Plate to Position table. 

For each plate position, the table reports: 

Plate Name—the type of plate, as configured in Tools > Plate Library. 

Bar Code Expect—Whether or not you want the system to read a bar code from the 

plate. Bar code numbers can optionally be incorporated into output data file names. 

Bar Code List—in data files only, the bar codes of plates used in the experiment, in the 

given plate position. 

Change these settings if required with the Edit Plate dialog. 

If Position 1 is to be used only for tips, and not to hold a source plate, check the Load Tips 

Position check box below the table. This removes Source Plate 1 from the table. 

If the Cell Reservoir is installed in the system, Source 3 is automatically dedicated to 

defaultcellres384. 
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Edit Plate 

To change the plate configuration for a particular position, double-click on the relevant row 

or select it and click the Edit Plate button, to open the Edit Plate dialog. 
 

Options Descriptions 

Position Displays the plate position you are editing. 

Plate Name Select the plate type from the drop-down list. The list contains default 

plates and any additional plates that have been added using Tools > 

Plate Library. 

 
Note: Only plates with the same number of wells or one order of 

complexity higher than the pipettor head format are displayed. 

Bar Code Expected Check this option if using a bar code for the plate. The bar code  

number can be incorporated into the file names of data files generated 

by the protocol. 

 
In Manual Mode, you are prompted to enter the bar codes prior to 

starting an experiment. 

 
In Remote Mode the bar code number is automatically scanned on the 

TETRAcycler landing pad or is passed to ScreenWorks by the third-party 

plate handler. 

Cell Flask Spinning Rate When the Cell Reservoir from the Cell Suspension option is installed, 

spinning rate can be set here or User Manual can be selected and the 

manual settings will be applied. 

 
CAUTION! Each plate position has a mechanical sensor to detect the presence of a 

plate, tip rack or boat in each position. However, the instrument does not distinguish 

the type of apparatus placed in a position. 
 

Edit Plate 

To change the plate configuration for a particular position, double-click on the relevant row 

or select it and click the Edit Plate button, to open the Edit Plate dialog. 
 

Options Descriptions 

Position Displays the plate position you are editing. 

Plate Name Select the plate type from the drop-down list. The list contains default 

plates and any additional plates that have been added using Tools > 

Plate Library. 

 
Note: Only plates with the same number of wells or one order of 

complexity higher than the pipettor head format are displayed. 
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Options Descriptions 

Bar Code Expected Check this option if using a bar code for the plate. The bar code  

number can be incorporated into the file names of data files generated 

by the protocol. 

 
In Manual Mode, you are prompted to enter the bar codes prior to 

starting an experiment. 

 
In Remote Mode the bar code number is automatically scanned on the 

TETRAcycler landing pad or is passed to ScreenWorks by the third-party 

plate handler. 

Cell Flask Spinning Rate When the Cell Reservoir from the Cell Suspension option is installed, 

spinning rate can be set here or User Manual can be selected and the 

manual settings will be applied. 

 

CAUTION! Each plate position has a mechanical sensor to detect the presence of a 

plate, tip rack or boat in each position. However, the instrument does not distinguish 

the type of apparatus placed in a position. 
 

Data File Name 

The Data File Name group box is used to configure a file-naming protocol for data files 

created in experiments. The file-naming protocol applies to *.fmd (data) and *.png (image) 

files. 
 

Options Description 

Include Date Check to include the date in the file name. It is checked by default. 

 
Note: To ensure that data files are not overwritten, we recommend that this 

option remains checked. 

Include Bar Code When selected, the bar codes of the first five plates used in the experiment 

are included in the file names. If there are fewer than five bar codes, then 

only those available are used. 

 
Note: Bar Code Expected must be selected for the desired plate position in 

order for the bar code to be incorporated. 

User Defined Name Enter a string of characters (up to 25) to be added to the file name. 

The base structure for file names is as follows: 

Date_UserDefinedName_Barcode1_Barcode2_Barcode3_Barcode4_ Barcode5_NNN.fmd 

where NNN is an integer from 1 to 999. The integer value NNN starts at 001 and increments 

for each data file generated with the same base data file name. 

The date uses format: MMDDYYYY, where M = month, D = day, and Y = year. 
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Note: These are print options only. To save files of data generated in experiments, use 

 

If a software crash or other error occurs during a run that interferes with normal instrument 

operation, then a data file is automatically stored as: 

InterruptedExperiment_Date_Time_NNN.fmd 

Folders 

Use the two fields here to designate directories into which data and export files will be saved. 

By default, data, image and export files are stored under: 

C:\Documents and Settings\[your user name]\My Documents\Molecular 

Devices\ScreenWorks\MyData\ 

Change—An option that allows the user to pick a different directory. 

Open Folder—An option which opens the Windows Explorer dialog box directly to the 

directory designated. 

Temperature Control 

The Temperature Control field allows you to set the plate-stage heaters to a desired 

temperature for an experiment. Temperature range is from ambient 25 °C to 40 °C (77°F to 

104°F). Select Manual Settings to control the heaters manually from ScreenWorks Software 

at the time the experiment is run. 

If, at the start of an experiment, the stage temperature is different from the selected value a 

dialog informs you of this. You can wait until the stage reaches the desired temperature or 

run the experiment anyway. 
 

Note: When the temperature is manually turned on through the Instrument menu, a 

setting of “0” in the protocol does not affect the temperature setting. If the user 

prefers to run off the temperature, this must be manually done through Instrument > 

Manual Operations > Temperature Control Off. 
 

Auto Print Options 

In the Auto Print Options section, select information to be automatically printed at the end 

of each experiment run with the protocol. 
 
 

the Auto-Export option (see Exporting Data on page 82). 

Print options are: 

Notes—Comments you have added to the protocol using the Notes option opened from 

the Analysis process page. 

Experiment Summary—The experiment summary automatically created for each 

protocol, viewed in ScreenWorks Software with the View > Experiment Summary 

command. 
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Note: Read Mode and Kinetic Reduction need to be defined for display in the 

following graphs. 

Multi-Well Graph—The graph showing the selected Read Mode time-course traces for 

all wells independently, as displayed in the Analysis process page. The option to include 

kinetic reduction values in each well of the graph is available. 

Detail Graph—A single graph with a single average trace for each group and read mode 

combination configured in the protocol. The option to include error bars on the graph is 

available. 
 

Note: Group statistic and the option to include effective or inhibition concentration 

need to be defined for the following options. 

Group Statistic Graph—A single graph with statistics acquired from the group statistics 

table for each group plotted and fit to a four-parameter curve. 

Group Statistic Table—A table utilizing the kinetic reduction data to define statistics (for 

example, mean and standard deviation) for each group defined on the plate. 

 

Analysis Process 

The Analysis process is included in all protocols and is always the second process after 

Settings. 

Viewing Data, see page 64 

Grouping, see page 73 

Correction, see page 76 

Exporting Data, see page 82 

Viewing Data 

Acquired data can be viewed in ScreenWorks Software on the main Analysis process page, in 

the Multi-Well Graph, or in larger Detail Graph. The options are described in this section. 

Multi-Well Graph 

The major part of the Analysis process page consists of a grid representing the wells of the 

read plate used in the protocol or data file (for example, with 96, 384, or 1536 wells). This is 

called the Multi-Well Graph. For protocol files this graph is empty, as no data have been 

acquired, but in data files each cell of the graph has a trace of one of the measurements 

taken from the corresponding read plate well. The maximum and minimum RLU values of the 

displayed data are reported above the Multi-Well Graph. 
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The Multi-Well Graph displays, for each well represented, one trace of relative light units 

(RLUs) versus time. If two or more read modes were recorded, select the mode to view from 

the display list box above the graph. To see the ratio of two read modes, enable Ratiometric 

Options in the Configure Corrections > Corrections dialog, and select Ratio in the display 

list. 

The Read Mode defined in the Multi-Well Graph is also applied to any traces displayed in the 

Detail Graph. 

The traces displayed in the Multi-Well Graph can be adjusted by the application of different 

data-correction options available in the Correction dialog, for example, the traces can be 

scaled relative to the average positive control response (see Correction on page 76). 

If groups have been defined for the assay, wells in the Multi-Well Graph are color-coded to 

represent these (see Grouping on page 73). In addition, there is the option to include the 

kinetic reduction value below each well trace in the Multi-Well Graph. 

Buttons, just above the Multi-Well Graph, open dialogs that offer various data analysis 

options; some relevant to protocol set up, some to already-acquired data in data files, and 

some to both. Multi-Well Graph buttons and descriptions include: 
 

Buttons Name Description 
 

 

Configure Groups Only available for protocol files, this button opens the 

Auto-Export dialog allowing configuration of statistics 

and time sequence files to be automatically created 

whenever the protocol is run. 

 
For data files the button changes to Export, and opens 

the File Export dialog, also opened from the File > 

Export command. See Exporting Data on page 82. 
 

 

Select Groups Opens the Select Groups dialog to classify which groups 

are quickly displayed in the Detail Graph from a 

predefined list based on the groups defined in the 

Grouping dialog. 

 
Note: Hold down the SHIFT or CTRL key to select 

multiple groups. 

 

 

Group Selection Mode Button toggles between Group Selection Mode and 

Well Selection Mode. 

 
During Group Selection Mode, wells selected within a 

predefined group displayed in the Multi-Well Graph will 

cause all wells within those groups to be displayed in 

the Detail Graph. 
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Buttons Name Description 
 

 

Well Selection Mode Button toggles between Group Selection Mode and 

Well Selection Mode. 

 
Well Selection Mode only displays wells selected in the 

Multi-Well Graph on the Detail Graph with their 

respective group colors assigned. 
 

 

Notes In protocol files, use this dialog to write comments that 

will be stored with all data files generated by the 

protocol. In the data files, view the comments (now 

read-only) in the same dialog. 
 

 

Images For data files only, where images have been saved 

during an experiment (by checking Save Images in a 

Read with TF step) these can be viewed by clicking the 

Images button. 
 

 

Copy Copies data in the Multi-Well graph to the clipboard so it 

can be pasted in a different program such as Microsoft 

Word. 
 

 

Configure Auto-Export Only available for protocol files, this button opens the 

Auto-Export dialog allowing configuration of statistics 

and time sequence files to be automatically created 

whenever the protocol is run. 

 
For data files the button changes to Export, and opens 

the File Export dialog, also opened from the File > 

Export command. See Exporting Data on page 82. 

 

 

Configure Correction Opens the Corrections dialog box to apply various 

corrections to modify data display. There is also the 

option to view ratiometric data. Settings made here in 

protocol files will affect how data are viewed when the 

protocol is run, but since all raw data are stored in data 

files, these options all remain available for acquired data 

as well. See Correction on page 76. 
 

 

Hide Kinetic Reduction Value Hides the kinetic reduction values that are displayed in 

the Multi-Well Graph. 

 

 

Show Kinetic Reduction 

Value 

Shows the kinetic reduction value in each well of the 

Multi-Well Graph. 
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Kinetic Reduction Types 

The Reduction Type field is located in the Kinetic Reduction Configuration dialog. Available 

options depend on the software version in use. A separate license for ScreenWorks Peak 

Pro™ adds advanced peak detection and characterization measurements to the field of 

standard measurement options (see Figure 5-2). Contact your Molecular Devices Sales 

Representative for details. 

Figure 5-2: Additional ScreenWorks Peak Pro Kinetic Reduction Types 

Standard measurement options and definitions include: 

Average—Numerical average of RLU counts of the selected reads. 

Maximum—Highest detected count (a single number) of all the selected reads. 

Buttons Name Description 

Configure Kinetic Reduction Opens the Kinetic Reduction Configuration dialog to 

define the parameters used to define the kinetic 

reduction. 

Reduction Type—Defines the reduction to be applied to 

the kinetic data traces displayed in the Multi-Well 

Graph. See Kinetic Reduction Types on page 67. 

Start Read—Define the first read to be used to 

determine the kinetic reduction. 

End Read—Define the last read used to determine the 

kinetic reduction. 

Read Mode—Select the read mode to apply the kinetic 

reduction to. 
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Maximum-Minimum—Result of subtracting the minimum count (a single number) from 

the maximum count (a single number). 

Minimum—Lowest detected count (a single number) of all the selected reads. 

Sum—Numerical sum of RLU counts of the selected reads. 

Area Under Curve—Numerical calculation of the area under the curve for the selected 

reads. 

Slope of Curve—Result of calculating the slope between two selected reads. 

(With optional license) Peak Pro measurement options and definitions include: 

Peak Frequency (BPM)—The Beats-Per-Minute frequency of the peaks detected based 

on the inverse of the peak temporal spacing. At least two peaks are required for this 

measurement. 

Peak Count—Number of peaks or action potentials detected within the read data that 

meet the specifications in the Configure Peak Detection dialog settings. 

Average Peak Width—Average peak width measurement in seconds from the 50% peak 

amplitude from baseline. 

Peak Width Standard Deviation—Standard deviation of average peak widths. 

Average Peak Amplitude—The average peak amplitude relative to the Average Peak 

Baseline measurement. 

Peak Amplitude Standard Deviation—Standard deviation of peak amplitudes. 

Average Peak Baseline—Average baseline amplitude measurement from the base of 

each peak detected. 

Average Peak Spacing—Average peak spacing in seconds. At least two peaks are 

required for this measurement. 

Peak Spacing Standard Deviation—Standard deviation of peak spacing. 

Average Peak Rise Time—Average time measured on the rising edge for each peak. 

Equal to the time between the 10% and 90% peak amplitudes. 

Rise Time Standard Deviation—Standard deviation of rise times. 

Average Peak Decay Time—Average time measured on the falling edge for each peak. 

Equal to the time between the 90% and 10% peak amplitudes. 

Peak Decay Time Standard Deviation—Standard deviation of decay times. 

Average Peak Width at 10% Amplitude—Average peak width in seconds at the 10% 

peak amplitude from baseline. 

Irregular Spacing—Identifies wells that have irregular spacing between peaks. Wells with 

regular peak temporal spacings are marked as OK. Wells with missing peaks are marked 

as MISS. Wells with extra peaks are marked as EXTRA. Wells with peak spacing 

characteristics of both missing and extra are marked as IRREG. 
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The Configure Peak Detection button activates when a Peak Pro measurement is selected 

from the Reduction Type field (see Figure 5-3). The Configure Peak Detection dialog allows 

the Peak Pro measurement settings to be adjusted and optimized (see Figure 5-4). 

Figure 5-3: Configure Peak Detection button activation 

Configure Peak Detection dialog options include: 

Smooth Width 

Fit Width 

Slope Threshold 

Amplitude Threshold Dynamic 

Amplitude Threshold Fixed 

Figure 5-4: Configure Peak Detection dialog 

Detail Graph 

All the read modes for wells selected in the multi-well graph can be displayed enlarged in a 

detail graph. You can select individual or multiple wells to view, or select by group. 
 

Note: When the FLIPR Tetra system is configured for two or more read modes, it 

cycles through each mode alternating between them for each reading. Although 

readings from each mode within a cycle occur at different times, they are represented 

as occurring simultaneously. 

The data displayed in the Detail Graph have the same corrections applied as the data 

displayed in the Multi-Well Graph. The Detail Graph reports these settings at the top of the 

graph window: 
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Subtract Bias 

Spatial Uniformity Correction 

Negative Control Correction 

Positive Control Scaling 

Response Over Baseline 

Crosstalk Correction 

These correspond directly to options in the Correction dialog, opened from the Analysis 
process page. To change these settings, change them in the Correction dialog. This will 

change all data in the Multi-Well Graph and Detail Graph to reflect the new correction 

applied. Detail Graph allows a number of data-selection options: 
 

Buttons Name Description 
 

 

Copy Graph Copies Graph in the Detail Graph to the clipboard so it 

can be pasted in a different program such as 

Microsoft Word. 
 

 

Copy Graph Data Copies graph data in the Detail Graph to the clipboard 

so it can be pasted in a different program such as 

Microsoft Excel. 
 

 

Zoom Mode Click to enable zoom capability in the graph. Once the 

Zoom button is pressed, drag over a region in the 

graph to view just that area enlarged to the full size of 

the graph. 

 
Alternatively, drag the cursor along a part of the x or y 

axis to zoom in on just that axis. 
 

 

Auto Scale Manual prompt to automatically scale the Detail 

Graph and Multi-Well Graphs to include all data points 

of the desired traces. 
 

 

Auto Scale Always Automatically scales the Detail Graph and Multi-Well 

Graph to include all data points of the desired traces 

without manual prompting. 
 

 

Undo Zoom Rescales a graph to the original settings. 

 

 

Manual Scale Graph Opens the Manual Scale Graph dialog to set the 

maximum and minimum values for the X- and Y-axis 

of the Detail Graph and Multi-Well Graph. 
 

 

Show/Hide Data Toggle button that shows or hides the RLU values for 

the selected traces at each read. 
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Buttons Name Description 
 

 

Show Point Labels Show Point Labels writes the value of each data point 

(for example, RLU value) beside the point on the 

graph. 
 

 

Show/Hide Legends A toggle button that displays or hides the Detail 

Graph legend. 

 

 

Average/Overlay Trace A toggle button that displays the average or overlay 

traces for selected groups. 

 
Average Group—Displays average time point values 

for all wells in the selected group. A separate trace is 

generated for each read mode. 

Note: When Well Selection Mode selected in the 

Multi-Well Graph, all traces displayed in the Detail 

Graph will be averaged regardless of the group they 

are assigned. 

Overlay Group—Displays traces for all the wells in 

selected groups. 

Note: Traces are color-coded by group. 
 

 

Show/Hide Standard Deviation A toggle button that enables or hides the standard 

deviation for the average group trace. 

Note: Average Group must be enabled to access this 

function. 

When Well Selection Mode is selected in the Multi- 

Well Graph, all traces displayed in the Detail Graph 

will be averaged regardless of the group they are 

assigned, and the standard deviation for this average 

will be displayed. 

 

Individual Well Selections 

To view a single well in the Detail Graph, double-click or drag the mouse cursor inside the 

well of interest. 

To view the traces of multiple wells overlaid in the Detail Graph, drag the cursor over the 

wells you want to view. Data from any rectangular block of wells within the plate can be 

viewed in this way. Additional wells can be added to the overlay by double-clicking or 

dragging the mouse cursor over the wells of interest. 

Group Selections 

You can also select data to view in the Detail Graph using group membership (see Grouping 

on page 73). This can be achieved using Select Group or Group Selection Mode functions 

found in the Multi-Well Graph. 
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Detail Graph Options 

Detail graphs have a number of visualization options available in addition to the shortcut 

buttons found at the top of the graph. When you right-click on the detail graph, a menu of 

visualization tools is displayed. These are summarized in the following table. 
 

Options Description 

Properties Opens the Graph Properties dialog to define Detail Graph properties including: 

title of graph, X- or Y-axis, graph scaling and background color. 

Zoom Select to enable zoom capability in the graph. 

 
Once the Zoom is selected, drag over a region in the graph to view just that 

area enlarged to the full size of the graph. 

 
Alternatively, drag the cursor along a part of the X- or Y-axis to zoom in on just 

that axis. 

Undo Zoom Rescales the graph to the original settings. 

Full Scale Scales the X- and Y-axis of the Detail Graph to the parameters defined in the 

Manual Scale Graph option. 

Auto Scale Manual prompt to automatically scale the Detail Graph to include all data points 

of the desired traces. 

Auto Scale Always Automatically scales the Detail Graph to include all data points of the desired 

traces without manual prompting. 

Analyzing Data 

The Grouping and Correction dialogs, opened from the Analysis process page, are used to 

analyze data produced during an experiment. Settings made in these dialogs in a protocol 

file affect the way that data, in data files generated with the protocol, are displayed when 

first viewed in ScreenWorks Software. They also affect data in automatic output options that 

occur when the protocol is run: automatic print output options (see Settings Process on 

page 58, and Auto Print Options on page 63) and Auto Export (see Exporting Data on page 

82). However data files created by ScreenWorks Software retain all raw data readings, so the 

analysis options in the Grouping and Correction dialogs can be applied to acquired data, 

modifying the display of these, irrespective of the analysis settings configured in the original 

protocol. 

Grouping and Correction are explained in the following separate sections. 
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Grouping 

Define groups in the Grouping dialog, opened from the Configure Groups button on 

Analysis process page. 

A group is a selection of wells with a common characteristic—usually in the type of 

compound added to the wells. Three groups—background fluorescence correction, positive 

controls and negative controls—are defined by default, but no wells are assigned to them. 

The well assignment for these groups is left to the user. 

Users can create additional groups to represent wells with a specific ligand, or ligand 

concentration, or any other characteristic they want to classify data by. Group definition 

includes specific input for compound concentration, as this is commonly used for group 

definition. Additionally, the Series option allows users to create a series of groups, where a 

number of different concentrations are automatically assigned to each group. This can be 

useful for creating groups for an IC50 or EC50 experiment. 

Groups are used to select data to be viewed in the detail graph, and the data itself can be 

corrected relative to responses to positive and/or negative control groups, in the Correction 

dialog. 

The Grouping dialog contains a grid representing the 96-, 384- or 1536-well read plate, and 

above this a list box where groups are defined and selected. The basic mode of operation is 

to select a group from the list box, then drag the cursor over the wells in the grid that belong 

to that group. Additional groups can be defined to add to the list. 

The following table describes the settings and options in the Grouping dialog: 

Options Description 

Groups Displays the list of defined groups, including group name (typically 

compound name), concentration and notes associated with the group. Wells 

assigned to a group in the grid below have the same color as the group in the 

list. 

Positive Controls—Use this group to assign positive control wells, typically 

the maximum response to a concentration of an agonist. 

Note: Positive Control wells need to be defined in order to use the Positive 

Control Scaling Correction. 

Negative Controls—Use this group to assign negative control wells, typically 

buffer addition controls. 

Note: Negative control wells need to be defined in order to use the 

Negative Control Correction feature. 

BF Controls—Use this group to assign wells in which to measure background 

fluorescence. Measurements for each time point from these wells are used 

for Background Fluorescence Correction for ratiometric data (see 

Ratiometric Options on page 77). 

_add new group—Use this to define a new individual group or a series of 

groups that are user-defined. 
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Options Description 

Add/Edit Group Opens the Edit Group dialog to edit the group selected in the Groups list. This 

could be an existing group, or create a new group by selecting the Add New 

Group row. 

 
Shortcut: Open the Edit Group dialog by double-clicking on a group in the 

Groups list. 

Delete Group Deletes the group selected in the Groups list. Any wells assigned to the group 

lose their coloring, indicating that they no longer belong to any group. 

Delete All Groups Deletes all user-defined groups. 

Note: Positive, negative and background fluorescence control groups cannot 

be deleted, however this command deletes all wells assigned to these 

groups. 

Clear All Selections Removes all group assignments from all wells. Group names in the top list 

are not affected. 

Undo Last Selection Removes group membership from the last wells that were assigned to a 

group. 

 

Changing Wells Assigned to Groups 

To assign wells to a group: 

1. Select the appropriate group from the Groups list, for example, Positive Controls. 

2. Drag the cursor over the wells from the plate layout that you want to include in the 

selected group. Alternatively, the row or column title can be selected to include all the 

respective wells in the group. 
 

Note: Wells in a group do not need to be contiguous. Multiple areas of the plate 

may be selected. 

You can deselect individual or neighboring wells by right clicking in one corner of a well to 

be deselected, then dragging over the well or wells to deselect. 

3. Repeat Steps 1–2 to assign other wells to different groups. 
 

Adding a New Group 

To add a new group: 

1. Select _add new group from the Groups list and click the Add/Edit Group button (or 

double-click on the group). The Select Type of Group dialog opens. 

2. You can choose to configure a single group with specific settings on the Group tab, or 

configure a series of groups, with incrementing concentration values, on the Series tab. 
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3. To assign a single group concentration, click the Group tab and do the following: 

Enter a name for the group (for example, compound name) in the Group Name field. 

Select or enter the concentration in the Concentration box. 

Select the concentration units in the Units drop-down list. The choices are nM, µM, 

mM, M or Log. 

In the Notes area, type in any notes that you want associated with the specified 

group and data file. 

4. To assign a series of concentrations, click the Series tab and do the following: 
 

Note: The Series option is typically used for assigning a dose-response curve with 

regular increment steps. 

Enter a name for the group (for example, compound name) in the Group Name field. 

Select or enter the lowest or highest concentration of the series in the Starting Value 

field. 

Select or enter the change in concentration between concentrations in the series in 

the Step Increment field. 

Select the concentration units in the Units drop-down list. The choices are nM, µM, 

mM or M. 

Decide how the Step Increment is applied to the Starting Value to create the series, 

for example, Plus, Minus, Multiply or Divide, and select it from the Operation drop- 

down list. 

If you have replicates, select whether they are aligned in row or column format on 

the plate. If replicates align in both row and column formats, indicate the number of 

replicates (for example, Replicates in rows indicates all wells in the selected rows will 

have same concentration). If two rows are to include the same concentration, 

indicate “2” replicates. If there are no replicates, select None. 

Select the direction in which the series will increment, for example, Left, Right, Top or 

Bottom. 

In the Notes area, type in any notes that you want associated with the specified 

group and data file. 

5. When finished, click OK to save the defined group. 

When a series is created, assign wells to it as described above. Successive rows or columns 

are assigned different concentrations and group color automatically, as configured in the 

series. 
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Correction 

Use the Correction dialog to apply data-correction algorithms, and to view ratiometric data. 

These changes affect: 

Data displayed in the Multi-Well Graph and Detail Graph. 

Data displayed in group statistic table and graphs. 

Data in files are exported manually or automatically (see Exporting Data on page 82). 

Data in printed output configured in the Settings process page (see Auto Print Options 

on page 63). 

Plainly, once data are exported, they cannot be changed, so settings made in this dialog in 

protocol files are important for these output options. For viewing data in ScreenWorks 

Software, however, since raw data are always kept, correction options selected in protocol 

files can be altered when the data are viewed in resulting data files. 

The following table includes brief descriptions of the options in the Correction dialog; for a 

full descriptions, see Data Processing Algorithms on page 237 : 
 

Options Description 

Crosstalk Correction Only available with Aequorin, ICCD camera. Check this option to 

correct all wells for crosstalk from neighboring wells. The crosstalk 

function is based on well-to-well distance and the measured 

percentage of crosstalk. 

Positive Control Scaling Check to average each maximum RLU value from the positive 

control group and normalize all samples to this value (set at 100%). 

This function is useful when graphing a dose-response curve or 

when comparing data between experiments. 

Negative Control Correction Check this option to have an average negative control well value 

and ratio-to-well value calculated for each sample interval (time 

point). This ratio is calculated for each sample interval and applied 

to all wells. This function provides a good correction for signal drift 

and artifacts. 

Spatial Uniformity Correction Check this option to use the initial signal to normalize signal in each 

well, removing fluctuations due to well-to-well variation in cell 

density and dye loading. The processing algorithm averages the 

initial signal from all wells together. It then scales each individual 

well relative to the average. This correction is particularly 

recommended when you want to normalize cell number, type and 

dye-loading conditions throughout a plate. 

 
Note: Spatial uniformity should only be used when all wells in a 

plate are treated the same prior to an experiment (for example, 

dye loading, cell numbers, etc.). 
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Note: Spatial uniformity correction and response over baseline are disabled when 

 
 

Options Description 

Subtract Bias Based On Sample Check this option to subtract the RLU measured at a selected read 

number from all other time points in each well. This option 

enables you to set the Y-axis scale so that at the time point 

specified, the Y-axis values for all data graphs is zero. Select the 

read number to be subtracted in the field to the right of the check 

box. The default is read number 1. 

Response Over Baseline Check this option to display the trace as a ratio of the response to 

the average of a set of predefined reads. 

 
Baseline Start—First read to be included in the averaged baseline 

value. 

Baseline End—Last read to be included in the average baseline 

value. 

Show As Percentage—Displays response as a percent increase 

over the average baseline value. 

Each of the correction options can be applied alone or in combination with the others. When 

a combination is selected they are applied in the following order: 

1. Crosstalk 

2. Spatial Uniformity Correction or Response Over Baseline 

3. Negative Control Correction 

4. Positive Control Scaling 

5. Subtract Bias 
 

Note: Spatial uniformity correction and percent baseline cannot be applied at the 

same time. 
 

Ratiometric Options 

Where two read modes are configured, you can view the data as a ratio of one read mode to 

the other, for each data point. 

When this option is enabled, traces of the calculated ratio can be displayed in the multi-well 

and detail graphs. 

Prior to calculating the ratio, ratiometric data is corrected for fluorescence background by 

subtracting estimated background values from both numerator and denominator for each 

time point. Once the fluorescence background is subtracted, the ratio is then calculated. 

Additional user-selected corrections are applied to the ratio, beginning with negative control 

correction, positive control scaling, followed by subtract bias. 
 
 

Ratiometric Options are active. 

Ratiometric parameter settings are described in the following table: 
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Options Description 

Ratiometric Options Enable ratiometric data viewing by checking the check box. 

Specify how the ratio is defined by selecting the read modes 

to be used as numerator and denominator. 

Background Fluorescence Correction Scale by BF Control Group—For each time point and read 

mode in the ratio, the average value for that time point in the 

background fluorescence control wells (BF Controls, in the 

Grouping dialog) is subtracted. The ratio is calculated after 

subtraction of the average value from both numerator and 

denominator. 

 
Scale by Constant Values—Constant values to subtract from 

the numerator and denominator for each time-point ratio 

are entered by the user. 

 
You must enter these constant values in the numerator and 

denominator fields when this option is selected. 
 

Group Statistics 

Below the Multi-Well and Detail Graphs on the Analysis process page, the Group Statistics 

Table is used to analyze data produced during an experiment. Groups defined in the 

Grouping dialog can only be analyzed in this section. In addition, settings made in the 

Correction dialog influence the group statistics that are reported. 

To analyze data in the Group Statistics Table, groups must first be defined in the Grouping 

dialog. When defined, the Configure Kinetic Reduction button is selected in Multi-Well 

Graph to define the reads and reduction type to be analyzed. 

Features of the Group Statistics Table are explained in separate sections. 
 

Buttons Name Description 
 

 

Copy Table Data Copies data in the Group Statistic Table to the 

clipboard so it can be pasted in a different program 

such as Microsoft Excel. 

 

 

Collapse All Groups Collapses the Group Statistics Table to only display 

the group name and relative statistics. 

 
This works as a toggle button with Expand All Groups 

which displays the individual wells and kinetic 

reduction values that comprise each group statistic. 
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Buttons Name Description 

 

 

Expand All Groups Expands the Group Statistics Table to display all the 

individual wells and kinetic reduction values that 

comprise each group statistic. 

 
This works as a toggle button with Collapse All 

Groups, which displays only the group name and 

individual statistics. 

 

 

Auto Fit All Columns This is used to collapse the column width so it is no 

wider than the title of the column or largest data 

point. 

 

 

Select Statistics Opens the Choose Statistics dialog box which enables 

users to define groups statistics (for example, 

Average, Standard Deviation and Z-score) are 

displayed in the table. 

 
Group statistics available include the following: 

Concentration—Numerical concentration values 

assigned to each group in the Grouping dialog. 

Units—Concentration units (for example, uM) 

assigned to each group in the Grouping dialog. 

Notes—Comments assigned to each group in the 

Grouping dialog. 

Average—Numerical average of the kinetic reduction 

values for a given group. 

Maximum—Highest value (a single number) of all 

kinetic reductions within a group. 

Maximum-Minimum—Result of subtracting the 

minimum kinetic reduction value from the maximum 

count kinetic reduction value for a single group. 

Minimum—Lowest kinetic reduction value within a 

group. 

Sum—Numerical sum of all kinetic reduction values 

within a group. 

Standard Deviation—Defines the numerical value 

associated with one standard deviation from the 

average. 

Standard Deviation+1—Equals the average group 

value plus one standard deviation. 

Standard Deviation-1—Equals the average group 

value minus one standard deviation. 
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Buttons Name Description 

 

 

Select Statistics (continued) Z Score—Used to evaluate quality or performance of 

the assay and is dependent on the concentration 
1 

evaluated . 

 
Z-factor—Used to evaluate the quality or 

performance of the assay at a given concentration. 

This is typically used for all concentrations, not 

including the positive control. Calculation used: 

 
Z = 1 - [3*(std dev of GROUP + std dev of neg 

ctrls)/abs(mean of GROUP - mean of neg ctrls)] 

 
Z’-factor—A characteristic parameter for the quality 

of the assay itself. This is typically performed using 

data only from the positive control concentration. 

Calculation used: 

 
Z' = 1 - [3*(std dev of pos ctrls + std dev of neg 

ctrls)/abs(mean of pos ctrls - mean of neg ctrls)]. 

1. Zhang, J., Chung, T. D. Y. and Oldenburg, K. R. (1997). A Simple Statistical Parameter for 

Use in Evaluation and Validation of High Throughput Screening Assays. Journal of 

Biomolecular Screening 4(2):67:73. 

The statistics defined in the Group Statistic Table can be plotted in the Group Statistic 

Graph, located behind the Detail Graph, to quickly view a dose-response curve. All groups 

are included in the graph, unless the user right-clicks on the desired group and selects 

Exclude Groups From Statistic Chart. Groups not used in the graph will have a green line 

through the entire row of the group. To include the group in the graph, right-click the group 

and select Include Groups In Statistic Chart. Data displayed in the Group Statistic Graph is 

defined by selecting the desired group statistic from the Group Statistic Table. Therefore, if 

the standard deviation is the desired data to be evaluated, select the Standard Deviation 

column header to highlight this data in the Group Statistic Table and it will be displayed in 

the graph. 

Features of the Group Statistic Graph are explained in separate sections. 
 

Buttons Name Description 
 

 

Copy Graph Copies data in the Group Statistic Graph to the 

clipboard so it can be pasted in a different program 

such as Microsoft Word. 
 

 

Copy Graph Data Copies Graph Data in the Group Statistic Graph to the 

clipboard so it can be pasted in a different program 

such as Microsoft Excel. 
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Buttons Name Description 
 

 

Zoom Mode Press to enable zoom capability in the graph. Once 

the Zoom button is pressed, drag over a region in the 

graph to view just that area enlarged to the full size of 

the graph. 

 
Alternatively, drag the cursor along a part of the X- or 

Y-axis to zoom in on just that axis. 

 

 

Auto Scale Manual prompt to automatically scale the Group 

Statistic Graph to include all data points of the 

desired traces. 
 

 

Auto Scale Always Automatically scales the Group Statistic Graph to 

include all data points of the desired traces without 

manual prompting. 
 

 

Undo Zoom Rescales graph to the original settings. 

 

 

Manual Scale Graph Opens the Manual Scale Graph dialog to set the 

maximum and minimum values for the X- and Y-axis 

graph. 
 

 

Show/Hide Data Toggle button that shows or hides the data for the 

selected traces at each read. 

 

 

Show Point Labels Show Point Labels writes the value of each data point 

(for example, RLU value) beside the point on the 

graph. 
 

 

Show/Hide Legends A toggle button that displays or hides the detail graph 

legend. 

 

 

Show/Hide Smoothed Curve A toggle button that displays or hides the 4- 

parameter curve fit. 

 
This feature can be displayed at the same time as 

Show/Hide Original Trace. 

 

 

Show/Hide Original Trace A toggle button that displays or hides the trace of the 

graph, which connects each data point. 

 
This feature can be displayed at the same time as 

Show/Hide Smooth Curve. 
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Buttons Name Description 
 

 

Show/Hide Real Data Points A toggle button that displays or hides the data points 

to create the graph. 

Note: It is recommended that either the Original 

Trace or Smoothed Curve features are activated 

when the data points are hidden. 
 

 

Display X-Axis in Log Scale A toggle button that converts the X-axis from a 

concentration to a log concentration scale. 

 

 

Show/Hide EC/ICXX Value A toggle button that displays or hides the 

effective/inhibition concentration from being 

displayed. When activated, the user defines the 

percentage of activation/inhibition that the graph will 

plot. 

 

Exporting Data 

ScreenWorks Software has two means of exporting data: 

Automatic export when a protocol is run, configured in protocol files. 

Export from already acquired data, in data files. 

Export options are accessed in different ways in the two cases: 

In protocol files use the Auto Export button in the Analysis process page. 

For data files, use File > Export, File or Batch Export, or the Export button on the 

Analysis page. The Export button allows export only of the current data file, while the 

File menu has options to export the current file or batches of files on disk. 

Data is exported as ASCII text format files, with a separate file exported for each 

measurement configuration you ask for. When data is exported from data files you must 

enter a folder to write the output files to. In the Auto-Export option, files go to the folder 

defined in the Settings process. The default export folder is: 

C:\Documents and Settings\[your_user_name]\My Documents\Molecular 

Devices\ScreenWorks\MyData 

The Auto-Export dialog has three tabs: 

Time Sequence—Exports time-point measurements for selected read modes. The 

measurement values that are exported have any corrections configured in the 

Correction dialog applied. If there are two read modes and Ratiometric Options is 

selected in the Correction dialog, you can also export the ratio for each time point. 

Files have a *.seqn extension, where n increments for each file generated in the export. 

Statistics—Exports averages, maximums, and other kinetic reduction values for selected 

numbers of reads for each well. 

Files have a *.statn extension, where n increments for each file generated in the export. 
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Group Statistics—Exports the group statistical values for selected numbers of reads for 

each group and are based on user-defined kinetic reduction settings. 

Files have a *.gstatn extension, where n increments for each file generated in the export. 

Further details about these tabs are provided in the sections below. 

When exporting data files the dialog also has a Files tab where you can set the export 

directory and select batch files to export if this option is selected. 
 

Note: Data created in previous versions of the FLIPR Tetra system operating software 

cannot be viewed or exported by ScreenWorks Software. 
 

Exporting Time Sequence 

Configure parameters for export of time-sequence data in the Export Time Sequence tab. 

The exported files contain a value for every read interval for each well, for the read mode or 

ratio selected. This contrasts with the Statistics file, which contains one kinetic reduction per 

well. 

 
The following table describes the settings and options of this dialog: 

 

Options Description 

Enable Time Sequence Check this option to have a time sequence export file created. 

File Name Options Choose a name for the exported time sequence file. 

 
Use name of data file—Export files with the data or protocol file 

name, with *.seqn extension, where n is an integer ≥ 1. 

Use user-defined name—Enter your own name for the export files 

(maximum of 25 characters). Files are given *.seqn extension, where 

n is an integer ≥ 1. 

Data Format Format the output from this group of options: 

 
Show Labels—Check to include information about the processing 

options selected (for example, name of *.fmd file and well labels). Any 

corrections prior to export (e.g., negative control correction) are 

reported at the top of the exported ASCII file. 

Order of Well Data—Order the data by column (for example, A1, A2, 

A3) or by row (for example, A1, B1, C1). Set this option in accordance 

to the way your spreadsheet or database handles well data. 

Order Time Data—Select vertical or horizontal ordering of the data. 

Misc. Parameters Select experimental parameters and group statistics to export with the 

data. 
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Options Description 

Individual File Parameters Use the bottom section of the dialog to choose the number and type 

of time sequence files to be created from the same data set. 

 
Number of Files—Click the Add File button to add to the number of 

statistic files to be created from the same data set. 

Read Mode—Enter the read mode (or ratiometric data) from which 

you want to export data. 

From Quadrant—You can choose a specific quadrant from which to 

export, or export data from all quadrants. This enables you to export 

data from one plate into four different spreadsheet files, if desired. 

 
Note: This option is only available for data created in 384- or 1536- 

well formats. 

 

Exporting Statistics 

Use the Export Statistics tab to configure kinetic reductions, for example, averages and 

maximum and minimum values, for selected numbers of reads within each well. Multiple 

kinetic reductions can be configured, each resulting in another export file. Within each file 

only one value is reported per well. 

The following table describes the settings and options of this dialog: 
 

Options Description 

Enable Statistics Check this box to have a statistic file created. 

File Name Options Choose a name for the exported statistic file. 

 
Use name of data file—Export files with the data or protocol file 

name, with *.statn extension, where n is an integer ≥ 1. 

Use user-defined name—Enter your own name for the export files 

(maximum of 25 characters). Files are given *.statn extension, where 

n is an integer ≥ 1. 

Data Format Format the output from this group of options: 

 
Show Labels—When checked, the output file contains information 

about the processing options selected (for example, name of *.fmd 

file and well labels). Any corrections done prior to exporting the data 

(e.g., negative control correction) are indicated in text format at the 

top of the exported ASCII file. 

Order of Well Data—Order the data by column (for example, A1, A2, 

A3) or by row (e.g., A1, B1, C1). Set this option in accordance to the 

way your spreadsheet or database handles well data. 

Misc. Parameters Select experiment parameters and group statistics to export with the 

data. 
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Options Description 

Individual File Parameters Use the bottom section of the dialog to designate the number and 

type of statistic files to be created from the same data set. 

 
Number of Files—Click the Add File button to add to the number of 

statistic files to be created from the same data set. 

Compute—Select a kinetic reduction type. See Kinetic Reduction 

Types on page 67. 

Start Read—Enter the first read number to be included in the kinetic 

reduction. 

End Read—Enter the last read number to be included in kinetic 

reduction. This can equal the Start Read, if you want to extract values 

from a single read. 

Read Mode—Enter the read mode (or ratiometric data) from which 

the data will be processed. 

From Quadrant—You can choose a specific quadrant from which to 

export, or export data from all quadrants. This enables you to export 

data from one plate into four different spreadsheet files, if desired. 

 
Note: This option is only available for data created in 384- or 1536- 

well formats. 

 

Exporting Group Statistics 

Use the Export Group Statistics tab to configure group statistics (for example, average, 

standard deviation and z-scores) based on the kinetic reduction defined for a select number 

of reads. 

The following table describes the settings and options of this dialog: 
 

Options Description 

Enable Group Statistics Check this box to have a group statistic file created. 

File Name Options Choose a name for the exported group statistic file. 

 
Use name of data file—Export files with the data or protocol file 

name, with *.gstatn extension, where n is an integer ≥ 1. 

Use user-defined name—Enter your own name for the export files 

(maximum of 25 characters). Files are given *.gstatn extension, where 

n is an integer ≥ 1. 
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Options Description 

Kinetic Reduction Configures the parameters used to define the kinetic reduction. 

 
Reduction Type—Defines the reduction to be applied to the kinetic 

data traces exported. See Kinetic Reduction Types on page 67 for 

details. 

Start Read—Define the first read to be used to determine the kinetic 

reduction. 

End Read—Define the last read used to determine the kinetic 

reduction. 

Read Mode—Select the read mode to apply the kinetic reduction. 

Misc. Parameters Select experiment parameters to export with the data. 

 

Batch Exporting 

Manual export of files is accessed through File > Export, File or Batch Export. Manual 

Export allows the same files as defined above to be exported. In addition to individually 

exporting files, Batch Export enables batches of data files to be exported to individual or 

single export files. 

The following table describes the settings and options of the Batch Export dialog: 
 

Options Description 

Export Directory User defines where export files are 

to be sent. The default export folder 

is: 

 
C:\Documents and Settings\[your_ 

user_name]\My 

Documents\Molecular 

Devices\ScreenWorks\MyData 

Batch Export Following Files Selecting Add opens the Open File 

dialog to choose data files to be 

exported. 

 
Note: Hold down the SHIFT or CTRL 

key to select data files. 
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When batch exporting data, the export files produced will vary depending on the options 

you select in the individual export statistic, time sequence and group statistic sections. If a 

single export file is desired for each data file exported, select Use name of data file in the 

respective section you want to export. Export files created using this method will be labeled 

with the name of the data file it was created from. However, if a single export file is desired 

that contains information for multiple data files, select Use user-defined name in the 

respective section. In this instance, all exported information will be combined into one file 

labeled with the desired user-defined name. When the file is open, the individual data file 

names which the information was exported from are used as the header for each data set 

within the export file. 

Image Display 

Use the Image Display dialog, opened from the Analysis process page, to view images saved 

in data files when Save Images was enabled during a Read with TF step. This option stores a 

total of 100 images per experiment; the number of images per dispense is user-defined. The 

default is set to one image before and nineteen images after the fluid addition is initiated. 

Saved *.tif files can be played back in sequence, frame-by-frame or as a video. 

Options Description 

Correction Options During export, either the existing or 

new corrections can be applied. 

Use corrections already applied in 

each data file—Applies the existing 

corrections saved with each data file 

during export. 

Use same corrections for all files— 

Applies and saves new corrections to 

all data files. Useful when exporting 

all data files with same parameters 

or saving the same correction to 

multiple data files. Details regarding 

available corrections can be found 

under Correction on page 76. 

If an error occurs while trying to export a file, do the 

following 

Put up an error message and let me 

decide what  to do—Enables the 

user to decide how to proceed when 

an error is encountered. 

Skip the file—Does not include the 

data in the export, but continues to 

export data. The option to write the 

error to a log file is available. 
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Image Display is useful for diagnosing problems. For example, if cells are blown off during a 

fluid dispense, you will see dark holes in the middle of the cell layer after the fluid addition. If 

the entire well decreases in relative light units, it is likely that extracellular dye has been 

diluted. 

Notes 

In protocol files, open the Protocol Notes dialog where you can enter comments that you 

want kept with all data files generated with the protocol. The dialog contains a simple text 

editor for you to format your comments. 

In data files the same dialog shows the comments that were added in the protocol file, now 

in read-only format, so they cannot be edited. 
 

Transfer Fluid Process 

This process enables you to program reagent or cell additions and to execute them in 

conjunction with other processes. 

The default protocol has one Transfer Fluid process. 

A blue Transfer Fluid icon indicates that the process occurs in series with other blue-colored 

processes in the protocol. A purple icon indicates that the execution of the process is 

synchronized to a Read or Mix Fluid process (which will also have a purple icon). 

The Transfer Fluid process has different options for pin tools and standard pipettors. In each 

case you must configure aspiration and dispense of compound separately. 

For a standard pipettor you can configure more than one aspiration or dispense (but not 

both) within the process, with the appropriate ‘multiple’ Fluid Transfer Type. 

With a standard pipettor selected, aspiration and dispense steps are configured by selecting 

the appropriate row in the aspiration or dispense table and pressing the Edit button to open 

a configuration dialog. With the Pin Tool, aspiration and dispense configuration is done 

directly in the Transfer Fluid page. 

To enable additional dispense steps with a standard pipettor, select the multiple dispense 

option in the Fluid Transfer Type. Then configure the first dispense with a volume less than 

the volume aspirated. An additional dispense is automatically enabled for the remaining 

volume. Similarly, for multiple aspirates, configure the first aspirate with less volume than 

the dispense. 
 

Note: The entire volume of fluid aspirated is always dispensed. 
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Aspirate Configuration (Standard Pipettor) 

The following table describes configuration options for the upper, Aspirate, section on the 

Transfer Fluid process page when a standard pipettor is selected. 
 

Option Description 

Fluid 

Transfer 

Type 

Select a type of fluid transfer: 

Single Aspirate–Single Dispense—Aspirates one liquid volume and dispenses that 

entire liquid volume in one action into a plate. 

Single Aspirate–Multiple Dispense—Aspirates one liquid volume and dispenses up 

to four distinct liquid volumes into four distinct quadrants or plates. Add additional 

dispenses by making the dispense volume less than the aspirate volume. 

 
Note: The last dispense expels all liquid remaining in the tip. Tips to improve Single 

Aspirate–Multiple Dispense (by quadrature) pipetting precision include: 

* When pipetting do not use hold and expel volumes. In addition use the slowest 

removal speed (2 mm/s). 

* Aspirate 5–10% more than is needed from the source plate (for example, aspirate 

110 µL when dispensing 25 µL into four quadrants. 

* Include a mix step with 3 strokes in the desired source plate to pre-wet tips. Mixing 

of fluid in the source plate primes the internal walls of the tips, reducing surface 

tension between the fluid and tip plastic. 

 
Multiple Aspirate–Single Dispense—Aspirates up to four liquid volumes from up to 

four aspirate plates and dispenses entire tip contents into a single plate. To add 

additional aspirates, make the aspirate volume less than the dispense volume. 

Read Check this box to link a Read process to the Transfer Fluid process. 

This automatically adds a Read with TF step to the protocol, and opens the 

configuration page for that step. 

 
See Read Process on page 97 for more information about read process options. 

Note: This option is required if you intend to read a plate while transferring liquid 

during a kinetic cell-based assay (for example, calcium mobilization). 

Aspirate Check the check box at the start of a row to activate an aspirate sequence. 

 
If Multiple Aspirate has been selected as Fluid Transfer Type, enter an aspirate 

volume less than the dispense volume to add another aspirate step. 

Note: Only checked aspirate sequences are active in the experimental protocol. 
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Option Description 

Edit Aspirate Configure an aspirate step in the table by selecting it and pressing the Edit Aspirate 

button, or double-click on the row. This opens the Edit Aspirate dialog. 

 
Use this dialog to define aspiration parameters reported in the table. 

Source Plate—Select the plate from which you want an aliquot of fluid removed. 

Typically, this is a plate containing an agonist, antagonist or if the Cell Suspension 

option is installed, cells in suspension. 

Quadrant—Select quadrant from which volume is aspirated. 

Note: Quadrant selection is only available when liquid is aspirated from a plate using 

a pipettor head of lower density, for example, 384-well plate using a 96 pipettor 

head. 

Volume—Enter volume (in µL) to aspirate. 

Speed—Enter speed at which to aspirate (in µL/s). 

Fill Reservoir Speed—Select the speed with which fill the Cell Reservoir from the 

spinner flask. 

Edit Aspirate 

(continued) 

1 

Drain Reservoir Speed —Select the speed with which to drain the cells from Cell 

Reservoir to drain destination. 
1 

Drain Destination —Select a destination where cells should be drained from Cell 

Reservoir after pipettor aspiration. 

Height—Enter distance (measured in µL) from the bottom of the well the tips should 

start aspirating. 

Note: Tips move downward full volume of aspiration, for example, aspirate 10 µL 

with a start height of 35 µL will put the pipettor height at 25 µL after aspiration. 

Pipettor head movement helps prevent well overflow when tips are submerged in 

the well. If downward pipettor motion is not desired, set tip height to minimum 

value. Tip movement downward halts when the tips reach 1/30th well volume. 

Hold Volume—Enter size of air gap (in µL) following aspiration. Air gaps prevent 

liquid from leaking out of the tip before dispensing. 

Removal Speed—Enter rate (in mm/s) at which tips are pulled from well 

immediately after aspiration. This value is adjusted depending on fluid viscosity or 

volume of fluid in the well. 

Note: For low volume transfers, a slow up-speed may improve precision. 

Put Tips in 

Well Before 

Read 

Check this option to place tips in the read plate prior to beginning read intervals. 

 
This option is suggested for assays in which placing tips below the fluid surface can 

prevent excessive turbulence. 

 
Enabling this option helps ensure accurate timing of fluid dispense relative to reads. 

1. These options are only available when Cell Reservoir is installed and selected in Source 

Plate 3 settings. 
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Dispense Configuration (Standard Pipettor) 

The following table describes Dispense configuration on the Transfer Fluid process page 

when a standard pipettor is selected. 

Options Description 

Dispense Check the check box at the start of a row to activate a dispense 

sequence. 

 
If Multiple Dispense has been selected as Fluid Transfer Type, 

enter a dispense volume less than the aspirate volume to add 

another dispense step. 

Note: Only checked dispense sequences are active in the 

experimental protocol. 

Edit Dispense Configure a dispense step in the table by selecting it and pressing 

the Edit Dispense button, or double-click on the row. This opens 

the Edit Dispense dialog. 

 
Use this dialog to define dispense parameters reported in the 

table. 

Target Plate—From the list, select the plate to receive the fluid 

dispense. Typically, this is the Read Plate. 

Quadrant—Select quadrant from which volume is dispensed. 

Note: Quadrant selection is only available when liquid is 

aspirated from a plate using a pipettor head of lower density for 

example, 384-well plate using a 96-pipettor head. 

Volume—Enter volume (in µL) to dispense. 

Note: In the last dispense, the entire contents in the tip is 

dispensed. 

Height—Enter the distance (measured in µL) from the bottom of 

the well the tips should be inserted prior to dispensing. 

Note: Tips move upward the full volume of dispense during 

dispense, for example, a 10 µL dispense with a start height of 35 

µL will put the pipettor height at 45 µL after dispensing. This 

movement helps prevent well overflow when tips are 

submerged in the well. Tips will not move higher than the full 

volume of the well. 

Height value will need to be adjusted when transferring from 

previous FLIPR Tetra systems. 
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Options Description 

Edit Dispense (continued) Speed—Enter speed at which to dispense (in µL/s). Ideal 

dispense speed takes into account the volume added, how fast 

the signal increases in response to compounds and strength of 

the attached cells at the bottom of the plate. 

 
Expel Volume—Enter an additional volume (in µL) the pipettor 

dispenses over the dispense volume. Typically, this value is equal 

to the aspirate Hold Volume value. 

 
In a multiple dispense, only the last dispense can have an Expel 

Volume. 

If Mix Fluid After Dispense is selected, Expel Volume 

automatically changes to zero for the dispense associated with 

the fluid transfer, to ensure that tips remain in the well prior to 

the mix step. However, the expel volume designated in the 

dispense is transferred to the Mix with TF step, to help ensure 

liquid is properly expelled from the tips after mixing. 

Removal Speed—Enter rate (in mm/s) at which tips are pulled 

from well immediately after the dispense. This value is adjusted 

for fluid viscosity, fluid volume in the well or if the transfer is 

performed to a dry well. 

Pause in Well—Enter time (in seconds) to pause with the tips in 

the wells after dispensing and mixing (if specified) before the 

next pipettor move. 

 
Read intervals may occur simultaneously with this step. Typically, 

the pipettor is paused during a read to prevent disturbances in 

the imaging process. 

Mix Fluid After Dispense Check this box to link a Mix Fluid process to the Transfer Fluid 

process. 

 
This automatically adds a Mix with TF step to the protocol, and 

opens the configuration page for that step. 

 
See Mix Fluid Process on page 95 for more information about 

mixing options. 

Note: This option is only available when Fluid Transfer Type has 

a single dispense. 
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Options Description 

Unload Tips after Fluid Transfer Instructs the instrument to unload tips after the Fluid Transfer 

process. Typically, this is used when changing the tips during an 

experiment or when reducing down-time between 

experiments. 

Note: This option is only available when Load Tips Position is 

selected on the Settings process page. Using this feature also 

requires that no source plate is placed in plate position 3 during 

the experiment. 
 

Aspirate Configuration (Pin Tool) 

The following table describes aspiration configuration options when a pin tool is selected. 
 

Options Description 

Source Plate Select the plate from which you want an aliquot of fluid removed. Typically, 

this is a plate containing an agonist or antagonist. 

Height Enter distance (measured in µL) from the bottom of the well to place the 

pins. The distance equivalent in millimeters is displayed as well. 

 
Float pins—Moves the pipettor down to a position at which the pins should 

be 1 mm below the bottom of the wells. As pins come to rest on the well 

bottoms additional downward motion of the tip block is absorbed by the tips 

moving into the block. This ensures that all pins are submerged in the same 

volume of fluid across the plate. The Height is designated as -1.00 mm. 

Quadrant Select the quadrant from which volume is aspirated. 

Note: Quadrant selection is only available when liquid is aspirated from a 

plate using a pipettor head of lower density, for example, 1536-well plate 

using a 384 pin tool head. 

Down Speed Enter the speed (in mm/s) at which the pin tool is inserted into the source 

plate. 

Removal Speed Enter the speed (in mm/s) at which the pin tool is removed from the source 

plate. The speed of removal determines the volume of fluid remaining on the 

pins. 

Note: Increasing the removal speed increases the volume of compound on 

the pin after aspiration. To decrease the fluid volume, slow down the removal 

speed. It is recommended that assay development be done to determine the 

volume transferred based on removal speed. 

Pause in Well Enter a duration (in seconds) to hold the pin tool in the source plate after full 

insertion and before removal. 
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Dispense Configuration (Pin Tool) 

The following table describes dispense configuration options when a Pin Tool head is 

selected. 
 

Options Description 

Target Plate Select the plate to receive the fluid dispense; typically, the Read Plate. 

Height Enter the distance (measured in µL) from the bottom of the well the tips should 

be inserted. The distance equivalent in millimeters is displayed to the right of 

the µL value. 

Quadrant Select the quadrant of the target plate into which compound is to be dispensed. 

Note: Quadrant selection is only available when liquid is aspirated from a plate 

using a pipettor head of lower density, for example, 1536-well plate using a 384 

pin tool head. 

Down Speed Enter the speed (in mm/s) at which the pin tool is inserted into the target plate. 

Removal Speed Enter the speed (in mm/s) at which the pin tool is removed from the target 

plate. The speed of removal determines the volume of fluid remaining on the 

pins. 

Pause in Well Enter a duration (in seconds) to hold the pin tool in the dispense plate after full 

insertion and before removal. 

Read Check this box to link a Read process to the Transfer Fluid process. 

This automatically adds a Read with TF step to the protocol, and opens the 

configuration page for that step. 

 
See Read Process on page 97 for more information about read process options. 

Note: This option is required if you intend to read a plate while transferring 

liquid during a kinetic cell-based assay (for example, calcium mobilization). 

Mix Fluid Check this box to link a Mix Fluid process to the Transfer Fluid process. 

 
This automatically adds a Mix with TF step to the protocol, and opens the 

configuration page for that step. 

 
See Mix Fluid Process on page 95 for more information about mixing options. 

Unload Pin Tool Automatically unload the pin tool after the dispense. 
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Mix Fluid Process 

Fluid mixing steps can be added to protocols as independent protocol steps, Mix Fluid or 

linked to a Transfer Fluid step, Mix with TF. Independent Mix Fluid steps can be configured 

to mix fluid in source or read plates, while Mix with TF steps immediately follow the Transfer 

Fluid step they are linked to, mixing fluid in the read plate where compound was dispensed. 

Different mix options are offered for standard pipettors and the pin tool, described in the 

following sections. 

Mix Fluid (Standard Pipettor) 

Fluid mixing with a standard pipettor consists of a series of aspirations and dispenses in and 

out of the tips. 

The following table describes the options available on the Mix Fluid process page: 
 

Options Description 

Mix Plate Select the plate that has the fluid to be mixed. Typically, it is a source plate 

from which you will be transferring fluid. 

Quadrant If appropriate, select a quadrant from which fluid is mixed. 

Note: Quadrant selection is only available when liquid is dispensed to a 

plate using a pipettor head of lower density, for example, 384-well plate 

using a 96 pipettor head. 

Volume Enter volume (in µL) to mix. 

Speed Enter speed (in µL/s) to mix the fluid. 

Height Enter distance (in µL) from the bottom of the well that the tips will be 

inserted prior to mixing. 

Note: Tips move up and down with aspirate and dispense commands. 

These movements help to prevent well overflow when the tips are 

submerged. 

Expel Volume Enter an additional volume (in µL) the pipettor dispenses, beyond the 

volume entered in the Volume field above. This helps to ensure that all 

fluid is expelled from the tips after mixing. 

Strokes Enter number of times to aspirate and dispense mix volume. One stroke is 

equal to one aspiration and one dispense. 

Removal Speed Enter rate (in mm/s) at which tips are pulled from well immediately after 

the mix. This value is adjusted for fluid viscosity or fluid volume in the 

well. 

Pause In Well Enter time (in seconds) to pause with the tips in the well after mixing and 

before the next pipettor head move. 

Unload Tips After Mix Automatically unloads tips after the mix step. 
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Mix Fluid (Pin Tool) 

Fluid mixing with a pin tool consists of a sequence of up and down motions of the pin block. 
 

Options Description 

Mix Plate Select the plate that has the fluid to be mixed. Typically, it is a source plate 

from which you will be transferring fluid. 

Top Height Enter the height (in µL) for the top of the stroke during mixing. 

Quadrant If appropriate, select a quadrant in which fluid will be mixed. 

Note: Quadrant selection is only available when liquid is dispensed to a 

plate using a pipettor head of lower density, for example, 1536-well plate 

using a 384 pipettor head. 

Bottom Height Enter the height (in µL) for the bottom of the stroke during mixing. 

Strokes Enter the number of times the pins move within the mix step. One stroke 

is equal to one up-stroke and one down-stroke. 

Down Speed Enter the speed (in mm/s) of the down-stroke. 

Removal Speed Enter rate (in mm/s) at which pins are pulled from the well immediately 

after the mix. This value is adjusted for fluid viscosity or fluid volume in 

the well. The speed of removal determines the volume of fluid remaining 

on the pins. 

Up Speed Enter the speed (in mm/s) of the up-stroke. This is not the rate which pins 

will be removed from the well. 

Pause in Well Enter a duration to hold the pin tool in the well plate once mixing is 

completed, before withdrawal. 

Unload Pin Tool Check to have the pin tool unloaded after mixing. 
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Mix With TF 

Fluid can be mixed immediately after dispense to ensure proper mixing of agonists and 

antagonists with the cell monolayer. Typically, this is necessary when transferring fluids one- 

tenth or less of the total fluid volume of a well. 

To add a mix after dispense, check the Mix  After Fluid Dispense (Mix  Fluid for the Pin 

Tool) option in the Transfer Fluid process dialog box. This inserts a mix step and the Mix 

Fluid process icon turns purple, indicating that mixing occurs immediately after dispense and 

concurrently with a Read process, if selected. 
 

Note: Any Expel Volume configured in the dispense step prior to a mix is locked if Mix 

Fluid After Dispense is selected. Tips are raised during Expel Volume, but this could 

lead to inadequate mixing, so mixing occurs with the tips at the level they finish the 

basic dispense at, and Expel Volume occurs after mixing is completed. 

 
Mixing parameters for a Mix with TF are similar to a Mix Fluid process, however Mix 

Plate, Quadrant, Hold Volume and Tip Up Speed, are not configurable. These 

options can only be accessed in the Transfer Fluid process to which the mix is linked. 

 
To remove a Mix with TF process, deselect it in the Transfer Fluid process dialog. 

 

Read Process 

Read steps can be added to protocols as independent protocol steps, Read or linked to a 

Transfer Fluid step, Read with TF. Configuration options for the two types of step is similar, 

except Read with TF allows you to time the read precisely with the time that compound is 

dispensed, and it also gives you the option to save the images used to measure the 

response. 

Read 

To add a Read process to a protocol that is independent of a liquid transfer, drag the Read 

process icon from the Process Explorer to the Experiment window. The Read process page 

opens when the icon is released. When added to the protocol, the icon is orange, indicating 

it is an optics function and occurs in parallel with fluid processes during the experiment. 

A Read consists of a sequence of images taken at a predefined rate, from which relative light 

values for each well are measured. A single Read process can be divided into two intervals 

with different read rates. Typically this is used to take images at a high rate while compound 

is being added, and shortly thereafter, to best capture kinetic effects, then images can be 

taken at a less frequent rate as cells settle and less change occurs. 
 

Note: The read rate you configure for the Read process is the same for all the read 

modes you have enabled. For example, if you set the Read Interval to 1 s, and have 

two read modes, two images are taken every second—one for each read mode. 

The following table describes the options available in the Read process page: 
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Options Description 

First Interval Configure the first series of reads taken during the Read process. 

Read Interval—Enter time (in seconds) between reads. The same interval 

is used for each read mode (for example, the instrument takes images 

twice as fast if a second read mode is enabled). 

Note: Time should be no less than exposure time plus read-out time (see 

Setup Read Mode on page 59 for more information). If it is less, then the 

experiment speed is determined by the capability of the computer. 

Number of Reads—Enter the total number of reads to be taken in the 

first interval. 

Second Interval Configure the second series of reads taken during the Read process. If 

you do not want a second series with a different read interval, make 

Number of Reads zero. 

Read Interval—Enter time (in seconds) between reads. The same interval 

is used for each read mode (for example, the instrument takes images 

twice as fast if a second read mode is enabled). 

Note: Time should be no less than exposure time plus read-out time (see 

Setup Read Mode on page 59 for more information). If it is less, then the 

experiment speed will be determined by the capability of the computer. 

Number of Reads—Enter the total number of reads to be taken in the 

second interval. 
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Read With TF 

Plate reading concurrent with fluid transfer is necessary to collect data for kinetic cell-based 

assays as the response time is very rapid. To link a Read process to a Transfer Fluid process, 

select Read in the Transfer Fluid page. Inserting a read this way turns the Read process icon 

purple, indicating that the read occurs concurrently with liquid addition. 

Read with TF configuration is similar to that of an independent Read process, but with the 

addition of two more options; Number of Reads Before Dispense and Save Images. 
 

Note: To remove a Read With TF process, uncheck the Read option in the Transfer 

Fluid process dialog box. 

The following table describes the additional options in the Read with TF dialog: 
 

Options Description 

Number of Reads Before Dispense Enter the number of reads to be taken before fluid is added to 

the plate. This provides a cellular response baseline prior to 

addition of agonist or antagonist. Number of Reads Before 

Dispense is included in the total number of first interval reads 

entered in the Number of Reads field, for example, if the 

Number of Reads is 60 and the number of Reads Before 

Dispense is five, there will be 55 reads after dispense is 

initiated. 

Save Images When checked, up to 100 images are saved in an image file 

(*.png) associated with an experiment. These images can be 

used for more than one dispense as long as the total images 

saved do not exceed 100 for the experiment. 

 
Number of Images Before Dispense—Enter the total number 

of images to be saved prior to initiating the dispense. 

Number of Images After Dispense—Enter the total number of 

images to be saved after initiating the dispense. 

 
By default one image prior to and nineteen after dispense are 

saved for review in Image Display on page 87. 

Note: Images may be useful to troubleshoot problems with 

your cell plate such as cells detaching during fluid dispense. 
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Wash Tips or Pins Process 

This process is normally used to eliminate unwanted agonist or antagonists prior to another 

addition within an experiment or between experiments. In many cases, it reduces 

consumable costs and downtime associated with replacing tips. 

For standard pipettors, tips are inserted into the wash location and wash fluid aspirated and 

dispensed. This can be done a number of times (strokes) in the same wash fluid, then the 

whole process repeated up to five times (wash cycle) with fresh wash fluid. 

For the pin tool, up and down motion is used to force fluid in and out of the capillary slot of 

the pins. A typical wash protocol uses an initial solvent to remove compound from the pins, 

followed by a second solvent to remove the first solvent. It is recommended that pins are 

blotted at a blotting station to remove excess liquid from the pins between washes. 

Wash Tips (Standard Pipettor) 

The following table describes the options available in the Wash Tips process page, for a 

standard pipettor: 
 

Options Description 

Fluid Type Select the fluid in the wash reservoir during tip washing, from 

wash fluid container A or B. 

Pump Speed Select the speed (slow or fast) you want the pump to fill and 

empty the wash reservoir. 

Note: Molecular Devices recommends you use Fast except 

with volatile solvents. 

Wash Cycles From the list, select the number of times that fluid cycles 

through the wash reservoir. For each cycle, the pipettor 

executes the number in the Strokes field. 

Strokes From the list, select the number of times to aspirate and 

dispense wash fluid. 

Volume/Stroke Enter the volume (in µL) of fluid to be aspirated and then 

expelled for each stroke. 

Hold Time Enter the length of time (in seconds) to pause between 

aspirating and expelling fluid. 

Aspirate Speed From the list, select the speed (in µL/s) to aspirate fluid. 

Dispense Speed From the list, select the speed (in µL/s) to dispense fluid. 

Unload Tips After Washing Check this option to have tips removed from the pipettor head 

after washing is complete. 
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Wash Pins (Pin Tool) 

The following table describes the options available in the Wash Pins process page, for a Pin 

Tool: 
 

Options Description 

Fluid Type Select the fluid in the wash reservoir during tip washing, from wash fluid container 

A or B. 

Pump Speed Select the speed (slow or fast) you want the pump to fill and empty the wash 

reservoir. 
 

Note: Molecular Devices recommends you use Fast 

except with volatile solvents. 

Wash Cycles From the list, select the number of times that fluid cycles through the wash 

reservoir (up to 5). For each cycle, the pipettor executes the number in the Strokes 

field. 

Strokes From the list, select the number of times to raise and lower the pins. One stroke is 

equal to one upstroke and one down-stroke. 

Down Speed Set the speed of the pin tool during the downstroke. 

Stroke 

Distance 

Set the height of one stroke that the pin tool travels. 

Up Speed Set the speed of the pin tool during the up-stroke. 

Removal 

Speed 

Set the speed that the pin tool is withdrawn from the wash location. The faster the 

withdrawal speed the more fluid remains on the pins. 

Pause in Well Set a time to hold the pin tool at the bottom of the wells in the wash solution after 

the wash is completed. 

Unload Pin 

Tool After 

Wash 

Check to have the pin tool removed after washing is complete. 
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Blot Pins Process 

The Blot Pins process is only available for the pin tool. This function is used to dry the pins 

between transfers or washes, to prevent carry-over. 
 

Options Description 

Target Plate Select the plate. 

Height Enter distance (measured in μL) from the bottom of the well to 

place the pins. The distance equivalent in millimeters is displayed 

as well. 

 
Float pins—Moves the pipettor down to a position at which the 

pins would be 1 mm below the bottom of the wells. As pins come 

to rest on the blotting surface additional downward motion of the 

tip block is absorbed by the tips moving into the block. This 

ensures that all pins are in contact with the blotting surface. The 

Height is designated as -1.00 mm. 

Pause in Well Enter a duration during which the pin tool is held motionless at 

the set height. 

Unload Pin Tool After Blot Automatically unload the pin tool once blotting is complete. 

 

Pause Pipettor Process 

Pause Pipettor steps are included in a protocol to prevent future pipettor motion until the 

pause is complete. Read processes can continue to execute, unless stopped by the linked 

action “read with transfer”. This can be useful to stop the pipettor from picking up 

compound if it will then sit for an extended period in the air. Also, it can be used to provide 

time for solvents (such as EtOH) to evaporate off the pins after a wash. 

This process has only one configurable setting, the duration of the pause, entered in 

seconds. 
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Wash Cell Reservoir Process 

This process is only available when the Cell Reservoir is installed and is recommended for use 

before and after using cells in suspension. 

This process can be used as a way of priming the reservoir with cells prior to an assay or for 

cleaning purposes. 

No pipetting is associated with this step. 

The following table describes the options available in the Wash Cell Reservoir process page. 
 

Options Description 

Pre-coat Tubes Select to pump the fluid up to the sensor before filling the reservoir. 

Fluid Source Select which fluid to use for the wash process. All Fluid 1–4 bottles 

are available as well as the Cell Flask. 
1 

Drain Reservoir Destination Select a drain destination for the fluid left in the reservoir after the 

wash. Waste bottles, Cell Flask, or any of the Fluid bottles are 

available. 
1 

Fill Reservoir Speed Select a pump rate for filling the Cell Reservoir; the range is 1–10. 
1 

Drain Reservoir Speed Select a pump rate for draining the Cell Reservoir; the range is 1–10. 

Wash Cycles Set how many wash cycles with the above settings should be done. 

Hold Time This option will soak the reservoir in the pumped fluid by leaving the 

fluid in the reservoir for a specified time; the range is 0–300 seconds 

(0–5 minutes). 

1. This option is only available when the Cell Reservoir is installed and selected as the 

source plate for aspiration. 

 

Finish With Source 

In Remote Mode, the Finish with Source process instructs the instrument to notify the 

robot controller to remove the desired source plate. This option is required when using 

multiple plates in a single source location. 
 

Note: This process is not active in Manual Mode or for the read plate position. 
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Chapter 6: Exchanging Hardware 
 
 

The following procedures instruct you on how to exchange pipettor and pin tool heads and 

their respective wash reservoirs on the FLIPR Tetra system. 
 

Exchanging Pipettor and Pin Tool Heads 

All pipettor and pin tool heads must be installed and calibrated on their intended instrument 

for the first time by a certified Molecular Devices Field Service Engineer. When calibrated, 

each head can be easily exchanged but only on the instrument for which they were 

calibrated. 
 

Note: If you have any questions or concerns regarding the procedures, contact 

Molecular Devices Technical Support. See Obtain Support. 
 

Uninstalling a Pipettor or Pin Tool Head 

The following procedure uninstalls a 384 pipettor head as an example. 

To uninstall a 384 pipettor head: 

1. In the ScreenWorks Software, unload all tips on the pipettor head by selecting 

Instrument > Manual Operation > Unload Tips. 

2. Select Instrument > Manual Operation > Change Head. This command instructs the 

pipettor head to move over the Read Plate position. 
 

CAUTION! DO NOT select DONE in the dialog that opens until you have 

completed work on the pipettor. 

3. Open the upper front door to access the pipettor head. 

6 
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4. Turn the D-Axis Knurled Nut counter-clockwise until it loosens and can be lifted. 

For 1536 pipettor heads only: After loosening the D-Axis Knurled Nut, install the 

Pipettor Head Guard, which seats over the 1536-pipettor head plungers, by tightening 
the two thumb screws. This guard protects the plungers from being damaged while the 

pipettor head is being handled outside the instrument. 
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5. Turn the Head Clamp Knob counter-clockwise until the head is loose and can be lifted off 

its mounting position. 



108 0112-0109 K 

FLIPR Tetra High Throughput Cellular Screening System User Guide 
 

 

 
 

6. To remove pipettor head, grasp the pipettor head silver Guide Shaft, lift upward (to 

unseat from Alignment Pins and to lower plunger pins allowing a lift gap) and then slide 

to the left off the pipettor mount. 
 

Note: If the pipettor head does not easily slide off, try grabbing the D-axis knurled 

nut receiver and pressing it downward to give the pipettor head additional 

clearance from the D-axis knurled nut prior to trying again. 

 

 

 
7. Store the pipettor head in a safe location. A recommended safe location should include 

placing the pipettor head in its plastic storage bag to guard for particulates. 
 

CAUTION! Do not place pipettor heads on nose cone surfaces because this can 

damage the nose cones. Store pipettor heads inverted, resting on the pipettor 

head top that seats on the pipettor mount position. 
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Installing the Pipettor Head 

The following procedure installs a 1536-pipettor head as an example. 

1. Hold the pipettor head by its silver Guide Shafts and slide it to the right over the 

Pipettor Mount. When the pipettor head is in position, it should be seated on the 

Alignment Pins and should not slide off the pipettor mount without lifting upwards. 

 
2. Tighten the Head Clamp knob by turning it clockwise. 

 

Note: For 1536 pipettor heads only: Remove the guard covering the 1536 pipettor 

head plungers by loosening the two thumb screws. This allows the D-axis to move 

freely so it can be attached to the D-axis knurled nut in the next step. 

 

CAUTION! If the guard is not removed prior to resetting the instrument, the 1536 

pipettor head may be damaged. 
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3. Tighten the D-Axis Knurled Nut by turning it clockwise until tight. If the nut does not 

reach its receiver threads, lift the D-axis receiver to engage the threads and tighten the 

nut. 

 
4. After the pipettor head is fastened, see the following procedure to exchange the tip wash 

reservoir to match the pipettor head format. 
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Uninstalling Wash Reservoir Top 

The following procedure uninstalls a 1536 wash reservoir top as an example. 

1. Loosen both Captive Thumb Screws on reservoir top. 
 

2. Lift reservoir top off of the washer base. 

3. Ensure the Blue O-Ring on the washer base remains properly seated. If not reinstall the 

o-ring into its o-ring groove. 

4. Store the reservoir top in a safe location. 
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Installing Wash Reservoir Top 

The following procedure installs a 384 wash reservoir top as an example. 

1. Align the appropriate format reservoir top so the Connector matches the washer base 

connector. When aligned correctly, the reservoir top name (96, 384 or 1536) is located 

towards the front of the instrument. 

2. Once aligned, press the top into position, using the Alignment Pins to guide the 

placement of the top. 

3. Tighten both Captive Thumb Screws to ensure the reservoir top is fastened to the base. 

4. Go to the following procedure to reset the instrument. 

Resetting the System After Changing Pipettor Heads 

To reset the FLIPR Tetra system: 

1. Make sure the pipettor head and tip wash reservoir top formats match before 

proceeding. If they do not match, the instrument faults and will not let you run any 

experiments. 

2. When the change is complete, click DONE in the dialog box that displayst in the 

ScreenWorks Software. The instrument resets itself. 

3. When the reset cycle is complete, the green Assay Finished (Unlock) light is the only 

indicator light illuminated on the front of the instrument. 
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Exchanging the 1536 Tip Gasket 

Gaskets should be replaced approximately every 200 plates (~3200 strokes). Gasket lifetime 

varies depending on the number of aspiration/dispense steps performed in your experiment 

and should be monitored. 

Installing the Gasket 

To install the 1536 tip gasket: 

1. Remove the gasket from its package and discard the gasket backing. 
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2. Place the lubricated side of the gasket down on the tip block, using the gasket recess to 

guide the frame position. 

When aligned, the tip block and gasket are sandwiched together until the tip block 

grippers clamp into place. 
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Removing the Tip Block and Gasket 

During the unloading, the tip block grippers unclamp and release the gasket and tip block 

into the rack assembly. When unloaded, dispose the gasket and use a new one the next time 

the block is loaded. Ordering information for disposable gaskets can be found in 

Consumables and Accessories on page 245. 
 
 

 

To use Position 1 for a source well plate: 

Load tips manually and then remove the tip rack before starting an experiment. 

When loaded, a source plate can be placed in Source 1 in both manual and robotic 

modes. 
 

Note: Sensors indicate only the presence of an object in plate position and do not 

indicate whether it is a source plate or tip rack. 
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Exchanging Pin Tools 

Pin tools are blocks loaded with pins, which are loaded onto a pin tool head to transfer fluid. 

Two pin tool heads, 1536-well and 384-well formats, are available for the FLIPR Tetra system. 

Each pin tool head is compatible only with the pin tools of its respective format. Pin tool 

heads will not pick up pin tools whose magnetic ID does not match the respective head 

format. Therefore the 384-well pin tool head will not be able to pick up 1536-well pin tools or 

vice versa. This is designed for the safety of the pin tool. 

Pin tools for a single head type are user-exchangeable. Up to eight or fourteen pin tools are 

available for the 384-well or 1536-well pin tool heads respectively. 

To load or unload a pin tool: 

In the ScreenWorks Software, select Instrument > Manual Operation > Load Tip and 

Unload Tip. 

The pin tool is picked up and clamped to the head using pin tool block grippers similar to 

the 1536 pipettor head. 

To use Position 1 for a source well plate: 

Load tips manually and then remove the tip rack before starting an experiment. 

When loaded, a source plate can be placed in Source 1 in both manual and robotic 

modes. 
 

Note: Sensors indicate only the presence of an object in plate position and do not 

indicate whether it is a source plate or tip rack. 

 

Exchanging LED Modules 
 

optical components. Use appropriate care not to damage them. Specifically, do 
not touch the surfaces of the LED filters with your bare fingers or other objects. 

 

Uninstalling LED Modules 

To uninstall LED modules: 

1. Open the lower front door of the FLIPR Tetra system. 

When the lower door is open, power to the LEDs is disabled. 

WARNING! During the exchange procedure, you will have access to precision 
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2. Loosen the two silver Latching Clamps securing the excitation optics module to the left 

light pipe. 

 

3. Pull the excitation optics module down and away from light pipe to disengage the Power 

Connectors on the LED modules from the light pipe. Be careful not to scratch the 

bandpass filters when pulling LED modules out of the instrument. 

Remove the Foam Insert found on the rear side of the excitation optics module. 
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4. Loosen the two Captive Thumb Screws holding the LED modules together, and then pull 

the modules apart so they can be exchanged for new wavelengths. 

 

5. Repeat for the LED module mounted to the right light pipe. 

6. When separated, LED modules can be exchanged using the following installation 

procedure. 

Installing LED Modules 

1. To create an Excitation Optics Module, you combine two LED banks of different 

wavelengths. Align the Mating Pins to their respective Mating Hole in the LED module 

that you are securing to each other. 

 

2. When aligned, push the two LED banks of different wavelengths together and tighten 

the two Captive Thumb Screws with firm finger pressure. 
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3. Place the Foam Insert on the rear end of the excitation optics module. 
 

 
 

 

 

4. Open the lower front instrument door and slide the left Excitation Optics Module into 

place. Each module is coarsely self-aligning, but observe engagement of the two Power 

Connectors and confirm they are aligned before applying mating pressure. 

5. After the connectors are mated, engage and tighten the two Latching Clamps that 

secure each module to the Light Pipe. 

Note: Make sure that the foam piece fits inside the LED Frame. 
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6. Repeat the above procedure for the right Excitation Optics Module, being sure the 

same wavelength modules occupy the corresponding position (upper/lower) on each 

side. 

 

7. If also changing filters, continue to Changing Filters on page 120. If you are finished, close 

the lower front door. 

8. When the lower front door closes, and the message displays The lower door has been 

opened, do you want to update optics? Click Yes. 

Filters and LEDs are identified. 

LEDs are tested. 

ScreenWorks Software Instrument Status Configuration is updated. 

The process finishes when the progress dialog closes. 

Changing Filters 

Filters are mechanically sensed and the filter configuration can be viewed in the instrument 

configuration window of the FLIPR Tetra system ScreenWorks Software. 

To uninstall and then install the needed filter, use the following procedures. 

If the needed filter is not available, three custom filter holders are available for purchase to 

place filters by an outside vendor. See Consumables and Accessories on page 245 for 

purchasing information. When installed, these filters appear as 1_1, 2_2, and 3_3 in the 

software protocol. 
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Uninstalling a Filter 

To uninstall a filter: 

1. Open the lower front door of the FLIPR Tetra system. 
 

 
 

 

2. Remove the Filter Cover, located below the left LED module. 
 

 

3. Using the filter tab that protrudes slightly from the filter tray, push the filter up out of its 

position and remove it from the instrument. Only to grasp the filter by the tab. 
 

 

 

4. Repeat Step 3 for the remaining emission filters you want to remove. 

Note: When the lower front door is open, system power is disengaged. 

CAUTION! DO NOT touch the filter surface. 
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5. After needed emission filters are removed, replace the Filter Cover. 

6. To install new emission filters into the system, continue to Installing an Emission Filter on 

page 122. 

Installing an Emission Filter 

The emission filter wavelengths are automatically identified by the system and can be 

selected from the ScreenWorks Software menu. 

To install an emission filter: 

1. If needed, open the lower front door of the FLIPR Tetra system, and remove the Filter 

Cover, located below the left LED module. 

2. To install emission filters, grasp the filter you wish to install by its Tab, located where the 

filter table is, and place it into the appropriate filter position. Typically, this is the 

rightmost Position 1 in the slider. Insert the rear of the filter first, making sure it fits into 

the specific filter position. Push the tab down, so that the Filter Indexer clicks into the 

position. A notch on front of the tab should align with one of the lines on the Filter Tray. 
 

 

 

3. Subsequent filters can be installed by repeating step 2 in Positions 2 and 3. 
 

Note: If a needed filter is not available, three custom filter cassettes are available 

for purchase (seeOptics Consumables on page 246 to place filters created by an 

outside vendor. When installed, these filters appear as 1_1, 2_2, 3_3 in the 

software protocol. 

CAUTION! DO NOT touch the filter surface. 
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4. The emission filter wavelengths are identified by the system and passed to the 

ScreenWorks Software where they can be selected from menus. 
 

CAUTION! When using all 3 filter positions, do not duplicate wavelengths, 

because this will cause a fault in the software. 

5. After desired emission filters are installed, replace the Filter Cover. 

6. When you are finished, close the lower front door. 

7. When the lower front door closes, and the message displays The lower door has been 

opened, do you want to update optics? Click Yes. 

Filters and LEDs are identified. 

LEDs are tested. 

ScreenWorks Software Instrument Status Configuration is updated. 

The process finishes when the progress dialog closes. 

Changing Plate Hold-Down Devices 

The plate hold-down devices, part numbers 2300-1631 and 2300-1633, are designed to keep 

plates or tip racks from lifting after aspirating, dispensing and tip loading. Each device has an 

overhang feature that contacts the skirt of a plate to prevent upward movement when the 

pipettor is removed from the plate. Three different plate hold-down gaps (2 mm, 2.5 mm and 

6 mm) are provided that correspond to three identified plate skirt thicknesses. The 2.0 mm 

and 2.5 mm are incorporated on one plate hold down device that may be rotated 90×. A 

second plate hold-down has a 6.0 mm gap and can be found in the accessory kit. Numbers 

corresponding to the plate skirt thicknesses are marked on the top of the devices. The device 

is properly oriented for a particular flange thickness when the digits can be read as upright 

from the service door of the instrument. 

Selecting a Plate Hold-Down Devices 

Most plates and tip racks use the 2.5 mm device setting. Exceptions among approved plates 

are the Corning/Costar plates that have a very thick 6.0 mm plate skirt and the thin 2.0 mm 

plate skirt of thee Greiner 1536-well plates. To determine which hold-down device is most 

appropriate for your plate, use the lowest hold-down device that allows the plate skirt to 

slide under the overhanging feature freely. It is important the overhanging feature is clearly 

above the skirts on all plates and tip racks that will be used in a particular plate position or a 

misalignment with the pipette tips will occur. Test the configuration as described below after 

installation. 
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Installating a Plate Hold-Down Device 

To install or reposition the plate hold-down: 

1. Place the device in its proper orientation so that the numbers appear upright when 

viewed looking through the main user access door. 

2. Insert one of the flat head screws that was originally securing the device or one included 

in the accessory kit through the hole in the device and into the screw threads on the left 

side of the plate-retaining pockets. Tighten the screw firmly. The device is self locating, 

therefore no additional alignment is necessary. 

3. If plates or tip blocks with different flange heights are to be used in the same position, 

use the device specified for the largest flange thickness. 

4. Test the plates or tip blocks to be used by inserting them into the plate pockets at the 

location in which they will be used. 

5. Observe that when the plate is released it is pushed to the left under the retaining 

device. It should come to rest against the edge locating surfaces on the left and nearest 

the door. 

6. Pull up on the plate gently. 
 

Tip: A definite retaining force should be felt. A sideways movement during lifting 

can cause the plate to slide out from under the retaining device and be lifted 

upward without retention. This does not happen during instrument operation 

but might require attention to be avoid when lifting a plate by hand. 
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Removing a Plate Hold-Down Device 

To remove the existing plate hold-down: 

1. Clear the system of plate or tips that can interfere with the position from which you are 

removing the plate hold-down device. 

2. Use a Phillips #2 or #3 screwdriver to loosen and remove the screws from the center of 

the devices. 

3. Remove the plate hold-down device. 
 

Cell Reservoir 

Initial installation of the cell reservoir is done by a Molecular Devices certified field service 

engineer. 

Installing the Cell Reservoir 

If the cell reservoir was removed following the instructions in Uninstalling the Cell Reservoir 

on page 126, reinstall it as follows: 

1. Ensure the tubing connection to the connector is tight. 

2. Align the Reservoir Connector to the Cell Reservoir and tighten the two Captive Thumb 

Screws. 
 

 
3. Insert the Cell Reservoir into the Source Plate 3 position. 

4. Go to the Instrument menu and select Refresh Configuration. The Instrument Status 

tab displays Cell Reservoir: OK. 

This status indicates that only the Cell Reservoir can be selected for the Source Plate 3 

position. 

5. Run a Manual Wash (see Wash Cell Reservoir Process on page 103) and inspect the cell 

reservoir area to ensure that there is no fluid leakage. 
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Uninstalling the Cell Reservoir 

When the Cell Reservoir is configured and detected by the instrument, it is the only available 

choice as the Source Plate 3 selection. ScreenWorks Software displays Cell Reservoir: OK in 

the Instrument Status tab. 

To use the Source 3 position for a different source plate, the Cell Reservoir must be 

uninstalled. 

To uninstall the Cell Reservoir: 

1. Remove the Reservoir Connector by loosening both Captive Thumb Screws. 
 

 

2. Place the Reservoir Connector by the Tip Washer. 

3. Remove the Cell Reservoir. 
 

 
 

 

4. Click Instrument > Refresh Configuration. 

The Instrument Status tab displays Cell Reservoir: NOT_OK. 

5. Select another plate for the Source Plate 3 position. 

Tip: You can now autoclave the Cell Reservoir. 
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Chapter 7: Calibration and Signal Test 
 
 

The following procedures and information are required to calibrate the optics and run a 

signal test of the FLIPR Tetra system. 
 

Optical Calibration 

Calibrating the optics of FLIPR Tetra system requires taking an image of the 96-, 384-or 1536- 

well plate and using it as a mask to locate the wells. Typically, calibrations are run with the 

following procedures: 

After LED banks or pipettor head are exchanged. 

After a new plate is added to the plate library. 

If no filters are in the instrument, install them at this time (see Changing Filters on page 

120). 

Adding a Read Plate to Plate Library 

The FLIPR Tetra system has default plate masks for 96-, 384-, and 1536-well read plate types. 

If you want to use a plate type that varies significantly from the default formats, you must 

create new dimensions and mask for that plate type. Use the description of the Plate Library 

menu item, (see Plate Process Definition on page 50), as a reference guide for options and 

parameters available when adding a plate to the software. 

To add a plate and mask to the software: 
-8 

1. Prepare a 1 x 10 M fluorescein solution. 

2. Ensure the microplate bottom is clean and free of scratches and dust. 

3. Dispense enough fluorescein solution into each well so as to cover the bottom. 

Dispensing half of the total well volume is typically a safe volume with which to work. Use 

the FLIPR Tetra system pipettor. 

4. Place the microplate containing fluorescein in the read position and select Plate Library 

from the Tools menu. 

5. From the Plate Process Definition list, select a plate with a similar well format. 

6. Click Copy Plate. 

7. Enter the Plate Specifications: 

Enter a Plate Name. 

Select Read Plate as the Plate Type. 

Type in the plate dimensions. 

8. Click Finish to create a new read plate with mask. 

7 
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Plate mask definition is complete when the green Assay Finished (Unlocked) light is 

illuminated. 

Flat-Fielding 

Microplate illumination during a fluorescence assay does not result in perfectly uniform 

excitation distribution on the microplate surface. In the FLIPR Tetra system, light distribution 

is more intense in the middle of the microplate than the edges, therefore a flat-fielding 

algorithm is applied to the microplate image to compensate for variations in light intensity 

across the microplate. 

During luminescence assays LEDs are not used. Flat-field corrections are preset during 

installation and do not require any user adjustment. 

Calibrating the Optics 

FLIPR Tetra system identifies the serial number, wavelength range and position of each LED 

bank present in the instrument. This information, in addition to the wavelength range for 

the emission filters, is stored with the system’s calibration files. Any time LEDs or emission 

filters are changed in the FLIPR Tetra system, you need to recalibrate the Flat-Field 

Calibration files for the new LED/Filter pairs. The following procedure steps you through the 

process of calibrating the system optics. 
 

Tip: Due to the improved light tightness of the new FLIPR Tetra system, the 

background correction calibration available in the previous versions of this software 

(used with black bottom plates) is no longer required. 

If you have any questions or concerns regarding the calibration procedure, contact 

Molecular Devices Technical Support. See Obtain Support. 

The Excitation LED Calibration is needed only if the LED Calibration Status shows NotDone 

when you select to use the 335–345 nm/475–535 nm (340 LED Module). 

Excitation LED Calibration 

To use Excitation LED Calibration: 

1. Select Instrument > Calibration, or click on the Calibration icon. 

The Calibration dialog appears. This dialog includes a list of the Excitation/Emission 

Wavelength (LED/Filter) combinations for the installed modules, and corresponding 

status, LED Calibration, either Done or NotDone, and Flat-Field Calibration, either Done 

or NotDone. 

2. Select 335–345 nm/475–535 nm. 

The Excitation LED Calibration button activates. 

3. Click Excitation LED Calibration. 

When the progress bar dialog closes, continue with Flat-Field Calibration. 
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Flat-Field Calibration 

To use Flat-Field Calibration: 

1. Select the Calibration option from the Instrument menu, or click on the Calibration 

icon. 

2. The Calibration dialog appears. This dialog includes a list of the Excitation/Emission 

Wavelength (LED/Filter) combinations for the installed modules, and corresponding 

calibration status, either Done or NotDone, for Flat-Field Calibration, and LED 

Calibrartion of the selected Plate Format. 
 

Note: None indicates either no LEDs are illuminated or the instrument used a 

blank emission filter position to create the calibration file. 

3. Select a Plate Format (96, 384, or 1536). 

4. Select the Excitation/Emission Wavelength pair from the Calibration Status list with the 

NotDone status. 

5. Place the Flat-Field Calibration Plate into the Read Position. 

335–345 nm/475–535 nm 

380–390 nm/475–535 nm 

390–420 nm/565–625 nm 

420–455 nm/475–505 nm 

420–455 nm/515–575 nm 

470–495 nm/515–575 nm 

470–495 nm/565–625 nm 

495–505 nm/526–586 nm 

510–545 nm/565–625 nm 

610–626 nm/646–706 nm 

The following dye should be used to calibrate the respective Excitation/Emission 

Wavelength (LED/Filter) pair. 

360–380 nm/400–460 nm with MQAE (detailed instructions for handling MQAE are 

outlined in the MQAE section). 

390–420 nm/440–480 nm with Coumarin (detailed instructions for handling 

Coumarin are outlined in the Coumarin section). 

6. Click Flat-Field Calibration. 

The calibration completes when the Assay Finished (Unlock) light illuminates on the 

instrument, and the Excitation/Emission Wavelength status shows Done in the Flat- 

Field Calibration column. 
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7. When complete, click Close to exit. 

8. Place your yellow signal test plate of the appropriate well format into your system. 

9. Perform a signal test by selecting Yellow Plate Signal Test from the Instrument> 

Manual Operation menu, or using the corresponding button. The yellow plate standard 

deviation should be 5% or less. 

Coumarin 

Required material: 

Black clear-bottom plate of needed format and brand for assay (96, 384, or 1536) 

Coumarin (7-diethylaminocoumarin-3-carboxylic acid, Cat# D-1421, Molecular Probes, 

Eugene, OR) 

1. Make a 0.02 M stock solution of Coumarin in Dimethyl Sulfoxide (DMSO). Mix by 

vortexing tube. 

2. Store small aliquots at -20 °C ( -68°F). 

3. Within one hour of calibration, thaw an aliquot and make 20 mL 10 M solution in the 

same buffer to be used for dye loading. Adjust pH to 7.4. Mix by vortexing. 

4. Pipette a uniform quantity of the Coumarin solution into each well of the microplate. The 

volume must be adequate to cover the bottom of the well uniformly. The following 

quantities are recommended: 

96-well plate, 100 μL/well 

384-well plate, 40 μL/well 

1536-well plate, 6 μL/well 

5. Check the plate visually to make sure there are no bubbles or unfilled wells. Shake or tap 

the microplate to dislodge any bubbles. Keep the Coumarin plate covered and in the 

dark until used. 

6. Use the Coumarin plate as the Flat Field Calibration Plate in Flat-Field Calibration on 

page 129. 

MQAE 

Required material: 

Black clear-bottom plate of desired format and brand for assay (96, 384, or 1536). 

MQAE (N-(ethoxycarbonylmethyl)-6-methoxyquinolinium bromide) Catalog # E-3101, 

Molecular Probes, Eugene, OR) 

1. Make a 0.02 M stock solution of MQAE in distilled water. Mix by vortexing tube. 

2. Store small aliquots at -20 °C ( -68°F). 
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3. Within one hour of calibration, thaw an aliquot and make 20 mL 10 M solution in water 

or in a chloride-free buffer to be used for dye loading. Adjust pH to 7.4. Mix by vortexing. 

4. Pipette a uniform quantity of the MQAE solution into each well of the microplate. The 

volume must be adequate to cover the bottom of the well uniformly. The following 

quantities are recommended: 

5. Check the plate visually to make sure there are no bubbles or unfilled wells. Shake or tap 

the microplate to dislodge any bubbles. Keep the MQAE plate covered and in the dark 

until used. 

96-well plate, 100 μL/well 

384-well plate, 40 μL/well 

1536-well plate, 6 μL/well 

6. Use the MQAE plate as the Flat Field calibration plate in Flat-Field Calibration on page 

129. 
 

Running a Signal Test 

When to run a Signal Test: 

Once a day to check the system. 

Before running an experiment to check the protocol settings. 

System Check 

Once a day, before running your first assay plate, run a signal test to ensure the system is 

performing according to specifications. A yellow signal test plate is available for each 

corresponding pipettor head supplied with the system. 

Although both Fluorescence and Luminescence are available in the signal test window, 

currently there is no easy way of testing signal strength in Luminescence mode. It is 

therefore recommended to run daily checks of Yellow Plate Signal Test in Fluorescence to 

check optical performance of the instrument and use the Protocol Signal Test only for 

Fluorescence experiments only. 
 

Note: To ensure proper system functioning, make sure that the system is turned on 

and the standard EMCCD camera is cooled to -60 °C ± 2 °C ( -76 °F ± 35.6 °F), or the 

Aequorin ICCD camera is cooled to -20 °C ± 5 °C ( -4 °F ± 41 °F). 

Store the signal test plate in a safe place away from bright light on an even surface. Avoid 

scratching the plate bottom as scratches can affect the standard deviation. 

Running the Yellow Plate Signal Test 

To run a Yellow Plate Signal Test: 

1. Select Yellow Plate Signal Test from the Instrument> Manual Operation menu or click 

on the appropriate button. 
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2. Depending on the camera type installed in your instrument, the settings will vary for the 

Fluorescence signal test. We recommend using the default values set in your software. 

3. Place the signal test plate on the stage in the read position. 

4. Take a picture by clicking Test Signal. Acceptable test plate results are a standard 

deviation less than 5% when the instrument is calibrated with the yellow test plate for 

the appropriate plate format. If the test results are outside of the range of acceptable 

values, look at the Image Display to see if any anomalies can be found on the plate. For 

additional information see Troubleshooting on page 169. 

5. Print the results and keep them in a maintenance folder by the instrument to track the 

standard deviation of the test plate over time. Alternatively, you can save the files on the 

hard drive. 
 
 

data file. You do not have to run a signal test more than once a day. 

The standard deviation should be less than 5% if the flat field calibration was performed 

using the Flat Field Calibration Plate of the respective plate format (96, 384 or 1536). 

Running a Plate Prior to an Experiment 

This option is only recommended for Fluorescence experiments. 

Run the Protocol Signal Test of your cell plate using the camera parameters in your protocol 

as described in Optimizing Optics Hardware on page 163. 

Depending on the range of values obtained, you may choose either to run the experiment or 

alter the Excitation Intensity, Exposure Time, Camera Gain, or Camera Gate. A suggested 

starting point for a calcium mobilization assay is 200–1,500 counts. 

Settings may be changed in the Protocol Signal Test. Depending on the installed camera and 

the read mode, different parameters are available for adjusting the signal strength. See 

Signal Test on page 46 for the exact description of each of these parameters. 

Change the settings as desired, and then click Test Signal to recheck the settings. Settings 

defined in the Protocol Signal Test can be saved to the open protocol when OK is clicked to 

close the dialog. 
 

Note: Signals displayed in the Protocol Signal Test dialog are not saved as part of the 

data file. 
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Chapter 8: Running an Experiment 
 
 

This chapter provides a starting point for setting up and running a kinetic cell-based assay on 

the FLIPR Tetra system. Running an assay requires performing the following tasks: 

Preparing the cells 

Powering-up the system 

Running a system check 

Dye-loading the cells 

Preparing source plates 

Setting up an assay protocol 

These tasks are explained in detail in the remainder of this chapter. Following the general 

procedures for running a FLIPR Tetra system experiment, protocols are outlined for four 

types of assays: 

Fluorescence-based calcium mobilization 

Fluorescence-based membrane potential 

Fluorescence ratiometric membrane potential using Voltage Sensor Probes 

Luminescence-based detection of calcium mobilization 

After the presentation of the assay protocols, guidelines for assay optimization are provided. 
 

Preparing Cells for Adherent Assays 

Location of Cells in the Plate 

The excellent signal-to-background noise ratio of the FLIPR Tetra system is made possible by 

the instrument’s bottom illumination and detection system. The read plate is illuminated by 

the LED modules at an angle approximately 45. It is recommended to have cells located at 

the bottom of the wells during an experiment. Adherent cells are typically grown overnight in 

the cell plate, whereas non-adherent cells are seeded either the night before, on a coated 

plate, or the day of an experiment and then centrifuged. 

Cell Densities 

Cell densities used in fluorescence assays vary because each cell type has different 

requirements. Cell densities range from 1,500 to 5,000 cells per well for 1536-well plates, 

5,000 to 20,000 for 384-well plates and 20,000 to 80,000 cells per well for 96-well plates. Non- 

adherent assays require higher cell densities. 

It is necessary to optimize the cell seeding density so that a uniform, 80–90% confluent 

monolayer is formed on the day of the experiment. Over- or under-confluent cell monolayer 

may result in reduced cellular response to the test compounds. 

8 
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Cells that are normally maintained in culture at subconfluent levels should be seeded at 

relatively low densities. Depending on the individual cell line, attachment matrix-coated 

plates (such as the poly D-lysine coated plate) might be required to improve adherence and 

minimize cellular “blow-off” during compound addition. Assay development needs to be 

performed to determine the optimal seeding density and plate environment for each cell 

line. 

Cell Seeding 

Cells can be seeded in plates using a multi-channel pipettor or a liquid dispensing system, 

such as the AquaMax® DW4 Dispenser from Molecular Devices. We recommend seeding a 

1536-well or 384-well cell plate using an automatic instrument rather than seeding manually. 

Thin needles used in automatic liquid-dispensing instruments prevent air bubble formation 

in well bottoms—a problem commonly encountered when cells are seeded with a manual 

pipettor. 96-well plates can be seeded by either manual or automatic methods. Refer to your 

specific instrument user guide for instructions on how to dispense cell suspension into wells. 

Cells are seeded in clear, flat-bottom, black-wall 1536-well, 384-well, or 96-well tissue culture 

treated plates. A flat plate bottom ensures that cellular fluorescence is localized to a single 

horizontal plane. Adherent cells typically are seeded one day before an experiment. 

Non-adherent cells are either plated one day before on a coated plate or the day of an 

experiment. All steps are carried out in the same black-wall 96-well, 384-well, or 1536-well 

plate. 
 

Note: Flat-bottom, clear-wall tissue culture plates may also be used with the FLIPR® 

Calcium Assay Kit and Membrane Potential Assay Kit. Depending on signal intensity, 

either black-wall or white-wall plates can be used when running aequorin assays. 
 

Preparing Cells for Suspension Assays 

Location of Cells in the Plate 

Suspension cells can be used for luminescence experiments. In this case, cells are kept in 

uniform suspension by the Cell Suspension option, which consists of a cell suspension 

module and reservoir system. Suspended cells are first pumped to the reservoir and then 

delivered to the read plate by the FLIPR Tetra system pipettor head. 

These assay methods are also described in the literature, for example, in Boie et al., Eur. J. 

Pharmacol., 340(2-3):227-241 (1997), and in United States Patent 6,872,536 and European 

Patent 1,145,002. Users interested in the patented methods may wish to consult legal 

counsel in evaluating these patents. 
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Cell Densities 

Cell densities in luminescence suspension assays vary. Depending on the bioluminescence 

signal from the cells, the density can be adjusted to reach appropriate signal window. Bright 

cells can be diluted, while dim cells might require a higher concentration. The suggested cell 

densities are 1,000–5,000 cells per well for 1536-well plates, 2,500–10,000 cells per well for 

384-well plates, and 5,000–40,000 cells per well for 96-well plates. 

Cell Seeding 

The size of the experiment will dictate the number of cells required. A typical CHO-based 100- 

plate suspension cell assay requires approximately 250–300 × 106 cells in the suspension cell 

flask. This can be accomplished by culturing cells in multiple layer flasks. Cells should be split 

2–3 days prior to the assay and not be more than 80–90% confluent prior to antibiotic 

removal. All flasks should be incubated at 37 °C ( -34.6 °F) and 5% CO2. One day prior to 

testing, spent media from each flask should be replaced with growth media that does not 

contain selection antibiotics. 
 

Powering-Up the System 

To ensure proper system function, power the instrument well before you begin an 

experiment. The camera requires about five minutes to reach its operating temperature, and 

if you are heating the plate stage (Instrument > Manual Operation > Temperature Control), 

allow 15 minutes for complete temperature equilibration (check the Instrument Status 

window for stage temperature). 

Follow the start-up procedure in Startup and Shutdown on page 31. Make sure the 

appropriate pipettor head, wash reservoir, LED banks and filters are in place prior to starting 

the instrument. If incorrect components are installed, see the appropriate section in 

Exchanging Hardware on page 105 for installation instructions. 
 

CAUTION! Do not attempt to change pipettor heads, wash reservoirs, LED banks and 

filters while the instrument is running. All features must be exchanged in the 

appropriate instrument mode. Optics calibration will need to be performed when the 

instrument is started for the first time after re-configuration of LEDs or emission filters. 

 

Checking the System 

Once a day, before running your first assay plate, run a Yellow Plate Signal Test to ensure the 

system is performing according to specifications. A yellow signal test plate is available for 

each corresponding pipettor head supplied with the system. 
 

Note: Make sure that the system is turned on and the CCD camera is cooled to -60 °C 

± 2 °C ( -76 °F ± 35.6 °F) when the EMCCD camera is present or - 20 °C ± 5 °C ( -4 °F ± 

41 °F) when the ICCD camera is installed to ensure proper system functioning. 
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CAUTION! Avoid scratching the plate bottom as scratches can affect the standard 

deviation. Store the yellow signal test plate in a safe place away from bright light on an 

even surface. A signal test plate does not need to be run more than once a day unless 

system components such as pipettor heads or LEDs are changed. 
 

Running the Yellow Plate Signal Test 

To run a Yellow Plate Signal Test: 

1. Select Yellow Plate Signal Test from the Instrument > Manual Operation menu or click 

the Yellow Plate signal test button. 

2. Set the following parameters: 

a. Select the correct plate from the Select Plate list. 

b. Select appropriate Read Mode. 

c. Select the appropriate Excitation/Emission Wavelengths. 

d. Set the Excitation Intensity to 50. 

e. Set the Exposure Time to 0.1 seconds. 

f. Set the Camera Gain to 80 (EMCCD camera). 

g. Set the Gate Factor to 3% (ICCD camera). 

3. Place the yellow signal test plate on the stage in the read position. 

4. Take a picture by clicking Yellow Plate Signal Test. Acceptable test plate results are a 

standard deviation less than 5% when the instrument is calibrated with the yellow test 

plate for the appropriate plate format. If the test results are outside of the range of 

acceptable values, look at the Image Display to see if any anomalies can be found on the 

plate. For additional information see, Troubleshooting on page 169. 

5. Print the results and keep them in a “Maintenance” folder by the instrument to track the 

standard deviation of the test plate over time. Alternatively, you can save the files on the 

hard drive in the signal test directory (C:\Documents and Settings\[your_user_ 

name]\My Documents\Molecular Devices\ScreenWorks\MySignalTests) as a *.sig file. 
 
 

data file. 

 
You do not have to run a yellow plate signal test more than once a day, unless you 

recalibrate or change the optics. 

 
This Fluorescence signal test also checks the Luminescence optics, since the optics 

path is the same in both modes. 
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Dye-Loading the Cells for Fluorescence Assays 

Many cell-based responses require fluorescent dye loaded in cells to bind or change 

conformation in the presence of a ligand. These changes are monitored through a shift in 

emission wavelengths and captured by a CCD camera. Calcium sensitive dyes such as the 

ones used in Molecular Devices FLIPR Calcium Assay kits monitor intracellular calcium flux 

assays, or environmentally sensitive for membrane potential assays. Depending on the 

application evaluated, dye-loading typically lasts 30 min–1 hour (at either room temperature 

or 37 °C ( 98.6 °F). 

Loading Duration and Temperature 

Optimal loading time depends on the cell type and presence of an anion exchange inhibitor. 

It is recommended not to exceed the optimal loading time. If anion exchange inhibition does 

not enhance dye-loading conditions, it should not be used. A 60 minute loading time at 37 °C 

( 98.6 °F) is usually effective for most cell lines and is the recommended starting point for 

calcium mobilization assay development. 
 

Note: If loading for 30 min yields an acceptable fluorescence signal, as has been 

observed for some cell lines, use the shorter loading time. In some cases, incubation 

at room temperature may work as well or better than 37° C ( 98.6 °F). 
 

Preparing a Source and Compound Plate 

Preparation Time for the Source Plate 

Depending on assay complexity, source plate preparation time may vary. To avoid conflicts, 

plan your experiment carefully to ensure source plates are ready before dye loading is 

complete. 

Recommended Source Plates 

Compound conservation can be achieved by reducing dead volumes and minimizing source 

plate adherence. Reducing source plate adherence help to ensure proper compound 

concentrations are delivered to a read plate. Polypropylene plates are most commonly used 

for this purpose because they are solvent-resistant, can withstand repeated freeze-thaws, 

and have a low retention. In addition, proteins are less likely to adhere to polypropylene 

plates rather then polystyrene surface. 

Manufacturers offer a wide selection of plate bottom shapes (U-, V- or flat bottom) to lessen 

dead volumes. Dead volumes decrease as you move from a flat to U- to V-bottom plates. 

Contact the plate manufacturer for the dead volume in the plates you are using. 
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Concentration of Compounds in the Source Plate 

Compound concentrations are prepared based on ratio of addition to initial well volume of 

the read plate. Common final concentrations are 3X, 4X or 5X because ratio of addition to 

read plate volumes are 1:3, 1:4 or 1:5, respectively. Volume of addition is dependent on 

compound mixing efficiency, cell adherence, and kinetics of cellular response. Assay 

development should always be performed to determine optimal addition volume and 

concentrations prior to screening. 

Addition and Mixing of Compounds to the Cell Plate 

Prompt mixing is required to initiate robust cellular kinetics associated with signal 

transduction assays. Proper addition parameters (for example, dispense speed, height, and 

volume) will initiate a rapid response upon addition. Slow signal increases or variation in 

signal between wells may be signs that mixing is too slow or not uniform. Optimal addition 

parameters typically consist of a fast dispense speed, low pipettor height, and large addition 

volume. Assay optimization is always recommended to determine the proper assay 

conditions prior to running a screen. 

If addition parameters are not optimized, artifacts will occur affecting data quality. One 

common problem is adding compounds too rapidly. Weakly adherent cells may dislodge 

from the monolayer, causing a decrease in fluorescence upon addition. Cell displacement 

can be reduced by slowing dispense speed while decreasing addition volume and increasing 

height. Larger dispense volumes mix rapidly because they encounter less surface tension as 

compared to smaller volumes. However, small sample volumes are less disruptive to a cell 

monolayer and reduce compound consumption. To avoid dislodging weakly adherent cells, 

compounds should be added in small volumes and at relatively low dispense speeds. 
 

Note: Mixing is not typically used during calcium or membrane potential assays. 

Signal artifacts, such as additional noise in the fluorescent trace, may be attributed to 

cell disruption induced by rapid pipettor movement. However, it is not uncommon to 

use mixing to resuspend reagents that have fallen out of solution in the source plate. 

For temperature-controlled assays, cell and source plates should be brought to temperature 

outside of the instrument. It takes approximately 45 to 60 minutes in a 95% humid, CO2 

incubator (15 minutes in a heating block) to warm plates to equilibrium at 37 °C ( 98.6 °F). 

Compound Plates for Suspension Assays 

Unlike adherent assays, suspension cell assays require cell addition directly to the compound 

in the read plates. Compounds are suggested to be prepared at 2X concentration in the 

same diluent as used for cells, since equal volumes of cells will be added to the read plate 

containing the compound. 

In 384-well assay 25 μL cells are added to 25 μL 2X compound; in a 1536-well assay 2 μL cells 

are added to 2 μL compound. Plates should be stored covered to prevent evaporation. 
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Setting Up an Assay Protocol 

An effective way to reduce time and ensure consistent screening parameters is to 

preconfigure protocol (*.fmp) files. Some users define and save protocol files for each cell 

line, project or user. Saved protocol files are opened from File > Open > Protocol File. In 

addition, the last 10 files (6 data and 4 protocol) opened in ScreenWorks Software are listed 

in the bottom portion of the File menu. 

Creating a Protocol File 

A protocol file defines experiment parameters: 

Instrument conditions, for example, read mode, plate positions, file names and file 

storage. 

Assay steps, for example, fluid transfer and reads. 

Analysis options, for example, groups, corrections and export parameters. 

Protocols are created by an easy drag-and-drop operation that moves experimental 

processes from the Process Explorer to the Experiment window. 

Defining the Settings Process 

In the Settings process of the Experiment window, select the appropriate parameters for 

Read Mode, Plate Position, Data File Name and Folders. For a detailed explanation of the 

Settings process and its options, Settings Process on page 58. 

Creating the Assay Sequence 

Select the desired processes from the Process Explorer and drag them to the desired 

sequence position in the Experiment window. 

Click on the process icon you want to define (for example, Transfer Fluid), and then enter 

the desired parameters. For more information on the available protocol processes and their 

options, see ScreenWorks SoftwareOverview on page 37. 
 

Note: The protocol processes are executed in a left-to-right order until there is a 

combined process of Transfer Fluid and Read with TF. After baseline imaging, all 

pipetting actions and imaging occurs in parallel. 
 

Choosing Analysis Options 

In the Analysis process, click on the Grouping, Correction or Export buttons to define the 

analysis parameters to be applied to the experimental data. For more information about 

these options see Analysis Process on page 64. 

When Finished Creating the Protocol 

When you have finished defining the experiment parameters of the processes in the 

Experiment window, click Save As and save the file as an *.fmp file. 
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Optimizing the Optics and Fluid Dispensing 

Optimizing the Hardware Settings 

Prior to screening, the following hardware components should be optimized for signal 

output and detection: 

Excitation intensity 

Exposure time 

Number of reads 

Camera gain for EMCCD camera 

Gate Open for ICCD camera 

Pipettor height 

Dispense speed 

Dispense volume 

Cell parameters for suspension assays. 
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Optimizing Optics Hardware 

Optimization is available to help amplify weak signals or reduce saturation. Modifying read 

settings may not alter the quality of your data because it only regulates the amount of light 

emitted or detected by the system. For instance, doubling the excitation intensity doubles 

the RLUs detected by the system, but your signal-to-noise ratio and Z-factor can remain the 

same. 

To optimize the fluorescence signal: 

1. Place the cell plates on the read positions. 

2. Start with the excitation intensity, camera gain and exposure time settings shown below. 

These settings are the most frequently used to measure basal fluorescence signal. 
 

Camera Type Calcium Assay Membrane Potential Assay 

EMCCD ICCD EMCCD ICCD 

Excitation wavelength (nm) 470–495 470–495 510–545 510–545 

Emission Wavelength (nm) 515–575 515–575 565–625 565–625 

Excitation Intensity (% 50 50 50 50 

Exposure Time (s) 0.4 0.533 0.4 0.533 

Camera Gain 130 2000 50 2000 

Gate Open — 6% — 6% 

3. Perform a Protocol Signal Test to evaluate the basal fluorescence signal. The desirable 

fluorescence signal for intracellular calcium assays is 200–1,200 fluorescence counts for 

EMCCD camera and 500–5,000 for ICCD camera. 

4. If the basal fluorescence signal is substantially out of these ranges, the excitation 

intensity, exposure time and gain or gate can be adjusted. Use the suggestions below to 

adjust the basal fluorescence. 

Basal fluorescence too low: 

Increase the Excitation Intensity if the basal fluorescence signal is too low. During the 

assay, the Excitation Intensity should range between 20% and 100%. 

Increase the Exposure Time. If you increase the Exposure Time, the read interval will 

have to be increased to a minimum of exposure time + 0.1 s (it takes 0.1 s to integrate 

the data). 

Increase the Camera Gain (EMCCD camera). The gain can vary between 1 (extremely 

bright fluorescence) to 240 (luminescence). 

Increase the Gate Open (ICCD camera). The gate can vary between 0.06% (extremely 

bright fluorescence) and 35% (very dim fluorescence). 
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Basal fluorescence too high: 

Decrease the Excitation Intensity. 

Decrease the Exposure Time. 

Decrease the Camera Gain (EMCCD camera). 

Decrease the Gate Open (ICCD camera). 

Adjusting the Pipettor Height 

To ensure prompt compound delivery, the pipettor height can be adjusted. It is based on 

pipettor mechanics and the physics of liquid. for Fluorescence an air gap, called the Hold 

Volume, is drawn into the tips after fluid aspiration from the source plate. This air gap 

ensures fluid doesn’t leak out during pipettor movement. The hold volume will be the first 

item to leave the pipette tip during dispense and enters the target well as a bubble. These 

bubbles may cause random light reflections and spurious signals. To avoid bubbles, fluid 

dispensing should occur with tips just above, but touching the initial well fluid level. This will 

leave the tips touching the meniscus after the addition has been completed to ensure 

complete sample dispensing. 
 

Note: For Luminescence suspension assays, no Hold Volume is recommended along 

with low and fast addition. 

If pipette tips are in the air at the end of fluid delivery, a drop can form on the tip end due to 

surface tension resulting in reproducibility problems. Therefore, the pipettor height should 

be set just above, but touching the starting fluid volume in the wells. 

The fluid surface in a 384- or 1536-well plate is a deeply curved meniscus. Therefore, we 

recommend setting the pipettor height somewhere below the starting fluid volume for the 

384- or 1536-pipettor. 

Adjusting the Fluid Dispensing Speed 

Default dispense speed is 50 μL/s, 20 μL/s and 2 μL/s when dispensing to 96-well, 384-well, 

and 1536-well plates respectively. The table below provides recommended fluid dispense 

speeds for all three plate formats. 
 

Cell Conditions 96-Well Plate 384-Well Plate 1536-Well 

(μL/s) (μL/s) Plate (μL/s) 

Slow dispensing speed for weakly adherent cells 

or non-adherent cells. 

10–50 5–20 1–6 

Fast dispensing speed for strongly adherent cells. 100–200 25–50 5–10 

These values must be experimentally determined for each cell type, but it is generally 

preferable to dispense as fast as possible to enhance mixing of the compounds in the wells. 

The trade-off is that the pipetting speed must not be so forceful as to dislodge cells from the 

well. 
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Optimizing Fluid Volume 

The fluid volume parameters have the following range: 

96-well plate = 5–200 μL 

384-well plate = 1–25 μL 

1536-well plate = 0.5–3 μL 

Large volumes mix more rapidly into the wells than smaller ones. However, smaller sample 
volumes cause less disruption to the cell layer and allow the same source plate to be used for 

multiple cell plates. To avoid dislodging weakly adherent cells, smaller compound volumes 

should be added to the cell plate, and the pipettor should dispense the compounds at a 

relatively low speed. 

Optimizing Pin Tool Delivery 

To ensure proper transfer of compound using a pin tool to your target plate, we recommend 

you evaluate the following factors during assay development. Controlling and standardizing 

these factors for a given application will help you deliver reproducible volumes. 

Pin diameter 

Surface tension of the liquid being transferred 

Surface tension of the pin 

Speed of removal from source liquid 

Speed of pin striking recipient plate 

Depth to which the pin is submerged in the source plate 

Depth to which the pin is submerged in the target plate 

Volume of slot in pin 

Surface tensions of plate and dwell time 

For more information regarding optimization of pin tools, please refer to http://www.vp- 

scientific.com/molecular_devices.htm or contact: 

V&P SCIENTIFIC, INC. 

9823 Pacific Heights Boulevard, Suite T 

San Diego, CA 92121 

Toll Free: +1-800.455.0644 

Phone: +1-858.455.0643 

Fax: +1-858.455.0703 

Email: sales@vp-scientific.com 

mailto:sales@vp-scientific.com
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Optimizing Cell Delivery 

During suspension assays, cells are pumped from the external Cell Flask to the Cell Reservoir 

and pipetted to the read plate. There are several user adjustable settings for suspension cell 

optimization. These parameters need to be optimized for each cell line as each cell line is 

different. The settings include: 

Stir speed in the Cell Flask 

Fill pump speed 

Drain pump speed 

FLIPR Tetra system aspirating/dispensing parameters 

Start the Assay Run 

To start the assay: 

Check the Experiment window to verify that the experiment synopsis is accurate and 

that the appropriate *.fmp file is being used. 

Verify the plates and tips are loaded in the instrument. 

Click the Run button on the toolbar to start the program. 

The upper and lower doors automatically lock before any part in the FLIPR Tetra system 
tower moves. These doors must remain closed until the end of the program including 

the duration of the pipettor tip wash. 
 

FLIPR Calcium Assay Kit Protocol 

This section provides the following information and procedures: 

Materials required to run the calcium mobilization using the FLIPR Calcium Assay Kit 

Cell preparation guidelines 

Dye loading procedure 

Troubleshooting tips for intracellular calcium assays 
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Required Materials 

The following items are required for running the FLIPR Calcium Assay Kit: 
 

Item Source 

FLIPR® Tetra system with Calcium Optics Kit installed (default 

with instrument): 

 
FLIPR® Tetra system LED Module 470–495 nm FLIPR® Tetra 

system Emission Filter 515–575 nm 

Molecular Devices 

See Consumables and 

Accessories on page 245 

FLIPR® Calcium Kits (one of the following): 

 
FLIPR® Calcium Assay Kit, explorer 

FLIPR® Calcium Assay Kit, bulk 

FLIPR® Calcium 3 Assay Kit, express 

FLIPR® Calcium 3 Assay Kit, explorer 

FLIPR® Calcium 3 Assay Kit, bulk 

FLIPR® Calcium 4 Assay Kit, express 

FLIPR® Calcium 4 Assay Kit, explorer 

FLIPR® Calcium 4 Assay Kit, bulk 

FLIPR® Calcium 5 Assay Kit, express 

FLIPR® Calcium 5 Assay Kit, bulk 

FLIPR® Calcium 5 Assay Kit, explorer 

FLIPR® Calcium Evaluation Kit 

Molecular Devices 

 
P/N R8041 

P/N R8033 

P/N R8108 

P/N R8091 

P/N R8090 

P/N R8143 

P/N R8142 

P/N R8141 

P/N R8187 

P/N R8186 

P/N R8185 

P/N R8172 

Clear, flat-bottom, black-wall or clear-wall 1536-, 384- or 96-well 

plates 

See Consumables and 

Accessories on page 245 

Clear, polypropylene source plate See Consumables and 

Accessories on page 245 

FLIPR® pipette tips, 96, 384, or 1536 gasket See Consumables and 

Accessories on page 245 

Cells in suspension — 

Test compounds Specific to receptor 

Growth medium Major laboratory supplier (MLS) 

Incubator (5% CO2, 37 °C / 98.6 °F) MLS 

Centrifuge MLS 

Pipettor and sterile tips suitable for use with microplates MLS 

Probenecid in powder form Sigma 

1 N NaOH Sigma 
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About the Fluorescent Dye 

Contents of the FLIPR® Calcium Assay Kit are optimized to give robust results when used on 

a FLIPR Tetra system according to protocol provided in the kit. Benefits include: 

Increased assay signal 

Reduced background 

Increased z-factor 

Drastically reduced addition artifact (“dip”). 

Dye is excited using the FLIPR Tetra system LED Module, 470–495 nm. Signal is detected 

using the standard 515–575 nm emission filter included with every FLIPR Tetra system. 

Additional emission filters are not required. 
 

Note: The Kit includes masking dye technology covered by issued and pending 

patents including US 6,420,183, US 7,063,952 and EP 0,906,572, licensed exclusively 

from Bayer AG to Molecular Devices. 
 

About Exchange Protein Inhibitors 

Some cell types use mechanisms such as anion exchange proteins to export anionic 

molecules from cells, including anionic forms of fluorescent dyes. This will result in poor dye 

loading. Therefore, it may be critical to inhibit the anion exchange protein to produce a 

successful intracellular calcium assay on the FLIPR Tetra System. 

Probenecid is an anion exchange protein inhibitor. When added to loading buffer, it may 

increase dye retention in cells. CHO-K1 is an example of a cell type known to require 

probenecid. Although probenecid can be useful in slowing dye leakage from cells, it is toxic to 

cells, and therefore inclusion and duration of dye loading step should be kept to a minimum. 

Calcium Assay Kit Experimental Protocol 

Cell Handling 

The FLIPR Calcium Assay Kit is designed to work with many cell types, both adherent and 

non-adherent. We recognize that a variety of cell handling conditions might be adopted at 

the discretion of the user, based on standard operating procedures in the laboratory. In this 

section we provide guidelines on how to prepare the cells for use with the assay kit. 

Adherent cells are the most frequently used cells with the kits. They are typically plated the 

day prior to an experiment and then incubated in a 5% CO2, 37 °C ( 98.6 °F) incubator 

overnight. See the table below for suggested plating volumes and seeding densities to create 

an 80–90% confluent cell monolayer before placing the plates in the FLIPR Tetra Instrument. 
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For non-adherent cells, we recommend centrifuging cells from culture medium and re- 

suspending the pellet in culture medium on the day of the experiment. It is recommended 

after the cells are plated to centrifuge the plates at 100 g for up to 4 minutes (with brake off). 

Alternatively, non-adherent cells can be treated like adherent cells, plating the day before the 

assay using the same plating volumes and seeding densities, as long as the cells are seeded 

onto coated plates (for example, poly-D-lysine or collagen) to ensure good attachment to the 

plate bottom. 
 

Cell Type 96-well Plate (100 μL 384-well Plate (25 μL 1536-well Plate (4 μL 

(cells/well) growth medium) growth medium) growth medium) 

Adherent cells 20,000–80,000 5,000–20,000 1,500–5,000 

Non-adherent 

cells 

40,000–200,000 10,000–50,000 3,000–10,000 

Preparation of Loading Buffer 

The following procedure is designed for preparation of the Loading Buffer per vial of the 

Explorer Kit, the Bulk Kit, or the Express Kit. 

1. To prepare the 1X HBSS Buffer plus 20 mM HEPES for the Bulk and Express Kits only, 

(Explorer Kit contains ready to use HBSS buffer plus 20 mM HEPES pH 7.4 in Component 

B), pipette 100 mL of 10X Hank’s Balanced Salt Solution and 20 mL of 1M Hepes buffer pH 

7.4 into 880 mL cell culture treated water. 

2. Remove one vial of FLIPR Calcium Assay Reagent (Component A) and equilibrate to room 

temperature. 

3. Dissolve contents of Component A vial by adding the appropriate amount of 1X HBSS 

Buffer plus 20 mM HPES as outlined in the table below. Mix by vortexing (~1–2 min) until 

contents of vial are dissolved. It is important that contents are completely dissolved to 

ensure reproducibility between experiments. 

Table 8-1: Quantities of 1X HBSS Required to Dissolve Component A 

Plate Format Explorer Kit (R8142) Bulk Kit (R8141) Express Kit (R8143) 

96-Well or 384-Well 10 mL 10 mL 20 mL 

1536-Well 6.5 mL 10 mL 20 mL 
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4. Prepare the Loading Buffer by diluting the Component A vial mixture with an additional 

volume of 1X HBSS plus 20 mM HEPES Buffer as outlined in table below. Multiple washes 

of the vial are necessary to completely transfer the contents. 

Table 8-2: Quantities of 1X HBSS Plus 20 mM HEPES Required to Perform Second 

Dilution of Component A. 

Plate Format Explorer Kit (R8142) Bulk Kit (R8141) Express Kit (R8143) 

96-Well or 384-Well NA 90 mL 480 mL 

1536-Well NA 55 mL 300 mL 

 
Note: If your cells require probenecid, then a stock solution should be prepared in 

1 M NaOH and added fresh to 1X HBSS buffer plus 20 mM HEPES (adjust pH to 7.4 

after addition of probenecid) for preparation of the Loading Buffer so that the final 

in-well working concentration is 2–2.5 mM. Do not store frozen aliquots of 

Loading Buffer with probenecid and always prepare fresh probenecid on the day 

of the experiment. 

 

CAUTION! The components supplied are sufficient for proper cell loading. For 

optimum results it is important NOT to add any additional reagents or change 

volumes and concentrations. 

 

Loading the Cells Using the Loading Buffer 
 

1. Remove cell plates from the incubator or centrifuge. Do not remove the supernatant. 

Add an equal volume of Loading Buffer to each well (100 μL per well for 96-well plates, 25 

μL for 384-well plate). 
 

Note: Add 2 μL per well for 1536-well plate by using anAquaMax® DW4 or 

equivalent device. 

 

Note: Although Molecular Devices does not recommend washing cells before dye 

loading growth medium and serum may interfere with certain assays. In this case, 

the supernatant can be aspirated and replaced with an equal volume of serumfree 

HBSS plus 20 mM HEPES buffer before adding the Loading Buffer. Alternatively, 

cells can be grown in serum-free conditions. 

CAUTION! Do NOT wash the cells after dye loading. 
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2. Incubate cell plates for 1 hour at 37 °C ( 98.6 °F) and then keep the plates at room 

temperature until used (loading time should be optimized for your cell line). 
 

Note: Some assays perform optimally when the plates are incubated at room 

temperature. 

 

Running the FLIPR Calcium Assay Kit 

To start the calcium assay: 

1. After incubation, acclimate the plates to room temperature for approximately 10–20 

minutes prior to transferring them to the FLIPR Tetra system. Please refer to 

“Recommended Setup Parameters” on page 136 for running the Calcium assay kit on 

FLIPR Tetra system. 

2. When performing a signal test prior to an experiment, typical average baseline counts 

range from 800–1,200 RFU for the EMCCD camera and 500–5000 for the ICCD camera on 

FLIPR Tetra system. 

3. Suggested experimental setup parameters for each FLIPR Tetra system are as follows. 

Fast addition speeds close to the cell monolayer are recommended to ensure better 

mixing of compounds and lower signal variance across the plate. However, further assay 

development, adjustment of the volume, height and speed of dispense, is 

recommended to optimize your cell response. 

Recommended Setup Parameters 

Recommended experimental setup parameters are as follows. 
 

Experimental Setup EMCCD Cameras ICCD Camera 

Parameters 

Read Mode Fluorescence Fluorescence 

Excitation Wavelength 470–495 nm 470–495 nm 

Emission Wavelength 515–575 nm 515–575 nm 

Excitation Intensity 
1 

80% 
1 

50% 

Camera Gain 50–130 2000 

Gate Open — 
1 

6 % 

Exposure Length 
1 

0.4 s 
1 

0.53 s 

Read Interval 1 s 1 s 

1. Can be adjusted to increase or decrease the signal if low RFUs or saturation problems 

occur. 
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Addition Parameters 96-Well Plate 384-Well Plate 1536-Well Plate 

Compound concentration (fold) 5X 5X 7X 

Addition volume (μL) 50 12.5 1 

Addition height (μL) 210–230 25–45 1–2 

Tip up speed (mm/s) 10 10 5 

Dispense speed (μL/s) Adherent cells 50–100 30–40 4–7 

Dispense speed (μL/s) Non-adherent cells 10–20 10–20 1–5 
 

Troubleshooting Guide 

This section presents solutions to problems that users may encounter when running calcium 

flux assays. 

Fluorescence Drop Upon Compound Addition 

This may be the result of dislodging cells from the well bottom during addition. Lowering the 

addition/dispense speed or adjusting the addition height or both should solve the problem 

in this case. 

Another potential reason is the dilution of the non-fluorescent compound into a plate with 

media containing fluorescent components (like DMEM media). This Ca4 kit mediates this 

issue compared to earlier developed Ca-kits. 

Adding volumes greater than recommended may increase the initial fluorescence drop. In 

these cases it may be necessary to adjust the volumes of the components. The 

recommended volume of the Loading Buffer is 100 μL for 96-well plates, 25 μL for 384-well 

plates and 2 μL for 1536-well plates. 
 

CAUTION! Decreasing the final in-well concentration of the Loading Buffer can 

decrease the response of the assay. If only one addition is required, then adding a 

higher concentration of compound in low volume could help reduce any fluorescence 

drop upon addition. 

 

Serum-Sensitive Cells or Targets 

Some cells are serum-sensitive resulting in oscillations of intracellular calcium that could 

interfere with results. Also, some target receptors or test compounds may interact with 

serum factors. In these cases, serum-containing growth medium should be removed prior to 

addition of loading buffer. The volume of growth medium removed should be replaced with 

an equal volume of 1X HBSS plus 20 mM HEPES buffer before loading. Alternatively cells 

could be incubated overnight in lower concentrations of FBS and not washed prior to the 

addition of Dye Loading Buffer. 
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Cells with DMSO Show a Calcium Response 

Buffer used for the negative control wells should contain the same final concentration of 

DMSO as is present in the wells containing the test compounds. However, this concentration 

of DMSO could cause a calcium flux. In these cases, add DMSO to the Loading Buffer such 

that the final concentration of DMSO in the wells does not change after buffer addition. 

Precipitation in the Reagent Buffer 

The FLIPR® Calcium Assay Kit is compatible with numerous buffers. Use buffers shown to 

work in previously established assays, if available. 

Response is Smaller than Expected 

The agonist and antagonist may stick to the tips and trays. Use up to 1% BSA in all 

compound buffer diluents and presoak tips in compound buffer with up to 1% BSA. 
 

Note: Do not use the same source plate for presoaking and compound addition when 

using a 384 Pipettor head in the FLIPR® Tetra system. Instead, use a 'Boat' for the 

presoak. 
 

Apparent Well-to-Well Variation is Observed 

AquaMax DW4 or equivalent dispenser is recommended for use with additions of cells or dye 

prior to the assay on the FLIPR Tetra system if apparent well-to-well variation is observed. In 

some cases allowing the plates to stand at room temperature prior to use or adding a single 

mix cycle in the compound or assay plate can decrease well-to-well variation. 
 

FLIPR Membrane Potential Assay Kit Protocol 

This section provides the following information and procedures: 

Materials required for the assay 

Cell preparation guidelines 

Dye loading procedure 

Troubleshooting tips for membrane potential assays 
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Required Materials 

The following materials are required for running a membrane potential assay: 
 

Item Source 

FLIPR® Tetra system with Membrane Potential Optics Kit 

installed: 

 
FLIPR® Tetra system LED Module 510–545 nm 

FLIPR® Tetra system Emission Filter 565–625 nm 

Molecular Devices 

See Consumables and Accessories on 

page 245 

One of the following Membrane Potential Assay Kits: 

 
Evaluation Kit 

MP Blue, explorer 

MP Blue, bulk 

MP Red, explorer 

MP Red, bulk 

Molecular Devices 

 
R8128 

R8042 

R8034 

R8126 

R8123 

Clear, flat-bottom, black- or clear-wall 1536-, 384- or 96- 

well plates 

See Consumables and Accessories on 

page 245 

Clear polypropylene source plates See Consumables and Accessories on 

page 245 

FLIPR® Tetra system pipette tips, 96, 384 or 1536 gasket See Consumables and Accessories on 

page 245 

Cells in suspension — 

Test compounds Specific to receptor 

Growth medium Major Laboratory Supplier (MLS) 

Incubator MLS 

Centrifuge MLS 

Pipettor and sterile tips suitable for use with microplates MLS 

1 N NaOH MLS 

 

Note: The Kit includes masking dye technology covered by issued and pending 

patents including US 6,420,183, US 7,063,952 and EP 0,906,572, licensed exclusively 

from Bayer AG to Molecular Devices. 
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About FLIPR Membrane Potential Assay Kit 

The FLIPR® Membrane Potential Assay Kits from Molecular Devices provide a fast, simple 

and reliable fluorescence-based assay for detecting changes in voltage across the cell 

membrane. These kits are designed to work in association with many receptors and ion 

channels as well as both adherent and non-adherent cell lines. The assay is a mix-and-read 

procedure in which cells are incubated with the kit reagents for 30 minutes after which the 

signal is detected using a FLIPR Tetra system. 

There are no intermediate wash steps involved and, typically, the assay is complete one 

minute after addition of the agonist. 

Conventional protocols for evaluating changes in membrane potential are technique- 

sensitive and multi-step procedures consisting of preparing large batches of dye and 

introducing dye into the compound plate. Several problems are routinely encountered with 

the conventional methods, all of which add to experimental variability. 

Problems in a conventional assay protocol include: 

Slow response time of traditional dyes used 

Extensive pre-read soaking procedure 

Requirement for precise temperature control 

Variation in fluorescence according to ionic concentrations 

Molecular Devices has developed the FLIPR® Membrane Potential Assay Kits to maximize cell 

line/channel/compound applicability while eliminating causes of variability in the data and 

reducing the number of steps in the conventional protocol. 

Advantages of the FLIPR® Membrane Potential Assay Kits include: 

More reproducible data 

Faster response time 

No cumbersome pre-assay preparation 

Ease of use at room temperature to physiological temperatures 

Fewer steps in the assay resulting in higher sample throughput 

FLIPR Membrane Potential Assay Cell Preparation 

Cell Densitiess 

A variety of cell handling conditions may be adopted at your discretion based on standard 

operating procedures in the laboratory. Non-adherent cells are typically plated on the day of 

experiment on a coated plate (for example, poly-d-lysine or collagen) to assist cell adherence 

to the plate bottom. We recommend you then centrifuge the plates at 1000 rpm for up to 4 

min with the brake off. Adherent cells are seeded the day prior to an experiment and 

incubated in a 5% CO2, 37 °C incubator overnight. To create an 80%–90% confluent cell 

monolayer, it is recommended the cells be seeded at densities shown in the table below. 



FLIPR Tetra High Throughput Cellular Screening System User Guide 

154 0112-0109 K 

 

 

 
 

Cell Type 96-well Plate (100 μL 384-well Plate (25 μL 1536-well Plate (4 μL 

(cells/well) growth medium) growth medium) growth medium) 

Adherent cells 20,000–80,000 5,000–20,000 1,500–5,000 

Non-adherent 

cells 

40,000–200,000 10,000–50,000 3,000–10,000 

 

FLIPR Membrane Potential Assay Kit Dye Loading 

Preparation of Loading Buffer 

The following procedure is designed for preparation of the Loading Buffer for either of the 

Membrane Potential Assay Kits, BLUE (R8034) or RED (R8123) in the Bulk format. 

 
Blue or Red 

To prepare loading buffer: 

1. To prepare a 1X Reagent Buffer dilute 10 mL of 10X Reagent Buffer (Component B) to 100 

mL with distilled water. Adjust to pH 7.4 with 1 N NaOH. 
 

Note: Occasionally, a white precipitate forms in the 10X Reagent Buffer bottle. 

This is normal and will not affect the assay. 

Depending upon the cell type and application, the Assay Buffer as provided with the 

FLIPR® Membrane Potential Assay Kit may not be the ideal choice. If so, alternative 

buffers may be used at your discretion in order to achieve optimal results. 

2. Remove a vial of FLIPR® Membrane Potential Assay Reagent (Component A). 

3. Dissolve contents of vial completely by adding 100 mL of 1X (96 and 384) or 67 mL of 3X 

(1536) Assay Buffer. Mix by repeated pipetting until the contents are completely 

dissolved. 
 

Note: For best results, dissolve the contents of the vial with 10 mL of 1x Assay 

Buffer, and then perform several washes of the vial using 1x Assay Buffer to yield a 

total volume of 100 mL (96 or 384) or 67 mL (1536). 

 

Note: Components supplied are sufficient for proper cell loading. For optimum 

results, it is important NOT to add any additional reagents or change volumes and 

concentrations. 
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Loading the Cells Using Loading Buffer 

To load the cells: 

1. Remove the cell plates from the incubator or centrifuge. Do not remove the 

supernatant. Add Loading Buffer to each well (100 μL per well for 96-well plates, 25 μL for 

384-well or 2 μL for 1536-well plates). 
 

Note: Although Molecular Devices does not recommend washing cells before dye 

loading, growth medium and serum factors can be washed away before adding 

the Loading Buffer, provided residual volumes after the wash step are as 

described. Alternatively, cells can be grown in serum-free conditions. 

2. Incubate the cell plates for 30 minutes at 37 °C (98.6 °F). 
 

 
 

 

 

Running the FLIPR Membrane Potential Assay 

Before incubation, ensure that the FLIPR Tetra system is equipped with the 510–545 nm LED 

module and 565–625 nm emission filter. See LED module and emission filter installation 

instructions in Exchanging Hardware on page 105 for a picture diagram can be faxed to you 

by contacting Molecular Devices Technical Support. See 

1. Choose the 510–545/565–625 excitation/emission wavelengths respectively from the 

Settings process in ScreenWorks Software. After incubation transfer the plates directly to 

FLIPR Tetra system and begin the Membrane Potential assay. 

2. Place the filter holder in its correct position in the FLIPR Tetra system. For a signal test, a 

starting average count of 1,500-2,500 RLU is recommended. 

Recommended Setup Parameters 

Recommended experimental setup parameters are provided below. Note that the addition 

speeds are faster than in the conventional protocol because of the increased robustness of 

the cells after the new loading procedure. 

Faster addition speeds can lead to better mixing of compounds and lower signal variance 

across the plate. 
 

Detection Parameters EMCCD Camera ICCD Camera 

Read Mode Fluorescence Fluorescence 

Excitation Wavelength 510–545 nm 510–545 nm 

Emission Wavelength 565–625 nm 565–625 nm 

Excitation Intensity 
1 

50 % 
1 

50 % 

Note: In some cases, incubation at room temperature may improve results. 

CAUTION! Do not wash the cells after dye loading. 
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Detection Parameters EMCCD Camera ICCD Camera 

Camera Gain 50 2000 

Gate Open — 
1 

6 % 

Exposure Length 
1 

0.4 s 
1 

0.53 % 

Read Interval 1 s 1 s 

1. Can be adjusted to increase or decrease the signal if low RFUs or saturation problems 

occur. 

 
 

Addition Parameters 96-Well Plate 384-Well Plate 1536-Well Plate 

Compound Addition Volume (μL) 50 12.5 1 

Compound Concentration (Fold) 5X 5X X 

Dispense Speed (μL/s) Adherent Cells 50–100 10–50 5–10 

Dispense Speed (μL/s) Nonadherent Cells 10–50 5-20 1-6 
 

Troubleshooting the FLIPR Membrane Potential Assay Kit 

This section presents solutions to problems that users may encounter when running 

membrane potential assays. 

Fluorescence Drop Upon Compound Addition 

This may result from dislodging cells from the wells during addition. Shortening incubation 

times, plating cells on poly-D-lysine plates or slowing the dispense speed should solve the 

problem in this case. 

Adding volumes greater than recommended may increase the initial fluorescence drop. In 

these cases it may be necessary to adjust the volumes of the components. The 

recommended volume of the Loading buffer is 100 μL for 96 well plate, 25 μL for 384 well 

plate or 2 μL for 1536-well plates. 
 

CAUTION! Increasing the final in-well concentration of the Loading Buffer may 

decrease the response of the assay. If only one addition is required, then add the 

appropriate volume of buffer before addition one. 

 

Fluorescence Increase 

An increase of fluorescence may be observed upon buffer only challenge. This increase is 

most likely due to a response of endogenous ion channels to increasing ionic strength. Patch 

clamping data supports this observed change. The choice of cells and expression levels of 

endogenous channels can greatly influence resting and changing membrane potentials. 

Match the compound addition buffer to the buffer in the cell plate (culture medium plus dye 

loading buffer) so there is no change in ion concentration upon compound addition. 
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No Response 

Not all assays work well with all cell lines or channels. To address this problem, we have 

developed two different assays to maximize the opportunity for a successful assay. If you 

have not tried both FLIPR® Membrane Potential Assay Kit formulations, Blue and Red, then 

first try the alternate kit to determine if your cell line is compatible. The FLIPR® Membrane 

Potential Evaluation Assay Kit (R8128) contains both formulations in an Explorer Kit format to 

facilitate testing of cell lines, channels, and compounds. If you do not see a change in 

fluorescence with either formulation, then we suggest changing some of the assay 

conditions. 

Recommendations include: replacing media before dye loading, longer incubation and assay 

times; preparing compounds in the loading buffer; and choosing different buffers such as 

Tyrode’s or specific ion-free buffers. For example, if studying a calcium channel, dye load cells 

using a calcium-free buffer and prepare your compound plate using a calcium containing 

buffer. 

Effect of DMSO on Membrane Potential Assays 

High concentrations of DMSO are toxic to many cell lines and affect compound mixing. Also, 

DMSO can induce physiological changes in cells (for example, differentiation). If the test 

compound preparation contains DMSO, it is important to titrate the DMSO to determine the 

maximum concentration that can be used with each indicator cell line and test compound. 

With some cell lines that have been tested, there was no effect on signal level up to 1% 

DMSO final concentration. 
 

Voltage Sensor Probes Assay Protocol 

This section provides the following information and procedures: 

Materials required for the assay 

Cell preparation guidelines 

Dye loading procedure 

Required Materials 

The following materials are required for running a membrane potential assay: 

Item Source 

FLIPR® Tetra system with Voltage Sensor Probes Optics Kit installed: 

 

FLIPR® Tetra system LED Module 390–420 nm FLIPR® Tetra System 

Emission Filter 440–480 nm FLIPR® Tetra System Emission Filter 565– 

625 nm 

Molecular Devices 

See Consumables and 

Accessories on page 245 
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Item Source 

Voltage Sensor Probes: 

 
DisBAC2(3) and CC2-DMPE 

VABSC-1 Background Suppression Dye 

Invitrogen 

 
K1016 

K1019 

Clear, flat-bottom, black- or clear-wall 384- or 96-well plates See Consumables and 

Accessories on page 245 

Clear polypropylene source plates See Consumables and 

Accessories on page 245 

FLIPR® Tetra system pipette tips, 96 or 384 See Consumables and 

Accessories on page 245 

Cells in suspension — 

Test compounds Specific to receptor 

Growth medium Major Laboratory 

Supplier (MLS) 

Incubator MLS 

Centrifuge MLS 

Pipettor and sterile tips suitable for use with microplates MLS 

1 N NaOH MLS 

 

About the Fluorescent Dye 

Voltage Sensor Probes are a Fluorescence Resonance Energy Transfer (FRET) based assay 

technology used for high-throughput ion channel drug discovery. The membrane-bound, 

coumarinphospholipid (CC2- DMPE) FRET donor binds only to the exterior of the cell 

membrane. The FRET acceptor is a mobile, negatively charged, hydrophobic oxonol [either 

DiSBAC2(3) or DiSBAC4(3)], which binds to either side of the plasma membrane in response 

to changes in membrane potential. Resting cells have a relatively negative potential. 

Therefore, the two probes associate with the cell membrane exterior, resulting in efficient 

FRET. Exciting the CC2-DMPE donor probe (at ~405 nm) generates a strong red fluorescence 

signal (at ~580 nm) from the oxonol acceptor probe. When the membrane potential 

becomes more positive, as occurs with cell depolarization by KCl, the oxonol probe rapidly 

translocates (on a sub second time scale) to the other membrane face. Thus, each oxonol 

probe "senses" and responds to voltage changes in the cell. This translocation separates the 

FRET pair, and exciting the CC2-DMPE donor probe now generates a strong blue fluorescence 

signal (at ~460 nm) from the CC2-DMPE probe. 
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Cell Preparation for the voltage Sensor Probe Assay 

Cell Densities 

A variety of cell handling conditions may be adopted at your discretion based on standard 

operating procedures in the laboratory. Nonadherent cells are typically plated on the day of 

experiment on a coated plate (for example, poly-d-lysine or collagen) to assist cell adherence 

to the plate bottom. We recommend you then centrifuge the plates at 1000 rpm for up to 4 

min with the brake off. Adherent cells are seeded the day prior to an experiment and 

incubated in a 5% CO2, 37° C (98.6 °F)incubator overnight. To create an 80–90% confluent cell 

monolayer, it is recommended the cells be seeded at densities shown in the following table. 
 

Cell Type (cells/well)    96-Well Plate (100 μL growth 384-Well Plate (25 μL growth 

medium) medium) 

Adherent cells 20,000–50,000 5,000–30,000 

Non-adherent cells 40,000–100,000 10,000–60,000 

 
Preparation of Loading Buffer 

To prepare loading buffer: 

1. CC2-DMPE: A 5 mM stock solution can be prepared in DMSO and stored at -20° C (-4 °F). 

On the day of the assay, a working solution needs to be prepared. An equal volume of 

10% Pluronic acid is mixed with CC2-DMPE and subsequently diluted to 5 μM in VSP-1 

solution. Vigorously mix the buffer and protect from light prior to use. 

2. DisBAC2(3): A 12 mM stock solution can be prepared in DMSO and stored at -20° C (-4 °F). 

A 200 mM stock solution of VABSC-1 can be prepared in water and stored at RT. 

On the day of the assay, a 4 μM working solution of DisBAC2(3) needs to be prepared 

including 0.21 μM VABSC-1 quencher in VSP-1 solution. 

 
Loading the Cells Using Loading Buffer 

To load the cells: 

1. Remove media from all wells of the 384-well plate and replaced with 50 μL/well VSP-1 

solution. 

2. Remove VSP-1 immediately and replace with 25 μL/well CC2-DMPE loading buffer and 

incubate at room temperature for 30 minutes, covered and protected from light. 

3. After 30 minutes, remove the CC2-DMPE loading buffer and wash wells with 50μL/well 

VSP-1 solution. 

4. Immediately remove VSP-1 and replace with 4 μM DisBAC2(3) and 0.21 μM VABSC-1 

loading buffer, then incubate for 30 minutes at room temperature protected from light. 
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Running the Voltage Sensor Probe Assay 

Before incubation, ensure that the FLIPR Tetra system is equipped with the 390–420 nm LED 

module plus the 440-480 nm and 565-625 nm emission filter. See LED module and emission 

filter installation instructions in Exchanging Hardware on page 105. 

Choose the 390–420/440–480 excitation/emission wavelengths respectively for Read Mode 1 

from the Settings process in ScreenWorks Software. Also select the 390–420/565–625 

excitation/emission wavelengths respectively for Read Mode 2. After incubation transfer the 

plates directly to FLIPR Tetra system and begin the Voltage Sensor Probes assay. 

The assay may be performed at room temperature up to physiological temperature. 

 
Recommended Setup Parameters 

Recommended experimental setup parameters are provided in the following tables. 

Faster addition speeds can lead to better mixing of compounds and lower signal variance 

across the plate. 
 

Detection Standard, EMCCD Camera Aequorin, ICCD Camera 

Parameters 
Read Mode 1 Read Mode 2 Read Mode 1 Read Mode 2 

Read Mode Fluorescence Fluorescence 

Excitation Wavelength 390–420 nm 390–420 nm 390–420 nm 390–420 nm 

Emission Wavelength 440–480 nm 440–480 nm 440–480 nm 565–625 nm 

Excitation Intensity 
1 

50–100 % 
1 

50 % 

Camera Gain 80 2000 

Gate Open — 
1 

6 % 

Exposure Length 0.25 s each mode 0.25 s each mode 

Read Interval 1 s for both modes 1 s for both modes 

1. Can be adjusted to increase or decrease the signal if low RFUs or 

saturation problems occur. 
 

Addition Parameters 96-Well Plate 384-Well Plate 

Compound Addition Volume (μL) 50 25 

Dispense Speed (μLs) Adherent Cells 50–100 10–50 

Dispense Speed (μL/s) Non-adherent Cells 10–50 5–20 
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Luminescence Assay Protocol 

This section provides the following information and procedures: 

Materials required for the assay 

Cell preparation guidelines 

Coelentrazine loading procedure 

Running the assay on FLIPR® Tetra System 

Optimizing tips for Luminescence assays 

Note: The references to the instrument assume the Aequorin ICCD camera option is 

present along with the Cell Suspension option. 
 

Required Materials 

The following materials are required for running a luminescence assay: 

Table 8-3: Cell Preparation for Aequorin Assays 

Item Source 

FLIPR® Tetra system with Aequorin, ICCD camera option and 

Cell Suspension option 

Molecular Devices 

Clear, flat-bottom, black wall 96-, 384-, 1536-well plates See Consumables and Accessories 

on page 245 

Clear polypropylene source plates (for adherent protocols) See Consumables and Accessories 

on page 245 

Black FLIPR® System pipette tips, 96- or 384-well or 1536 tip 

block and gaskets 

See Consumables and Accessories 

on page 245 

Test compounds Specific to receptor 

Cells in suspension Optional 

Coelenterazine Specific to Photoproteins 

Growth medium Major Laboratory Supplier (MLS) 

Incubator MLS 

Centrifuge MLS 

Pipettor and sterile tips suitable for use with microplates MLS 
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Cell Densities 

A variety of cell handling conditions may be adopted at your discretion based on standard 

operating procedures in the laboratory. Non-adherent cells are typically plated on the day of 

experiment on a coated plate (for example, poly-d-lysine or collagen) to assist cell adherence 

to the plate bottom. We recommend you then centrifuge the plates at 100g for up to 4 min 

with the brake off. Adherent cells are seeded the day prior to an experiment and incubated in 

a 5% CO2, 37 °C (98.6 °F) incubator overnight. To create an 80%–90% confluent cell 

monolayer, it is recommended the cells be seeded at densities shown in the table below. For 

suspension experiments, cells are loaded into a cell flask on the day of the experiment and 

are pipetted via the instrument into the read plate, so the flask concentration as well as the 

volume pipetted controls the final concentration. 

The recommended concentrations are listed in the following table. 
 

Cell Type 96-Well Plate (100 μL 384-Well Plate (25 μL 1536-Well Plate (2–3 μL 

(cells/well) growth medium) growth medium) growth medium) 

Adherent cells 5,000–50,000 1,250–15,000 1,000–2,500 

Non-adherent 

cells 

40,000–100,000 10,000–60,000 2500–-15,000 

Suspension 

cells 

10,000–40,000 2,500–10,000 1,000–5,000 

Coelenterazine Loading For Adherent Assays 

To load the cells for an adherent assay: 

Before the day of the assay, remove culture medium from wells. 

Wash cells in ‘BSA Medium’ containing DMEM/HAM’s F12 with HEPES, without phenol red, 

catalog# 11039-021 (Invitrogen) + 0.1% BSA. 

In reduced lighting conditions, make up a solution of coelenterazine appropriate for your cell 

type, in ‘BSA Medium’ and add a volume of 100 μL (96-well plates), 25 μL (384-well plates), or 

3 μL (1536-well plate) per well. Final concentration in the well should be 5–10 μM. 

Incubate the cells for 4–6 hrs at room temperature (22 °C/71.6 °F or lower). Cover the plates 

with aluminum foil to protect from light and to avoid degradation of coelenterazine. 

Coelenterazine Loading for Suspension Cell Assays 

To load the cells for a suspension assay: 

1. Before the day of the assay, remove the selection Antibiotics from cells. 

2. On the day of the assay, wash cells in seeding flask with 20 mL DPBS (without Calcium 

and Magnesium). 

3. Dislodge the cells by adding 15 mL Versene, incubating for 5 minutes in 37 °C (98.6 °F) 5% 

CO2 and immediately adding 20 mL of growth media without selection antibiotics. 
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4. Centrifuge in 50 mL tube @ 1000 RPM or 168 g for 2.5–3 minutes. 

5. With supernatant removed and cells re-suspended in 40 mL BSA-medium, count cells 

and adjust density to 5.0 x 106 cells/mL. 

6. Under reduced lighting conditions, recommended type of coelenterazine should be 

added to reach a final concentration of 5 μL. 

7. Cells should be placed in 15 mL aluminum wrapped tubes on rotating wheel (~7–8 RPM) 

at room temp (below 22 °C/71.6 °F) for 4 hours to overnight. 

8. After incubation, cell density should be adjusted while protecting from light and cells 

should be placed in the cell stir flask and stirred on FLIPR Tetra system at speed 6. 

9. Cells should spin protected from light for 1–2 hours prior to the start of the assay. 

Preparation of Cell Reservoir and Running the Assay 

1. The Cell Reservoir must have been cleaned at the end of the previous day’s assay. If this 

was done, rinse with DI H2O, several times. 

2. If the Cell Reservoir was not cleaned after previous assay, follow instructions for making 

AquaMax Sterilant Kit Procedure (Cat# R8156, Molecular Devices). See Consumables and 

Accessories on page 245. 

3. Fill a flask with the sterilant solution and run 3–4 Cell Reservoir wash cycles including a 2 

minute soak (Hold Time = 120 s). 

4. Physically wipe the Cell Reservoir with Kimwipes moistened in DI water. 

5. Rinse the Cell Reservoir 5 times with DI water and follow the steps for preparation in #6. 

6. Prior to start of assay, Cell Reservoir and lines to and from spinner flask should be rinsed 

5X each with the following: 

70% Ethanol 

Endotoxin-free DI water 

Media containing BSA-Medium 0.1% BSA 

7. Prior to start of screening, insert the hard plastic tubes from the Cell Flask into the lines 

running from the 8-way valve by pinching the lines and sliding the tubing inside. 

8. Cycle the cells through to the Cell Reservoir two to three times prior to starting assay. 

9. Use 2–3 plates to prior to screening and insure that the camera settings are within range 

of the signal. 

If cells are recirculated back to the cell flask, it is strongly recommended that the tips be 

washed each time an assay is run to reduce risk of contamination of the cells by toxic or 

antagonist compounds. 
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Instrument Setup 

Luminescence assays require no excitation source, but do require optimal instrument 

conditions to collect the maximum amount of light emitted from the assay. These settings 

are specific to the Aequorin camera option. 

In order to provide optimal light collection by the FLIPR Tetra system, we recommend you 

leave an empty emission filter position in the filter slider to run aequorin. In addition, you 

must calibrate the instrument to use no LEDs and emission filters. This state is identified as 

the NONE/NONE Excitation/Emission Wavelengths. Detailed instructions outlining the 

removal of the emission filters and calibration are found in Exchanging Hardware on page 

105. 

Experimental Setup Parameter 
 

Parameter Setting 

Read Mode Luminescence 

Excitation Wavelength None 

Emission Wavelength None 
1 

Camera Gain 70,000–280,000 
1 

Exposure Time 0.53 s 

LED Excitation Intensity NA 

Gate Open 100% 

Read Interval 1 s 

Reads before pipetting 5 

Reads during first interval 50–90 

Save Assay Images Possible, but creates very large files 

1. Can be adjusted to compensate for cell brightness or saturation problems. 

Fluid Transfer Settings—Aspirate 
 

Parameter Suspension Setting (pipette cells) Adherent Settings (pipette 

compound) 

Cell Flask Spinning Rate Manual setting, Speed 6 NA 

Fluid Transfer Type Single Aspirate, Single Dispense Single Aspirate, Single Dispense 

Source Plate defaultcellres384 Source Plate 2 

Fill Reservoir speed 5 NA 

Drain Reservoir speed 4 NA 

Drain destination Cell flask NA 

Aspiration Volume 25 μL 25 μL 
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Parameter Suspension Setting (pipette cells) Adherent Settings (pipette 

compound) 

Aspiration Height 70 μL 5 μL 

Aspiration Speed 20 μL/s 20 μL/s 

Tip Up Speed 10 mm/s 10 mm/s 

Hold Volume 0 μL 0 μL 

 

Fluid Transfer Settings—Dispense 
 

Parameter Suspension Setting Adherent Settings 

Target Plate Read Plate Read Plate 

Volume 25 μL 25 μL 

Height 15 μL 30 μL 

Speed 30 μL/s 20 μL/s 

Removal Speed 10 mm/s 10 mm/s 
1 

Expel Volume 0 μL 0 μL 

Pause in Well None None 

Hold pipettor during dispense None None 

1. A hold or expel volume will introduce air bubbles into the well causing false spikes in 

signal. 

Recommended Assay Settings 
 

Parameter Setting 

Reduction Type Area under the curve, from or shortly after addition point to the end of the assay 

Correction Subtract bias based on Sample 1 

Post Assay Cell Suspension Cleaning 
 

CAUTION! The suspension cell system should never be left without cleaning at the 

end of an assay day or between assays with different cells. 

1. Remove cell spinner flask and insert tubing from flask into DI water solution. 

2. Insert return line tubing to a waste flask making sure that the tubing does not reach into 

the waste fluid. It will need to be left as clean as the inlet tubing. 

3. Perform a manual reservoir wash with water and follow by wiping out the reservoir with 

a Kimwipe. 
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4. Build a FLIPR Tetra system protocol to wash the reservoir and all tubing in the following 

order: 

5 times with Endotoxin-free DI water. 

5 times with Cytoclense Sterilant wash and soak (2 min). 

5 times with Endotoxin-free DI water. 

5 times with 70% Ethanol and leave system and all tubing dry. 

5. The cell flask also must be washed each time after use: 

Rinse flask, spinner, caps, and all tubing with Endotoxin-free DI water. 

Use glassware detergent safe for use with cell culture vessel. 

Scrub with bottle brush and flush lines. 

Rinse with Endotoxin-free DI water. 

Soak flasks in Cytoclense sterilant (see Appendix D). 

Rinse with Endotoxin-free DI Water. 

Rinse with 70% Ethanol and leave all components to air dry or bake in oven. 

In addition, reservoir and spinner flask may be autoclaved. 

Optimizing an Assay 

The majority of the FLIPR Tetra system assay optimization is related to cell treatment prior to 

and during the assay. Cell and assay conditions to check include the following: 

Cell Culture on page 166 

Cell Seeding on page 167 

Loading Coelenterazine on page 167 

Source Plate on page 167 

Cell Culture 

Conditions to check: 

Cell passage number. 

Cell growth conditions, for example confluency in flasks and/or in wells. 

Expression induction time for transfected cells—concentration of selection antibiotics 

and overall cell viability. 
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Cell Seeding 

Conditions to check: 

Seeding density. Do not allow cells to become over-confluent. 

Type of black, clear-bottom white or clear plate. 

Volume of growth medium in each well. 

Growth medium replacement during seeding period. 
 

Loading Coelenterazine 

Conditions to check: 

Seeding density. Do not allow cells to become over-confluent. 

Type of black, clear-bottom white or clear plate. 

Volume of growth medium in each well. 

Growth medium replacement during seeding period. 
 

Source Plate 

Conditions to check: 

Type of buffer used should match coelenterazine buffer. 

For suspension assay, prepare 2x compound directly in read plate. 

For adherent assays, prepare a polypropylene plate with 2x compound. 

Volume of fluid in source plate in relation to required transfer volume and plate dead 

volume. 
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Chapter 9: Troubleshooting 
 
 

This chapter contains tables of symptoms and solutions to help you diagnose and repair 

problems with the FLIPR Tetra system. In some cases, you will need to contact Molecular 

Devices Technical Support. See Obtain Support. 
 

Instrument Status Colors 

ScreenWorks Software is designed to handle most errors that occur when running the 

FLIPR Tetra system. The status of the system is reported in the Instrument Status window. 

Depending on the state of the instrument, a different color block (green, yellow, red or black) 

is displayed at the bottom of the Instrument Status window. 
 

If the Instrument Status Then there is... 

Color is... 

Green Proper and open communication. 

Yellow Minor communication error. Clear error by selecting Clear Error from 

the Instrument menu. 

Red Instrument failure. Instrument must be reset by selecting Reset from 

the Instrument menu. 

Black No instrument communication available. This is typically shown when 

working in Offline mode. 

 

Troubleshooting Start-Up 
 

Symptom or Error Message Possible Causes Solutions 

“Connecting to the instrument, please wait. 

Will enter offline if the instrument is not 

connected or if this dialog is closed. Dialog 

may not close immediately on pressing the 

close button while connection is being 

attempted.” 

ScreenWorks Software 

is waiting for the 

FLIPR Tetra system to 

complete initialization 

prior to connecting. 

Wait until Assay Finished 

(Unlocked) light is the only 

light illuminated on the front 

instrument panel before the 

software and instrument will 

connect. 

"Camera chiller subsystem not functional. 

Please contact Technical Support. The 

instrument may have degraded read 

performance until it is repaired: Can't 

communicate with chiller." 

Instrument is not 

communicating with 

the chiller. 

Make sure the chiller is 

turned ON. Contact Technical 

Support. See Obtain Support. 

9 
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Symptom or Error Message Possible Causes Solutions 

409:“Initialization halted because tips are 

loaded. Please verify that the appropriate 

tip rack (96,384,1536) is loaded and select 

RESET”. 

Tips are on the 

pipettor head and 

need to be unloaded 

during instrument 

initialization/reset. 

Place tip rack in source 3/tip 

loading position to unload tips 

and select Reset from the 

Instrument menu. 

410: “Initialization halted. Either the upper 

or lower door is open. Please shut both 

doors and select RESET”. 

The door is open 

during instrument 

initialization/reset. 

Close the upper and lower 

doors and select Reset from 

the Instrument menu. 

411: “Front Panel Interrupt button was 

pushed while initializing. Initializing was not 

completed. Select Reset when ready to 

continue.” 

The front panel 

interrupt button was 

pushed, stopping 

instrument 

initialization. 

Select Reset from the 

Instrument menu. 

“Disconnected” is displayed in the bottom 

of the Instrument Status Window. 

ScreenWorks Software 

is in Offline Mode. 

Select Go Online from the 

Instrument drop-down 

menu. 

Multiple software 

copies are open. 

Close all versions of 

ScreenWorks Software 

before starting software. 

Instrument timed-out. Select Go Online from the 

Instrument drop-down 

menu. 

Instrument Configuration does not show 

desired components installed on 

instrument. 

Instrument does not 

have proper 

components installed. 

Install proper components 

and restart system. 

ScreenWorks Software 

is in Offline Mode. 

Select Go Online from the 

Instrument drop-down 

menu. 

“Camera Temp” not at -60 °C ± 2 °C (-76 °F 

±35.6 °F) for EMCCD camera or 

-20 °C ± 5 °C (-4 °F ±41 °F) for ICCD camera. 

Camera is not cooled 

down to temperature. 

Allow 10 minutes for camera 

temperature to cool. Make 

sure the chiller is working 

properly. 

Contact Technical Support. 

See Obtain Support. 
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Symptom or Error Message Possible Causes Solutions 

“Chamber Temp” not at desired 

temperature. 

Heated stage is not 

warming to desired 

temperature. 

Allow 15 minutes for the 

chamber to warm to the 

desired temperature. 

Contact Technical Support. 

See Obtain Support. 

Temperature control is 

not ON. 

Turn on heated stage by 

selecting Temperature 

Control ON from the 

Instrument > Manual 

Operation drop-down menu. 

Pipettor head is in the plate after the 

instrument initializes. 

Instrument did not 

initialize properly. 

Select Reset from the 

Instrument drop-down 

menu. 

Contact Technical Support. 

See Obtain Support. 

 

General Troubleshooting 
 

Symptom or Error Message   Possible Causes Solutions 

201: “Upper door open”. Upper door (outer) 

is not closed. 

Close outer (upper) door. 

202: “Both upper and 

lower doors open”. 

Both upper (outer) 

and lower doors are 

not closed. 

Close outer (upper) and lower doors. 

203: “Lower door open”. Lower door (outer) 

is not closed. 

Close lower door. 

204: “Read plate position 

empty”. 

No plate is present 

in the Read position. 

Place appropriate plate in the Read position. 

205: “Source 1 plate 

position empty”. 

No plate is present 

in the Source 1 

position. 

Place appropriate plate in the Source 1 position. 

206: “Source 2 plate 

position empty”. 

No plate is present 

in the Source 2 

position. 

Place appropriate plate in the Source 2 position. 

207: “Source 3 plate 

position empty”. 

No plate is present 

in the Source 

position. 

Place appropriate plate in the Source 3/Tip 

Loading position. 
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Symptom or Error Message   Possible Causes Solutions 

229: “Attempting to read a 

source only plate. Please 

assign a read plate to the 

read position, or if it is a 

read plate, go to TOOLS, 

PLATE LIBRARY and define 

the mask positions using the 

appropriate yellow plate.” 

The plate selected 

for the read position 

cannot be read 

because no mask 

has been identified. 

Convert from a source only to a read plate using 

the plate library. 

100: “Command not 

found.” 

Input command is 

not valid. See 

appended string on 

the error message 

for details. 

Contact Technical Support. See Obtain Support. 

101: “Invalid argument.” Input argument is 

not valid. See 

appended string on 

the error message 

for details. 

Contact Technical Support. See Obtain Support. 

102: “Invalid number of 

arguments.” 

Number of input 

arguments is not 

valid. See appended 

string on the error 

message for details. 

Contact Technical Support. See Obtain Support. 

103: “Invalid start of 

command.” 

Start of command is 

not valid. See 

appended string on 

the error message 

for details. 

Contact Technical Support. See Obtain Support. 

104: “Command invalid, 

system busy.” 

The system cannot 

act upon the 

command, as the 

system is busy. See 

appended string on 

the error message 

for details. 

Contact Technical Support. See Obtain Support. 

“Data buffer full”. The data buffer is 

full. See appended 

string on the error 

message for details. 

Contact Technical Support. See Obtain Support. 
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Symptom or Error Message   Possible Causes Solutions 

106: “Option not installed, 

command unavailable”. 

Pipettor head, LED, 

Emission Filter or 

TETRAcycler™ is not 

installed. 

Install option you want to use. 

Change protocol to use available instrument 

options. 

107: “Command failed”. General failure. Contact Technical Support. See Obtain Support. 

108: “Command failed, 

system in an error state". 

Minor 

communication 

error occurred. 

Select Clear Error command from Instrument 

drop-down menu. 

109: “Command failed, 

system not initialized “ 

Communication 

failed between 

software and 

instrument. 

Select Reset from the Instrument drop-down 

menu. 

Turn the instrument power switch OFF then ON 

to cycle power. 

“Password does not 

match”. 

User password is 

incorrect. 

Contact your instrument administrator for the 

appropriate user name and password. 

“Input not accepted”. Input value is not 

valid (e.g., select 

greater than 16 time 

sequence files  in 

the Export menu). 

See appended string 

on the error 

message for details. 

Change the input value so it is within the 

specified range. 

302: “Temperature system 

not functional. Please 

contact Technical Support. 

You will not be able to run 

protocols with temperature 

control until it is repaired.” 

Can’t read the 

temperature 

sensors for the 

heated stage. 

Select Reset command from the Instrument 

drop-down menu to reset instrument to see if 

communication can be reconnected. 

Contact Technical Support. See Obtain Support. 

 

Data files cannot be found  Use Windows’ Find utility to search for file 

names and determine where files were saved. 

Default location for ScreenWorks files is 

C:\Program Files\Molecular 

Devices\ScreenWorks\ Data. 

Hard drive fills up with data 

files. 

Files unnecessarily 

saved with *.tif file. 

Discard unwanted *.tif files. 

Data not archived. Clean off hard drive. 
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Symptom or Error Message   Possible Causes Solutions 

“Image” option in 

Experiment window is 

grayed out. 

Save images not 

selected in Read 

with TF process. 

Save subsequent data with Save images 

selected in protocol. 

*.tif files not found 

(deleted or moved) 

in data folder. 

*.tif files must be saved in same folder as data 

to retain Image button option. 

309: “Unable to modify or 

delete selected plate. It 

does not exist.” 

Plate does not exist. Contact Technical Support. See Obtain Support. 

401: “Input/Output PCB not 

functional. Please contact 

Technical Support. You will 

not be able to run protocols 

until it is repaired.” 

Input/Output PCB 

not functional. 

Contact Technical Support. See Obtain Support. 

402: “Motion reports a fatal 

error. Please select Reset. If 

this error repeats, please 

contact Technical Support.” 

Motion reports a 

fatal error. 

Contact Technical Support. See Obtain Support. 

403: “Motion timeout 

waiting for done. Please 

select Reset. If this error 

repeats, please contact 

Technical Support.” 

Instrument motion 

timed out prior to 

receiving “done” 

command from 

instrument. 

Select Reset from the Instrument menu. 

Contact Technical Support. See Obtain Support. 

404: “Motion timeout 

waiting for echo. Please 

select Reset. If this error 

repeats, please contact 

Technical Support.” 

Instrument motion 

timed out while 

waiting for an echo. 

Select Reset from the Instrument menu. 

Contact Technical Support. See Obtain Support. 

405: “Motion 

communication fault. 

Please select Reset. If this 

error repeats, please 

contact Technical Support.” 

Motion 

communication 

fault. 

Select Reset from the Instrument menu. 

Contact Technical Support. See Obtain Support. 

406: “Invalid DONE 

response from motion. 

Please select Reset. If this 

error repeats, please 

contact Technical Support.” 

Invalid DONE 

response from 

motion. 

Turn the instrument off. Wait 15 seconds. Turn 

instrument on. 

Contact Technical Support. See Obtain Support. 

407: “LCB read/write test 

failed. Please select Reset. If 

this error repeats, please 

contact Technical Support.” 

LCB read/write test 

failed. 

Select Reset from the Instrument menu. 

Contact Technical Support. See Obtain Support. 
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Symptom or Error Message   Possible Causes Solutions 

408: “Plate format file fault. 

Please contact Technical 

Support. You will be unable 

to use this plate until 

repaired.” 

Plate format file 

fault. 

Select Reset from the Instrument menu. 

Contact Technical Support. See Obtain Support. 

ScreenWorks indicates the 

user-defined name of the 

data file is invalid. 

Illegal characters 

were used in the file 

name. 

Eliminate illegal characters from userdefined 

name (for example, “ , ’ : ? ; ) . 

User-defined name 

includes too many 

characters. 

Use 25 characters or less in the user-defined 

name. 

Saturation detected. One or more wells 

in the microplate 

saturated the 

camera. 

A saturation warning in either the signal test 

dialog or on a plate will prevent you from 

reading the plate. It is at the discretion of the 

user to decide whether to address the 

saturation warning or proceed forward. If 

multiple wells within a plate are saturating the 

camera, decrease the Excitation Intensity, 

Exposure Time, or Camera Gain to prevent 

saturation. 

 

Troubleshooting the Pipettor 
 

Symptom or Error Possible Causes Solutions 

Message 

Cannot uninstall pipettor 

head. 

The D-Axis Knurled Nut is 

caught on the D-Axis 

receiver. 

Grasp the D-Axis Knurled Nut receiver and 

press downward to give the pipettor head 

additional clearance from the D-Axis 

Knurled Nut. 

Pipettor head is caught on 

the alignment pins. 

Lift the pipettor head up prior to moving 

left to lift the pipettor head off of the 

pipettor mount alignment pins. 

Cannot install pipettor 

head. 

The Head Clamp Knob is not 

tightening all the way 

down. 

Slide the pipettor head all the way to the 

right over the pipettor mount. When 

installed properly on the alignment pins, 

the pipettor head should not slide left 

without lifting. 

D-Axis Knurled Nut does 

not reach receiver threads. 

Lift D-axis receiver to engage threads and 

then tighten the D-Axis Knurled Nut. 
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Symptom or Error Possible Causes Solutions 

Message 

231: “Pipettor head not 

detected. Please verify 

proper installation and 

select Reset.” 

No pipettor head is present 

on pipettor mount. 

Install appropriate pipettor onto 

instrument. 

Pipettor head is not 

installed properly. 

Head clamp knob may not be secured 

tightly for instrument to identify pipettor 

head. Reinstall pipettor head. 

The open protocol may not 

use the pipettor on the 

instrument. 

Install appropriate pipettor onto 

instrument. 

Change plate format used in the software 

to match the pipettor head. 

208: “Unable to load tips. 

Tips are already on 

pipettor.” 

Tips are already present on 

pipettor. 

If you would like to change tips, select 

Unload Tips from the Instrument > 

Manual Operation drop-down menu. 

Once tips are exchanged, select Load Tips 

from the same drop-down menu. 

If want to keep the present tips on, clear 

error and proceed with your experiment. 

209: “Unable to unload 

tips. There are no tips 

loaded on the pipettor.” 

No tips are present on the 

pipettor head. 

Clear error. 

233: Unable to dispense. 

No tips loaded on 

pipettor.” 

No tips are present on the 

pipettor head. 

Load tips manually on the pipettor head 

using the Load Tips command which is 

found in the Instrument > Manual 

Operation drop-down menu. 

Change protocol to include loading of tips 

at the beginning of the experiment. 

234: “Unable to aspirate. 

No tips loaded on 

pipettor.” 

No tips are present on the 

pipettor head. 

Load tips manually on the pipettor head 

using the Load Tips command which is 

found in the Instrument > Manual 

Operation drop-down menu. 

Change protocol to include loading of tips 

at the beginning of the experiment 

235: “Unable to place tips 

in well. No tips loaded on 

pipettor.” 

No tips are present on the 

pipettor head. 

Load tips manually on the pipettor head 

using the Load Tips command which is 

found in the Instrument > Manual 

Operation drop-down menu. 

Change protocol to include loading of tips 

at the beginning of the experiment 
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Symptom or Error Possible Causes Solutions 

Message 

236: “Unable to mix. No 

tips loaded on pipettor.” 

No tips are present on the 

pipettor head. 

Load tips manually on the pipettor head 

using the Load Tips command which is 

found in the Instrument > Manual 

Operation drop-down menu. 

Change protocol to include loading of tips 

at the beginning of the experiment 

237: “Unable to wash. No 

tips loaded on pipettor.” 

No tips are present on the 

pipettor head. 

Load tips manually on the pipettor head 

using the Load Tips command which is 

found in the Instrument > Manual 

Operation drop-down menu. 

Change protocol to include loading of tips 

at the beginning of the experiment 

246: “Unable to change 

head. Please unload tips 

and select Change Head 

again.” 

“Change Head” action 

cannot be performed 

unless tips are removed. 

Unload tips manually from the pipettor 

head using the Unload Tips command 

which is found in the Instrument > 

Manual Operation drop-down menu. 

Some tips are left in the 

tip rack after loading the 

tips. 

Pipettor calibration failure. Contact Technical Support. See Obtain 

Support. 

Some tips are left on the 

pipettor after unloading. 

Pipettor calibration failure. Contact Technical Support. See Obtain 

Support. 

The tip rack is attached to 

the tips. 

Tip box failure. Remove tip box from tips. Choose 

Instrument > Manual Operation > Unload 

Tips to unload tips to tip loading position. 

Contact Technical Support. See Obtain 

Support. 

242: “The selected read 

plate has fewer wells than 

the pipettor head. Please 

select a plate with a 

matching format.” 

The pipettor head and read 

plate format is 

incompatible (e.g., 1536 

pipettor head with 96-well 

plate). 

Load the appropriate pipettor head type. 

Change protocol to include read plate 

format that is compatible with pipettor 

head. 

243: “The  selected 

source 1 plate has fewer 

wells than the pipettor 

head. Please select a plate 

with a matching format.” 

The pipettor head and 

Source 1 plate format is 

incompatible (e.g., 1536 

pipettor head with 96-well 

plate). 

Load the appropriate pipettor head type. 

Change protocol to include Source 1 plate 

format that is compatible with pipettor 

head. 
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Symptom or Error Possible Causes Solutions 

Message 

244: “The  selected 

source 2 plate has fewer 

wells than the pipettor 

head. Please select a plate 

with a matching format.” 

The pipettor head and 

Source 2 plate format is 

incompatible (e.g., 1536 

pipettor head with 96-well 

plate). 

Load the appropriate pipettor head type. 

Change protocol to include Source 2 plate 

format that is compatible with pipettor 

head. 

245: “The  selected 

source 3 plate has fewer 

wells than the pipettor 

head. Please select a plate 

with a matching format.” 

The pipettor head and 

Source 3 plate format is 

incompatible (e.g., 1536 

pipettor head with 96-well 

plate). 

Load the appropriate pipettor head type. 

Change protocol to include Source 3 plate 

format that is compatible with pipettor 

head. 

“Volume is too large.” Volume is too large for the 

pipettor head or plate 

format you are using. See 

appended string on the 

error message for details. 

Reduce the volume that you are 

aspirating/dispensing so it is within the 

specified range. 

“Volume is too small.” Volume is too small for the 

pipettor head or plate 

format you are using. See 

appended string on the 

error message for details. 

Increase the volume that you are 

aspirating/dispensing so it is within the 

specified range. 

“Speed is too large.” Speed is too large for the 

pipettor head or plate 

format you are using. See 

appended string on the 

error message for details. 

Reduce the speed that you are 

aspirating/dispensing so it is within the 

specified range. 

“Speed is too small.” Speed is too small for the 

pipettor head or plate 

format you are using. See 

appended string on the 

error message for details. 

Increase the speed that you are 

aspirating/dispensing so it is within the 

specified range. 

“Height is too large.” Height is too large for the 

pipettor head or plate 

format you are using. See 

appended string on the 

error message for details. 

Reduce the height that you are 

aspirating/dispensing so it is within the 

specified range. 

“Height is too small.” Height is too small for the 

pipettor head or plate 

format you are using. See 

appended string on the 

error message for details. 

Increase the height that you are 

aspirating/dispensing so it is within the 

specified range. 
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Symptom or Error Possible Causes Solutions 

Message 

“Done with plate after 

aspiration” is not present. 

TETRAcycler is not present 

on instrument. 

Must install TETRAcycler on instrument for 

command to be available. 

“Done with plate after 

dispense” is not present. 

TETRAcycler is not present 

on instrument. 

Must install TETRAcycler on instrument for 

command to be available. 

Dialog does not appear 

because you are dispensing 

to the Read plate position. 

Read plate is automatically changed at the 

end of an experiment when in Remote 

Mode. 

“Mix Fluid After 

Dispense” is not present. 

Command is not available 

when “Single aspirate – 

Multiple dispense” fluid 

transfer type is selected. 

Select either Single aspirate – Single 

dispense or Multiple aspirate – Single 

dispense fluid transfer types. 

 

Troubleshooting the Optics 
 

Symptom or Error Message Possible Causes Solutions 

240: “Attempting to use a LED 

module that is not installed. Please 

install the desired LED banks.” 

Specified LED module in protocol is 

not installed. 

Install the appropriate 

LED banks. 

Select the appropriate 

LED module that is 

already installed on the 

instrument. 

241: “Attempting to use an 

emission filter that is not installed. 

Please install the desired emission 

filter.” 

Specified emission filter in the 

protocol is not installed. 

Install the appropriate 

emission filter. 

Select the appropriate 

emission filter that is 

already installed on the 

instrument. 

210: “Unable to read plate. 

Calibration not valid for 

emission/excitation pair.” 

A calibration file is not available for 

the LED/emission filter combination 

selected. 

Calibrate instrument 

for desired 

LED/emission filter 

pair. 

214: “The 2 upper LED banks are 

not identical wavelengths. Please 

install identical wavelengths to both 

upper positions.” 

The upper pair of LED banks has 

mismatched LED module 

wavelengths. 

Make sure LEDs of the 

same wavelength are 

located in the upper 

LED bank position on 

either side of the read 

plate. 
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Symptom or Error Message Possible Causes Solutions 

215: “The 2 lower LED banks are 

not identical wavelengths. Please 

install identical wavelengths to both 

lower positions.” 

The lower pair of LED banks has 

mismatched LED module 

wavelengths. 

Make sure LEDs of the 

same wavelength are 

located in the lower 

LED bank position on 

either side of the read 

plate. 

217: “One or more LED banks not 

detected. Please verify all four 

banks firmly installed.” 

Cannot detect one of the LED 

modules. 

Make sure LED module 

is properly connected. 

Contact Technical 

Support. See Obtain 

Support. 

216: “LED module 

configuration/position has changes. 

Please recalibrate.” 

LED module position changed from 

where it was flat-field calibrated. 

Calibrate instrument 

for current LED 

configuration. 

Place LEDs in previous 

calibrated position. 

303: “LED modules not calibrated.” None of the installed LED banks have 

been flat-field calibrated. 

Calibrate instrument 

with installed LED 

banks. 

A LED inside the LED bank burned 

out. 

Calibrate instrument 

with installed LED 

banks. 

Replace LED bank if 

you are unable to 

recalibrate LED bank. 

Contact Technical 

Support. See Obtain 

Support. 

306: “Flat field calibration failed. 

Please verify that the correct plate 

is loaded. Please repeat flat field 

calibration.” 

Flat Field calibration failed; see 

appended string on the error 

message for details. 

Calibrate using the 

correct Flat Field 

calibration plate in the 

Read position. 

Contact Technical 

Support. See Obtain 

Support. 
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Symptom or Error Message Possible Causes Solutions 

218: “Unable to define plate mask. 

Please install 515–575 nm emission 

filter.” 

The 515–575 nm emission filter is 

not installed. Thus, mask alignment 

cannot be performed. 

Install the 515–575 nm 

emission filter to 

match the calibration 

file. 

Calibrate instrument 

with new emission 

filter. 

219: “Unable to define plate mask. 

Please install 470–495 nm LED 

banks.” 

The 470–495 LED banks are not 

installed. Thus, mask alignment 

cannot be performed. 

Install the 470–495 nm 

LED banks to match 

the calibration file. 

Calibrate instrument 

with new LED bank. 

307: “Unable to complete plate 

mask definition. Incorrect number 

of wells found. Please verify that 

the correct plate is loaded and 

repeat.” 

Mask alignment failed because it 

didn’t find the correct number of 

wells (e.g., must find 384 wells for a 

384 well plate). 

Correct read plate 

format must be in Read 

position. 

308: “Unable to complete plate 

mask definition. Found overlapping 

wells. Please contact Technical 

Support. You will not be able to run 

protocols using this plate until the 

instrument is repaired.” 

Plate is tilted/popped out of position. Make sure read plate is 

properly aligned in 

Read position. 

310: “Unable to perform gain 

curve. Please insert 515–575 nm 

emission filter.” 

515–575 nm emission filter is not 

installed on system. 

Install the 515–575 nm 

emission filter prior to 

performing gain curve. 

Contact Technical 

Support. See Obtain 

Support. 

311: “Unable to perform gain 

curve. Please insert 470–495 nm 

LED banks.” 

470–495 nm LED banks are not 

installed on system. 

Install the 470–495 nm 

LED banks prior to 

performing gain curve. 

Contact Technical 

Support. See Obtain 

Support. 

304: “Gain calibration failed. Please 

contact Technical Support.” 

 Contact Technical 

Support. See Obtain 

Support. 
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Symptom or Error Message Possible Causes Solutions 

Excitation/Emission wavelength is 

not available in the “edit read 

mode” dialog. 

Instrument was not calibrated for the 

excitation/emission pair for which 

you are looking. 

Calibrate instrument 

for the 

Excitation/Emission 

pair for which you are 

looking. 

“Exposure time is too large.” The exposure time for the camera is 

too large. See appended string on the 

error message for details. 

Decrease the exposure 

time so it is within the 

specified range. 

“Exposure time is too small.” The exposure time for the camera is 

too small. See appended string on 

the error message for details. 

Increase the exposure 

time so it is within the 

specified range. 

200: “Read interval too short.” Read interval is shorter than the sum 

of exposure lengths for each read 

interval in addition to the camera 

processing time. 

Set a longer read 

interval. 

“First interval is too small.” The time for the first interval is too 

short. Interval time must always be 

longer than the sum of all selected 

read modes plus the computer 

processing time. See appended string 

on the error message for details. 

Increase the read 

interval so it is within 

the specified range. 

“First interval is too large.” The time for the first interval is too 

large. See appended string on the 

error message for details. 

Decrease the read 

interval so it is within 

the specified range. 

“First interval number of reads is 

too large.” 

The number of reads in the first 

interval is too large. See appended 

string on the error message for 

details. 

Decrease the number 

of reads so it is within 

the specified range. 

“Number of reads before dispense 

are too large.” 

Number of reads prior to dispense 

are larger than the number of reads 

in the first interval. See appended 

string on the error message for 

details. 

Decrease the number 

of reads before 

dispense so it is within 

the specified range. 

238: “Protocol requests greater 

than 800 reads. This is not 

permitted.” 

Sum of all reads for all read actions 

and configurations must not exceed 

800. 

Reduce the number of 

reads in the 

experiment to less 

than 800 for all 

combined read modes. 
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Symptom or Error Message Possible Causes Solutions 

239: “Protocol requests greater 

than 50 images. This is not 

permitted.” 

Sum of all raw images for all read 

actions and configurations must not 

exceed 50. 

Reduce the number of 

raw images in the 

experiment to less 

than 50 for all 

combined dispenses. 

400: “Camera is not functional. 

Please contact Technical Support. 

You will not be able to run 

protocols until it is repaired.” 

Camera is not functional. Contact Technical 

Support. See Obtain 

Support. 

 

Troubleshooting the Yellow Plate 
 

Symptom or Error Message Possible Causes Solutions 

“Saturation detected, data may be 

invalid.” 

Incorrect settings. Set excitation intensity to 80%, exposure 

length to 0.1 s and for EMCCD gain to 80, 

for ICCD gate to 3%. If condition repeats, 

lower excitation intensity. 

Incorrect LED 

and/or emission 

filter choice. 

Check to make sure the appropriate LED 

and emission filters are selected. 

Emission optics 

are dirty. 

Make sure no dust is on emission filters. 

Bottom of Read 

plate is dirty. 

Make sure no dust or fluorescent 

compounds are on the bottom of the Read 

plate. 

Wells are cut off in Image Viewer. Plate not properly 

placed in Read 

position 

Make sure plate is properly placed and 

indexed in the Read position. 

Dirty/misaligned 

optics. 

Contact Technical Support. See Obtain 

Support. 

Fluorescence counts are 0. LED power is off. Increase excitation intensity of LEDs. 

Make sure Excitation/Emission 

Wavelength in the read mode does not 

have NONE for the excitation wavelength. 

Camera failure. Contact Technical Support. See Obtain 

Support. 

Signal test was not 

initiated. 

Select Test Signal in the Signal Test dialog 

box. 
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Symptom or Error Message Possible Causes Solutions 

Standard deviation for the signal 

test is greater than 5% and 

fluorescence counts may or may 

not be in the correct range. 

Instrument was 

calibrated with 

yellow boat. 

If instrument was calibrated using the 

yellow boat, the standard deviation can be 

5% or less. 

Camera not fully 

cooled down. 

Wait approximately 10 minutes for the 

camera temperature to cool down. 

Optical correction 

out of 

specifications 

Perform Flat-Field calibration. 

Plate is not 

aligned properly 

in Read position. 

Make sure plate is properly aligned and 

indexed in the Read position. 

Optics is dirty or 

failing. 

Contact Technical Support. See Obtain 

Support. 

Calibration plate 

failure— plate is 

dirty or scratched. 

Clean calibration plate with lens paper. DO 

NOT use lab wipes. If cleaning does not 

work, replace the calibration plate. 

 

Troubleshooting the Tip Washer 
 

Symptom or Error Message Possible Causes Solutions 

221: “Tip wash reservoir format 

(96/384/1536) does not match 

pipettor head. Please install 

matching reservoir and select 

Reset.” 

Pipettor head and tip 

washer reservoir top do not 

match (e.g., a 384 Pipettor 

head with a 96-well 

reservoir top). 

Install appropriate pipettor head 

to match tip wash reservoir top. 

Install appropriate tip wash 

reservoir top to match pipettor 

head. 

222: “Tip wash reservoir top not 

detected. Please install matching 

reservoir and select Reset.” 

No reservoir top is installed. Install appropriate tip wash 

reservoir top. 

Tip wash reservoir top is 

not properly installed. 

Tip wash reservoir top 

connectors may not be properly 

connected. 

223: “Check Waste Bottle A - 

sensor indicates full.” 

Waste bottle A is full with 

tip wash solvent. 

Empty tip wash solvent from 

waste bottle A. 

224: "Check Waste Bottle B - sensor 

indicates full." 

Waste bottle B is full with 

tip wash solvent. 

Empty tip wash solvent from 

waste bottle B. 

225: "Check TipWasher - sensor 

indicates overflow." 

Waste bottles are full. Empty tip wash solvent from 

waste bottles A and B and select 

Reset. 

Fluid level sensor 

malfunction. 

Contact Technical Support. See 

Obtain Support. 



Chapter 9: Troubleshooting 

0112-0109 K 185 

 

 

 
 

Symptom or Error Message Possible Causes Solutions 

226: "TipWasher: Check Wash Fluid 

Bottle A - fill sensor dry." 

Fill Bottle A is empty. Place tip wash solvent into Fill 

Bottle A. 

227: "TipWasher: Check Wash Fluid 

Bottle B - fill sensor dry." 

Fill Bottle B is empty. Place tip wash solvent into Fill 

Bottle B. 

250: "TipWasher: Check Wash fluid. 

Fill sensor dry during fill after 

prime." 

The selected wash bottle 

might be running low on 

fluid. 

Check the wash bottles. 

251: "TipWasher: Check Wash fluid. 

Fill sensor dry after fill." 

The selected wash bottle 

might be running low on 

fluid. 

Check the wash bottles. 

252: "TipWasher: Check Wash Fluid 

Bottles A and B - sensor indicates 

empty." 

Both of the wash bottles are 

detected empty. 

Add fluid to both wash bottles. 

254: "TipWasher: Check tubing at 

Fill Pump - fill sensor wet after 

draining line." 

Fluid sensor is detecting 

fluid when it should not. 

Check for any unconnected 

tubing. Contact Technical 

Support. See Obtain Support. 

301: “Tip wash module not 

functional. Please contact Technical 

Support. You will not be able to run 

protocols with tip washing until it is 

repaired.” 

Can’t communicate with 

the Tip Washer. 

Select Reset command from the 

Instrument drop-down menu to 

reset instrument to see if 

communication can be 

reconnected. 

 

Troubleshooting the Cell Reservoir 
 

Symptom or Error Message Possible Causes Solutions 

255 “CellReservoir: Reservoir not detected. 

Please install it at Source 3 position and select 

Refresh Configuration from Instrument menu 

bar.” 

Instrument cannot 

detect the cell 

reservoir. 

Check to make sure the 

Cell Reservoir is 

installed. 

Check the connection of 

the reservoir sensor 

inside the instrument. 

256 “CellReservoir: prime sensor dry during 

prime/fill. Please check Fluid Bottle 1”. 

Fluid sensor is not 

detecting fluid when 

pumping from Fluid 1. 

Check to make sure that 

Fluid 1 bottle is not 

empty. 

257 “CellReservoir: prime sensor dry during 

prime/fill. Please check Fluid Bottle 2”. 

Fluid sensor is not 

detecting fluid when 

pumping from Fluid 2. 

Check to make sure that 

Fluid 2 bottle is not 

empty. 

258 “CellReservoir: prime sensor dry during 

prime/fill. Please check Fluid Bottle 3”. 

Fluid sensor is not 

detecting fluid when 

pumping from Fluid 3. 

Check to make sure that 

Fluid 3 bottle is not 

empty. 
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Symptom or Error Message Possible Causes Solutions 

259 “CellReservoir: prime sensor dry during 

prime/fill. Please check Fluid Bottle 4”. 

Fluid sensor is not 

detecting fluid when 

pumping from Fluid 4. 

Check to make sure that 

Fluid 4 bottle is not 

empty. 

 

Troubleshooting Data 
 

Symptom or Error Message Possible Causes Solutions 

Negative control wells show a 

response. 

Wash buffer 

components are 

different from the 

compound buffer. 

Make sure wash buffer and 

compound buffer are the same. 

Check for a DMSO stimulation, if 

present. 

Statistical results do not conform to the 

expected results. 

Data analysis has not 

been optimally set up. 

Refer to Data Processing 

Algorithms on page 237. 

Data parameters need to be reset 

(subtract bias, spatial uniformity 

correction, positive control, etc.) for 

each experiment. 

*.vamp file 

parameters not set up 

correctly. 

Select the Grouping or Correction 

buttons to adjust the parameters 

as necessary. 

False negative wells. Pipettor adjustment 

problem. 

See Optimizing an Assay on page 

166. 

Tip problem. Contact Technical Support. See 

Obtain Support. 

Troubleshooting Robotic Integration 
 

Symptom or Error 

Message 

Possible Causes Solutions 

220: “Unable to load Plate present on plate Contact Technical Support. See Obtain 

plate. No plate on landing landing pad, but plate Support. 

pad.” presence was not 

detected. 

 

If plate not positioned properly by robot, 

contact Technical Support for robot 

  manufacturer. 

 No plate was delivered Contact Technical Support for robot 

 to landing pad by 3rd manufacturer. 

 party robot.  

221: “Unable to load Plate already at Unload plate currently in the desired position 

plate. Plate already requested position. prior to delivering new plate. 

detected at requested 

location.” 

 
 

If robot is attempting to load multiple plates 

to one position without retrieving plates, 

  contact Technical Support for robot 

  manufacturer. 
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Symptom or Error Possible Causes Solutions 

Message 

222: “Unable to unload 

plate. Plate already 

detected at landing pad 

Plate already present on 

landing pad. 

Remove plate on landing pad prior to 

unloading a new plate. 

223: “Unable to unload 

plate. No plate detected 

at requested position.” 

No plate present in 

position. 

Clear error and proceed with experiment. 

Plate may have popped 

out of position. 

Clear plate that is out of position prior to 

resuming experiment. 

Bar code reader misreads 

the bar code and file 

name reads “Bad_bar_ 

code”. 

Misplacement of bar 

code or incorrect type of 

bar code. 

Bar code must be on the side of the plate 

where the bar code is reading. Place label as 

low as possible. Use labels with numbers on 

top. 
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Appendix A: Robotic Integration 
 
 

This document describes the interface between a FLIPR Tetra system and a robotic 

instrument. The intention of the document is to provide a general overview of the interface 

between the instrument and robot and a detailed description of the communication 

protocol between the ScreenWorks Software, which will run on the host computer of the 

FLIPR Tetra system instrument, and the robotic control software. 

Information contained in this document might change as new development occurs—we 

recommend checking with your Molecular Devices sales representative for updated 

information. 
 

Conventions 
 

Bold text is used for commands 

Italic text is used for parameters 

Parameters in bracket [parameter1] are optional 

Parameters are separated by comma 

<CR> is the ACSII code for ‘carriage return’ which indicates end of the command or end 

of the response 

<TAB> represents a tab 

<SP> represents a space 

| represents OR 
 

Interface Versioning 

As of version 1.1 of the automation interface, the interface is versioned separately from the 

ScreenWorks Software and FLIPR Tetra system firmware. The interface now provides a 

command so it can be queried for its version number. This command is described in detail 

later in this document. 

A 
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Instrument Overview 

Basic Function 

FLIPR Tetra system is a fluorescence microplate reader used primarily for kinetic live cell- 

based fluorescence and luminescence assays. A typical assay involves the following steps: 

Introduction of a read plate containing cells in solution or compounds into the 

instrument. 

Acquisition of a baseline read (or series of reads) to determine the background 

fluorescence or luminescence signal from the read plate. 

Introduction of a potentially activating (or potentially inactivating) compound into the 

well or cells in suspension. 

Monitoring the changes in the fluorescence or luminescence signal from the read plate 

for a period of time immediately following the introduction of the compound. 

Further additions of different compounds to the well are typical in an assay on a  

FLIPR Tetra system. Between additions, the pipette tips used for fluid transfer may be 

replaced or washed. 

Cell response in a typical assay typically begins within 2 seconds of fluid addition and is 

monitored for 1–3 minutes. Fluorescence or luminescence signals are monitored at 

wavelengths and frequencies selected by the user within the physical constraints of the 

instrument. 

Hardware Introduction 

To accomplish the assays described, the instrument includes the following subsystems: 

Embedded control system — The instrument contains an embedded control system for 

use in controlling the instrument. This control system is accessed only by the 

ScreenWorks Software, which is supplied with the instrument. 

Plate reader — The optics subsystem includes an illumination source with excitation 

filters, emissions filters in a three-position filter changer, and a CCD camera. This system 

is used to read both fluorescence and luminescence assays. 

Pipettor — In order to accomplish kinetic assays, the instrument contains a pipettor 

which can add fluids to the read plate during a series of reads. The pipettor, equipped 

with a 96-, 384-, or 1536-well head, can be used for general purpose fluid transfer 

between any of the plates in the instrument. Each head type uses pipette tips, or a pin 

tools. For 96- and 384-well pipettor heads, this is a disposable plastic pipette tip. For 1536 

this is a metal tip block. Alternatively, 384- and 1536-well pin tool heads have replaceable 

pin tools. 
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Tip and pin washer — Each instrument includes a washer which can be used to wash tips 

or pins between fluid transfers. The washer consists of two parts—a washer control 

module and a wash reservoir. Installed on the right side of the instrument, the sensors, 

and control valves. These components connect to the wash reservoir located in position 

5 of the system stage. 

FLIPR TetraCycler Plate Handler — An optional plate handler is available that is capable of 

moving plates from a location outside of the instrument to any of the first four stage 

positions and vice versa. The second component of the FLIPR TetraCycler Plate Handler 

is an automated door system that allows plates to be exchanged while an assay is in 

progress. 

Layout 

The basic layout of the instrument subsystems is demonstrated in the following illustration: 
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As the illustration indicates, the top instrument compartment contains the pipettor and 

plate platform (stage). Plates are placed in the read position of the 5-position platform in 

order to be read by the plate reader, which is located in the optics compartment below the 

platform. 

Plate Layout 

The stage has 4 positions where plates and/or tips may be placed. These may be: 

Position 1: Source Plate 1 or Tip-loading 

Position 2: Source Plate 2 

Position 3: Read Plate 

Position 4: Source Plate 3 or Cell Reservoir 

A tip wash reservoir for tips or pins is available in position 5. 
 

 
 

Users may place either tip racks or plates in the tip-loading position (position 1) and Cell 

Reservoir or plates in Cell Reservoir position (position 4). The wash reservoir is not disposable 

but is replaced by users when the head type is changed. 
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Plate-Handling System 

Users may manually place plates or tip racks in the instrument or deliver them automatically 

using a robot or stacker. 

In manual mode, users access the plate stage through a large, manually operated door. This 

door opens on a vertical hinge, mounted to the left side of the door. An observation panel is 

built into this door and may be removed by users to attach to the top instrument 

compartment. In this arrangement, users may observe assays in progress (data quality will 

be poor or simulated) in order to debug assay setup issues. 

At the start of an assay, the door latches to prevent users from accidentally interrupting an 

assay in progress or injuring themselves. The door also latches for most other instrument 

actions not associated with an assay, for example, load tips, unload tips, and signal test. This 

latch remains engaged throughout the assay or operation. In manual mode, this latch 

automatically disengages at the end of the assay. 

For robotic integration, plates are delivered to a single location outside of the instrument. 

The placement area for robotic delivery of plates to the instrument is to the left of the 

instrument. The locations for manual and robotic access to the instrument are shown below: 

A further illustration of this arrangement shows the relation of the plate handler to the 

pipettor system. 

Terminology 

The manual access door side of the instrument is called the front of the instrument. From 

this, the following illustrates the named sides of the instrument: 
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Robotic Plate Loading 

Plates are shuttled into the instrument by a plate handling subsystem called the FLIPR 

TetraCycler Plate Handler. To lessen dead time between assays and to handle more source 

plates in an assay than can be accommodated on the plate stage, the robotic access door(s) 

and FLIPR TetraCycler Plate Handler are able to exchange plates and tips while an assay is 

running. 

The following diagram illustrates the steps involved in loading plates in robotic mode: 
 

A reverse process is used when unloading plates in remote mode. 

Optics Access Door 

The plate reader optics are mounted to the plate stage directly below the read plate position. 

A door is provided to the optics compartment for users to change emission filters and LED 

modules. This door is also latched when an assay is in progress to prevent users from 

interrupting assays or injuring themselves. 
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Washer Placement 

A tip/pin washer is included with the system and is placed on the lower right side of the 

instrument, towards the front. Extensive work has been done to isolate plumbing for the 

washer from other optical or power components. Access for tubing to the washer is required 

in any installation. 

Cell Suspension Placement 

The Cell Suspension module option is available for the FLIPR Tetra system. When installed, 

the Cell Suspension module is mounted on the lower right side of the instrument and the 

Cell Reservoir is inside of the instrument. Access to the module is necessary during testing. 

Other Instrument Access Areas 

The following diagram illustrates other important access areas in the instrument. 
 

On the right rear of the instrument, AC power enters. Directly above this entry is the main 

power switch. The power switch should be accessible in both robotic and manual modes. 

There are three indicator lamps near the power switch. Access to view these indicators can 

be useful for debugging instrument power problems. The main communication connection 

from the instrument to the host computer is located immediately above these power 

indicators. 

The instrument status panel, located next to the upper door handle, indicates whether or 

not the instrument is running and safe to open. It includes an emergency Interrupt button 

to stop any processes. 
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The panel has two lights as well as the Interrupt button. From the top of the panel these are: 

Assay Running (Locked)—Yellow light 

The FLIPR Tetra system is performing a task. The upper and lower doors are locked and 
cannot be opened until the task finishes or is halted using the Interrupt button. 

Assay Finished (Unlocked)—Green light 

No tasks are being run and it is safe to open the upper and lower instrument doors. 

The Interrupt button is an override button to halt all tasks, so you can access the 

instrument. If pressed the yellow light flashes until the system has reached a safe state to 

open the doors, then the green light comes on. 
 

CAUTION! The Interrupt button immediately ends the experiment and should only be 

used in emergencies. Interrupting the instrument while an assay in progress will 

almost always result in the loss of the plate being run. If this button is pressed, the 

yellow ‘busy’ light will flash until the instrument is safely unlatched. The system may 

need to be reinitialized by selecting Reset from the Instrument menu prior to 

resuming normal instrument function. 
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Monitor and Keyboard Placement 

The host computer provided with FLIPR Tetra system is mounted to the instrument’s right 

side. This computer provides the only direct user interface and path to control the 

instrument. Monitor and keyboard for this computer are mounted to an adjustable arm on 

the instrument’s front right. The following image illustrates this installation. 

The host computer, keyboard, and monitor may be moved to a different location at the 

user’s discretion. Wherever the host computer is placed, it must be directly connected to the 

instrument. It is not possible to communicate between the host computer running the 

ScreenWorks Software and the instrument across a network. A short communication cable is 

provided between the computer and instrument. In order to move the computer, the user 

may need to provide an alternate cable. This cable must be a shielded crossover Category 5 

cable. 

Required Access Areas 

The all inclusive system dimensions (with the FLIPR TetraCycler Plate Handler and Cell 

Suspension module) are approximately 53 inches (1346 mm) wide by 29 inches (737 mm) 

deep by 70 inches (1787 mm) tall. The FLIPR Tetra system is designed with rolling castors so it 

can be readily moved to make necessary adjustments and perform maintenance. Leveling 

feet are also installed on the lower instrument chassis. These feet are typically used for 

stabilizing the instrument when integrated with a robot, but can also be used to establish a 

uniform instrument deck level in situations where the lab floor is not flat. When running an 

experiment, please make sure the instrument’s feet are lowered and leveled. 

The computer and monitor are mounted to the right front side of the instrument with the 

included clamp, requiring a minimum lab space of 85 inches (2159 mm) wide by 61 inches 

(1549 mm) deep for maneuverability. A minimum 28 inch (711 mm) square footprint for tip 

wash bottles and chiller is required to the right side of the instrument. This space is also 

recommended to allow access to the main power-switch, washer tubing and communication 

connections. 
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The cabinet should have a user access space of 48 inches (1219 mm) in front for users to 

exchange tips, plates and reservoirs. An additional 24 inches (610 mm) behind and 10 inches 

(254 mm) to the left should be left available for servicing the instrument. 
 

adequate personnel are present when installing or moving the system. Follow all 
necessary safety precautions and use proper moving techniques. 

The following drawings illustrate these requirements: 
 

WARNING! The FLIPR Tetra systemcan weigh as much as 860 lbs (390 kg). Ensure 
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FLIPR Tetra System Control Architecture 

General Description 

The FLIPR Tetra system consists of a host computer and a stand-alone instrument. 

ScreenWorks Software is installed on the host computer supplied with the instrument. This 

software is the primary user interface. ScreenWorks Software is used to setup protocols, run 

assays, analyze and export data. ScreenWorks Software communicates to the standalone 

instrument with a dedicated connection using a communication protocol proprietary to 

Molecular Devices. The status of the instrument and assay is monitored by ScreenWorks 

Software, which then displays data as it is collected. 

A stand-alone instrument has all the hardware and firmware components required to 

perform an assay and report the results. It does not have the ability to display the results of 

experiments directly to a user. The user may not directly communicate with the stand-alone 

instrument in order to obtain data or to configure and run assays. 

The host computer supplied with the FLIPR Tetra system is configured with two Network 

Interface Cards (NICs). The first NIC is used to communicate with the instrument using a fixed 

IP address - this connection cannot be used for any other purpose. The second NIC is 

provided to connect the host to the Local Area Network (LAN) or to other devices (for 

example, router, hub, scheduling workstation). 

ScreenWorks Software and the instrument have two operating modes. The first of these is 

Manual mode. The second mode is Remote mode. ScreenWorks Software must be placed in 

Remote Mode in order to be controlled externally by third-party software via the 

automation interface. 

Manual Mode 

By default, the instrument starts in Manual mode. 

In Manual mode, configure assays in ScreenWorks Software and manually load plates and 

tips into the instrument. The following simple diagram illustrates this interaction: 
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In Manual mode, a second network connection on the host computer is not monitored. It is 

provided primarily to connect to your network to transfer data from the FLIPR Tetra system 

host computer for storage or analysis elsewhere. 

Remote Mode 

By transitioning into Remote Mode, ScreenWorks Software can be configured to 

communicate with external devices such as robots and stackers supplied by third parties. 

These devices can be used to supply plates and tips to the FLIPR Tetra system instrument. 

When in remote mode, third-party software is given full control over the internal plate 

handler, FLIPR TetraCycler Plate Handler. The FLIPR Tetra system software does not initiate 

any plate handling events. The general philosophy here is to put the third party software in 

charge and provide status information to allow it to make decisions on when the 

FLIPR Tetra system should load or unload plates and start assays. Third-party software 

monitors the assay through the ScreenWorks Software automation interface and provides 

additional plates and tips to the instrument as needed. External devices might not 

communicate directly with the FLIPR Tetra system instrument but only with the automation 

interface. 

Interact with the third-party software to select a protocol or preload the protocol in 

ScreenWorks Software before entering remote mode. The automation interface does not 

provide the functionality to create assay protocols. Interact with ScreenWorks Software 

while assays are running remotely to QA data and monitor progress. 

The control system to communicate between ScreenWorks Software and robotic controller 

can be configured in several ways. The following illustrations are provided to illustrate the 

range of options available. These examples are not exhaustive. 
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Third-Party Software via Network 
 

 

Third-Party Software on FLIPR Tetra system Host Computer 
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Direct Connection From Third-Party Software Host to FLIPR Tetra system host 
 

 

Communication Protocol and Address 

Communication between third-party software and ScreenWorks Software uses the TCP/IP 

protocol. The third-party software can be resident on another computer outside of the 

FLIPR Tetra system or on the instrument host computer. 

If the third-party software is remote to the host computer, the ScreenWorks Software 

receives communication through the IP address of the host computer on which it is running. 

If the third-party software is run on the instrument host computer, the ScreenWorks 

Software receives communication through IP address 127.0.0.1 (localhost). 

In all cases, ScreenWorks Software sends and receives commands through TCP/IP port 7. 

General Remote Mode Use 

This section provides a brief overview of running a FLIPR Tetra system in remote mode. Later 

sections describe some detailed issues in more detail. This section will provide some context 

for the introduction of the interface command set in the following section. 
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Instrument Startup 

When the instrument is powered on, it performs a series of initialization steps which may 

take several minutes. These steps include: 

Configuring the camera 

Initializing the pipettor 

Initializing the plate handler and automatic door (if included) 

Determining and checking the installed LEDs 

Determining the installed emission filters 

Initializing the tip washer 

Communicating with the chiller 

By default, the instrument is in manual mode upon startup. In this mode, the main manual 
access door is unlocked, the outer automated door is closed, and the FLIPR TetraCycler Plate 

Handler is moved outside the instrument, above the automation landing pad. As long as the 

instrument is in manual mode, the outer automated door and plate handler do not move 

from these positions, except during an instrument reset. 

Software Startup 

To use the instrument, the host computer must be started and ScreenWorks Software must 

be run. ScreenWorks Software establishes communication with the instrument and 

determine the instrument status and configuration. The instrument status and configuration 

can be determined by looking at the Instrument Status toolbar. This toolbar has two tabs. 

The Instrument Status tab shows the current instrument status including the status of 

assays in progress. The Instrument Config tab shows which LED modules, emission filters, 

and heads are installed. 

Protocol Creation 

The user must create assay protocols in manual mode. They do not need to load these 

protocols prior to placing the instrument into remote mode, but any protocol that is used in 

remote mode must be created and saved with a valid protocol file name prior to entering 

remote mode. 

Users should test all protocols in manual mode prior to attempting to run them in remote 

mode. 

Instrument Setup 

Prior to placing the instrument into remote mode, the user may want to load tips or plates 

into the instrument. These actions can be done in remote mode but in certain conditions it is 

advisable to do this through the main manual door prior to entering remote mode. 
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If tips are used for an extended period of time and the tips/source 1 position is used as a 

source position, it is best to load the tips manually before placing the instrument into 

remote mode. 

If boats or reservoirs are used as source plates, these should be loaded by hand in manual 

mode. The FLIPR TetraCycler Plate Handler must not be used to load reservoirs because the 

plate handler moves rapidly and large wells will spill liquid within the instrument. 

Instrument Mode Setting 

Prior to running an assay in remote mode, users must place the instrument into remote 

mode by selecting Instrument > Set Remote Mode from the main menu. 

After the user requests transition to remote mode, the instrument locks the main manual 

doors, moves the plate handler inside of the instrument, closes the inner automated door, 

and opens the outer automated door. This is the default position for remote mode. At the 

end of any plate handling operation, the instrument returns to this position. The outer 

manual doors remain locked as long as the instrument is in remote mode. 

The instrument assumes that any plates in the instrument when it transitions to remote 

mode are acceptable for use until a protocol has been run, which indicates that the plate is 

no longer needed. 

Loading Protocols 

In remote mode, protocols are loaded using the openprotocol command. This command 

loads the requested protocol and closes any other files open at the time that the command 

is sent. Protocols open regardless of whether they are valid. This command is described in 

more detail later in this document. 

Running Protocols 

After the instrument has been placed in remote mode and a protocol is opened, the protocol 

may be run by sending the runprotocol command. When a protocol begins to run in remote 

mode, any data files currently open close. This command is described in more detail later in 

this document. 

Instrument Status Updates 

The instrument can be queried at any time for instrument status, even when in manual 

mode. The status command is described in detail later in this document. 

Plate Status Tracking 

The most important information in the status command is the status of the plates in the 

instrument. From the status response, four possible information items may be determined 

about the plates in each of the four plate positions. 
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The first item that can be determined is the plate assigned to the plate position for the 

protocol to be run. This will be the plate name assigned in ScreenWorks Software for a 

particular plate type and assigned to that position for the current protocol. This information 

could be used by the robot to confirm that the correct plate type is delivered to the required 

position. ScreenWorks Software and the FLIPR Tetra system instrument have no method to 

determine whether the plate delivered is of the required type and they will always assume 

that the plate type delivered is correct. 

The status response also indicates whether a plate is present in each possible location. This 

indication is a direct readout of the status of the plate presence sensors in the instrument. 

This readout does not depend on whether a plate is required in the position or if the plate 

present is the correct plate. 

The REMOVEPLATES line in the status signals that the plates in the indicated positions have 

completed. Plates complete in different ways. If the plates are source plates, ScreenWorks 

Software indicates that they are finished when an aspiration from the plate is completed and 

that aspiration is checked to show that the plate is finished after the aspiration. For tip racks, 

they are marked as complete as soon as tips have been loaded or unloaded to/from them. 

Read plates are marked as complete at the end of the last read in the assay in which they are 

used. 

The NEEDPLATES line indicates plates that are needed for the assay in progress to continue. 

The instrument indicates that it needs a plate if it gets to an operation that requires a plate in 

a particular location and that location is either empty or contains a plate that was previously 

marked as finished. 

Bar Code Tracking 

Bar codes can be tracked in an assay in two ways. 

First, the bar code can be supplied to the software by the robot controller when the robot 

controller instructs the ScreenWorks Software to load a plate. The software will record the 

bar code values of the plates delivered in the appropriate data file in which they are used. 

Second, the instrument attempts to read a bar code for all plates it loads using the plate 

handler. If this value is not overridden by one supplied by the robot controller, this bar code 

is recorded in the data file when the plate is used. 

Regardless of the method used to deliver bar code information to the instrument, all bar 

code information might not be present when an assay is started, since all required plates 

might not be present in the instrument. Since the software can be configured to name the 

data file based on the bar codes of the plates used, it is possible that the data file name will 

change as an assay is completed. 
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Setting Up Protocols for Remote Control Use 

Protocols must be created in manual mode before entering remote mode. 

Protocols should also be tested in manual mode to ensure that they work as expected. 

Setting up protocols is described in the user guide and you should be familiar with this 

process before reading further in this section. See Setting Up an Assay Protocol on page 139. 

This section describes particular items you should be aware of when setting up protocols to 

be run in remote mode. 

Settings Screen 

Read Mode Settings 

In the settings screen, configure the read modes. The settings for the read mode are 

dependent on the assay dye, plate type, cell type, and condition. These settings are 

determined during assay development and no changes are required when switching into 

remote mode. 
 

Note: It is not possible to automatically vary these settings based on the particular 

cell plate loaded. 
 

Assign Plate Settings 

Assign plates to the required positions for the assay in the Assign Plate to Position group 

box. The assignment of plates can be critical to the smooth functioning of the assay. 

Only one type of plate can be assigned to a position throughout an assay. For example, it is 

not possible to assign a normal plate to a position for the first part of an assay and then 

assign a deep-well plate to that position for the rest of the assay. 

The read plate is always assigned to the read position. There are no special suggestions in 

remote mode for this assignment. 

The assignment of source plates and tips should be carefully considered. The pipettor and 

the plate handler are both used in remote assays and must share the space above the plate 

locations. The instrument monitors the locations of the pipettor and the plate handler and 

moves them if necessary to prevent collisions. The pipettor and plate handler are never 

allowed to be above the same plate position at the same time. Plates should be arranged to 

minimize potential interactions between the plate handler and the pipettor. 

The following guidelines can be helpful in assigning plate positions for automation: 

Open reservoirs with very large wells cannot be handled by the plate handler. These plates 

must be placed in the instrument manually prior to entering manual mode. Replacing these 

plates will require the user to halt remote control and place the instrument in manual mode 

to manually replace or refill the reservoir. Deep well plates are a good alternative to using 

these plates. 
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If tips are loaded in the experiment, they must be assigned to the Source Plate 1 location. 

When tips are assigned to this position, the position cannot be used for source plates. 

Unless the tips are going to be changed for every plate, it is a good idea to load the tips prior 

to placing the instrument into remote mode. Alternatively, the user could create a tip 

configuration protocol which load and wash the tips. This assay can be run and then the 

empty tip rack can be removed by the robot to allow the source 1 position to be used for 

other plates. As of v1.1 of the automation interface, tip loading and tip washing is available. 

Plates that are switched frequently should be placed closer to the left side of the instrument 

(near the automated landing pad) than plates which are not switched frequently. 

Deep well plates (or reservoirs) which can be used for a series of assays before being replaced 

can be placed in the source 3 location, as long as it is not being used for Cell Reservoir. This 

minimizes the interaction between the pipettor and the plate handler when switching plates 

during the majority of assays. 

It is only possible to RESET the instrument if a tip rack is present in the instrument. A RESET is 

required if the instrument enters a fault condition. If automated recovery from fault 

conditions is desired, the tips/source 1 position should be used for tips only and an empty 

tip rack should be left in this position at all times. 

Data File Name Settings 

Configure the desired data file name in the Data File Name group box. 

If the Include Bar Code box is selected, the bar codes for all of the plates which have been 

checked as requiring them are included in the data file name. Bar codes are separated by an 

underscore (_). If a bar code cannot be read, or one has not been provided during the 

loadplate command, the software records Bad_bar_code. 

The settings for the data file name are ignored in remote mode when the data file name is 

included with the runexperiment command line. Care should be taken when using this 

command to ensure that data file names are always unique to prevent the overwriting of 

data files. 

If the ScreenWorks Software is allowed to create the data file name, it will always end in _ 

###.fmd, where ### is the plate number with this base name. Using this option ensures that 

no data is lost due to file overwriting. 

Folder Settings 

This area is used to assign the directories used in saving the data and export files. There is no 

difference between settings for these directories in remote control mode and in manual 

mode. 

Running in remote control can produce large amounts of data. ScreenWorks Software will 

not allow users to begin new assays if less than 50MB of hard disk space is available. Hard 

disk capacity should be monitored and adequate space to save data should be maintained. 
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Saving data across a network connection is not recommended in any case. If a protocol is 

created which saves data across a network connection, you may be unable to run the 

protocol if the network connection becomes unavailable. If a protocol which saves across the 

network is running when a network connection is interrupted, data may be lost and the 

software may encounter problems. 

Temperature Control Settings 

This area allows the user to set the temperature control set point for the protocol. The 

instrument must already be at this set point prior to running the assay. 

If a protocol requiring temperature control is loaded and the runexperiment command is 

sent, the software confirms that the instrument has achieved this temperature. If the 

instrument has not reached the temperature, the software responds with an error. If the 

temperature has been reached, the experiment runs. 

Auto Print Options Settings 

In remote mode, problems with the printer can disrupt the continued operation of the 

system. No automatic printing is recommended in remote mode. 

Analysis Screen 

There are no special notes regarding the Analysis screen in remote control. Setup this screen 

as you would for any manual assay. 

It is very important to take care to set up groups, display, and reduction settings prior to 

running a large number of plates. These settings should be set in the protocol so that they 

are automatically replicated in each data file as it is created. It will be very tedious to go back 

to each data file and change these settings manually. 

Transfer Fluid Processes 

In general, settings for transferring fluids in remote control are the same as in manual mode, 

with three exceptions. These are in aspiration height over multiple plates, and the Pause In 

Well edit box. 

Aspiration Height over Multiple Plates 

When running in remote mode, a user might want to use a common addition source plate 

over a series of plates. The protocol(s) for this can be done in a couple of ways. The simplest 

way to do this is to create a single protocol which aspirates from the lowest allowed point in 

the source well. When doing this, you have to determine the maximum amount of liquid in 

the well so that the liquid displaced during insertion of the tip into the well is not pushed out 

of the well. This limits the amount of liquid that can be used in the source well. Alternatively, 

you can choose to create a series of protocols at successively lower aspiration start levels. 
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To provide an example of this situation, consider a user using a 384 well plate with a 250 μL 

well. This source plate is used to add a common agonist to all wells. In the assay, 20 μL of this 

agonist is added. Leave the plate in the instrument for a series of plates before replacing it. 

The FLIPR Tetra system a instrument allows protocols that begin aspiration as low as 8 μL for 

this plate. Inserting a 384 well tip all the way to the bottom of this plate displaces 50 μL of 

liquid. 

In the simple method described above,do not start with more than 190-200 μL of liquid in 

the plate because any more than this can spill liquid when the tip is fully inserted. The single 

protocol begins aspiration at 8 μL height. Then, run this assay 9 times before replacing the 

plate; leaving 10–20 μL of liquid in the wells after the source plate is removed. 

In the more complex implementation, fill the wells to 230–240 μL. Then, set up an assay that 

would start aspiration at ~240 μL in height, a second assay to start at ~220 μL, a third to start 

at ~200 μL. Continue to create separate assays at different heights or use the third assay for 

the remaining plates. In this case, 11 plates can be run before the plates need to be changed. 

The simple method is simpler to setup and run. The more complex method allows source 

plates to be switched less often. It also decreases the proportion of wasted common 

reagents. Finally, it can decrease carryover of compounds sticking to the outside of the tips, 

especially if the protocols are created to retrieve liquid from progressively lower heights all 

the way through the well height. 

Pause in Well Edit Box 

The Pause in Well edit box on the Edit Dispense screen allows you to require that the 

pipettor remain in the well after dispensing. This pipettor operation leaves the tips in the well 

for the time specified. When the tips are in the well, it might not be possible to exchange 

plates from any position, and certainly not from the read or source 3 positions. For this 

reason, use of this option is not recommended in remote mode. 

Wash Tips Processes 

No special requirements are needed for the Wash Tips process. 
 

Note: The pipettor and the plate handler do not share the tip reservoir position. For 

this reason, plate handling can proceed unhindered during wash operations. 
 

Mix Fluid Processes 

The Mix Fluids process does not require any special changes during protocol creation. 
 

Note: The same warning that applies to Pause in Well for dispensing also applies 

here. 

Also, mixing in any well may interfere with plate handling, so use of this function may require 

some experimentation. 

Read Processes 

No special requirements are needed for Read processes. 



FLIPR Tetra High Throughput Cellular Screening System User Guide 

210 0112-0109 K 

 

 

 

 

Finish with Source Processes 

This notifies the plate handler to remove the plates in remote mode. 

Wash Cell Reservoir Processes 

No special requirements are need for the Wash Cell Reservoir process. 
 

Command Set 

Command Syntax 

All commands and parameters must be sent in lower case and end with <CR>. 

All responses are given in lower case and end with <CR>. 

Response from ScreenWorks Software has one of the following forms: 

ok<CR> 

errorcode, error string<CR> 

status<CR> 

ok<CR> indicates the command was started successfully or command is executed 

successfully. 

errorcode, error string<CR> indicates command failed because of either an indicated 

condition or an instrument error. Error codes will be followed by a comma, a space, and 

then a string describing the error of up to 300 characters. Error strings are entirely lower 

case. 

status<CR> is the formatted status text which was requested. 

Version <CR> 

Command Description 

This command returns the version string for the automation interface command set. 

This command is only supported for versions 1.1 and newer. Older versions return the error 

c69, badly formed or unrecognized command in response to this command. 

Command Parameters 

There are no parameters associated with this command. 

Example Command Line 

version<CR> 

 

Example Response 

1.1<CR> or c69, badly formed or unrecognized command.<CR> 
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Suggested Steps in Command Usage 

This should be the first call made to the instrument after making a TCP/IP connection to 

ScreenWorks Software. To ensure problem free operation of your application for 

FLIPR Tetra system customers, the robotic integrator must consider limiting use of the 

application to interface versions they have tested. 

Status <CR> 

Command Description 

The status command returns the status of the instrument. The status response is an ASCII 

text string which includes: 

Information about the instrument type and firmware version. 

Whether the instrument is functioning normally or an error occurred. If an error has 

occurred, this field will contain an error code and an error string of less than 300 

characters. The error code and error string will be separated by a comma and space. 

The instrument status field reports a summary of status information including whether 

the instrument is busy, faulted, error, resetting, aborted, or idle. It also reports whether 

the instrument is remote or manual mode. In manual mode, only status information is 

available through this interface. All other commands will not function. Finally, this line 

reports whether the software is online (connected to the instrument) or not. 

Whether an experiment is running or not—do not open or start another experiment 

until the first is finished. 

Name of the plates assigned to each position. 

Whether plates are present or not on plate locations. 

Whether plates need to be loaded or removed. 

Whether the plate handler is busy or idle. 

Whether the landing pad has a plate or not. 

Camera temperature. Status returns “not_ok” while camera CCD temperature is cycling 

and/or out of range as defined by factory firmware settings, “off” if camera temperature 

control is disabled, or “ok” otherwise. Typically factory setpoint is -60 °C ± 2 °C ( -76 °F ± 

35.6 °F) for EMCCD camera or -20 °C ±5 °C ( -4 °F ± 41 °F) for ICCD camera. Also returns 

actual CCD temperature and setpoint. 

Chamber temperature. Status reports “not_ok” while chamber is not at setpoint 

temperature (typical factory tolerance of ±0.5 °C/± 41 °F, “fault” if sensor does not return 

a reading, “off” if chamber temperature control has been disabled, or “ok” otherwise. 

Waste/fill bottle status. 
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Tips on|off. 

Outer auto door, open/closed—if it is closing it is reported as closed. 
 

Example Command Line 

status<CR> 

 

Response Format 

instrument <SP>instrument name<TAB> 

version<SP>mm/dd/yyyy<TAB> 

function<SP>ok|errorcode|fatalcode,[errorstring]<TAB> 

inst_status<SP>busy|fault|error|resetting|abort|idle,remote|manual,o 

ffline|online<TAB> 

exp_running<SP>yes|no<TAB> 

readplate<SP>platename|none,have|empty<TAB> 

sourceplate1<SP>platename|none,have|empty<TAB> 

sourceplate2<SP>platename|none,have|empty<TAB> 

sourceplate3<SP>platename|none,have|empty<TAB> 

loadplates<SP>re[,s1,s2,s3,ti]|none<TAB> 

removeplates<SP>re[,s1,s2,s3,ti]|none<TAB> 

platehandler<SP>idle|busy_load|busy_remove<TAB> 

plate_on<SP>yes|no<TAB> 

camera_temp<SP>ok|not ok|off,temp,setpoint<TAB> 

chamber_temp<SP>ok|not_ok|fault|off<TAB> 

waste_bottlea<SP>ok|full<TAB> 

waste_bottleb<SP>ok|full<TAB> 

fill_bottlea<SP>ok|empty<TAB> 

fill_bottleb<SP>ok|empty<TAB> 

tips<SP>on|off<TAB> 

outer_auto_door<SP>open|closed<CR> 

Example Response 

instrument<SP> tetra<TAB> 

version<SP> sep 30 2004<TAB> 

function<SP> d70, initialization halted because tips are loaded. please 

verify that the appropriate tip rack (96,384,1536)is loaded and select 

reset <TAB> 

inst_status<SP> idle,remote,online<TAB> 

exp_running<SP>no<TAB> 

readplate<SP> default384,have<TAB> 

sourceplate1<SP>default384,have<TAB> 

sourceplate2<SP>none,have<TAB> 

sourceplate3<SP>none,have<TAB> 

loadplates<SP>none<TAB> 

removeplates<SP>none<TAB> 

platehandler<SP>idle<TAB> 

plate_on<SP>no<TAB> 
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camera_temp<SP>ok,-35,-35<TAB> 

chamber_temp<SP>off,0,0<TAB> 

waste_bottlea<SP>ok<TAB> 

waste_bottleb<SP>ok<TAB> 

fill_bottlea<SP>ok<TAB> 

fill_bottleb<SP>ok<TAB> 

tips<SP>on<TAB> 

outer_auto_door<SP>closed<CR> 

Suggested Steps in Command Usage 
 

Send status command. 

Response is the instrument status. 

Loadplate<TAB>Location, Last Plate[, BAR CODE] <CR> 

Command Description 

Loads plate or tips to the specified location from landing pad. The plates or tips must have 

been placed on the instrument landing pad prior to the command being issued. Up to 13 

plates (1 source plate, 12 compound plates) can be used in single experiment. 

Additional parameters are available to provide the bar code for the delivered plate and 

identify the final plate for an assay. 

The bar codes of up to 5 plates can be recorded in the data file. 

Command Parameters 

There are four parameters available for use with this command. 

The parameters are location, bar code, and last plate. The location parameter is required. 

The bar code and last plate parameters are optional. If the bar code parameter is used then 

the plate order parameter must also be used. 

Location parameter must be one of following: 

re–which indicates read plate location. s1–

which indicates source plate 1 location. 

s2–which indicates source plate 2 location. 

s3–which indicates source plate 3 location. 

ti–which indicates tips loading location. 

The tips and source 1 location are the same position. Either the “ti” or “s1” parameter may 
be used to indicate this position. 

Bar code parameter must be: 

String up to 20 characters. 

String can have letters, numbers, underscore, and spaces. 
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The instrument will always attempt to read a bar code while loading a plate. If a bar code is 

supplied through the loadplate command, any bar code actually found on the actual plate 

loaded will be ignored. 

The last plate parameter indicates whether or not the plate being loaded is the last plate in 

the current experiment. This parameter must be “yes” or “no”. The last plate parameter is no 

longer used by the FLIPR Tetra system and ScreenWorks Software but continues to be 

required for compatibility reasons. 

Example Command Line 

loadplate<TAB>re, no, abcd1234<CR> 

 

Example Response 

ok<CR> or c10, error string<CR> 

 

Suggested Steps in Command Usage 
 

1. Check if instrument status is acceptable, such as no error state, no plate on landing pad, 

no plate in target location, plate handler is idle. 

2. Put plate on landing pad. 

3. Send loadplate command. 

Response is OK, confirming command started execution or Condition code related to 

command, that confirming command could not start execution. 

4. Monitor plate handler status for completion, and error status for any other kind of error. 
 

Command Specific Error Responses 
 

Instrument is not functionalCondition code is C00 

Invalid plate locationCondition code is C05 

Plate handler busyCondition code is C10 

Landing pad does not have a plateCondition code is C20 

Plate location already has a plateCondition code is C15 

Removeplate<TAB>location <CR> 

Command Description 

Removes plate or tips from the specified location. If source plate3 location is set for tips in 

the current experiment, the instrument will assume tips are present in that position 

Command Parameters 

There is one parameter, location, for this command. 

Location parameter must be one of following: 
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re–which indicates read plate location. s1–

which indicates source plate 1 location. 

s2–which indicates source plate 2 location. 

s3–which indicates source plate 3 location. 

ti–which indicates tips loading location. 

Note: The tips and source 1 location are the same position. Either the “ti” or “s1” 

parameter may be used to indicate this position. 
 

Example Command Line 

removeplate<TAB>s1<CR> 

 

Example Response 

ok<CR> or c20, error string <CR> 

 

Suggested Steps in Command Usage 
 

1. Check if instrument status is acceptable (no error state, no plate on landing pad, plate 

present in target location, plate handler is idle). 

2. Send removeplate command. 

Response is OK, that confirming command started execution or Condition Code related 

to command, that confirming command could not start execution. 

3. Monitor plate handler status for completion, and error status for any other kind of error. 
 

Command Specific Error Responses 
 

Instrument is not functionalCondition code is C00 

Invalid plate locationCondition code is C05 

Plate handler busyCondition code is C10 

Landing pad has a plateCondition code is C21 

Plate location doesn’t have plateCondition code is C16 

Openprotocol<TAB>File Name<CR> 

Command Description 

This command opens the specified protocol. Any documents open before this command is 

sent will be closed automatically. Only one protocol may be open at the time. 

Command Parameters 

There is one parameter, file name, for this command. 
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File name parameter will be the complete file name of the protocol to be opened, including 

path and file type identifier (*.fmp). 

Example Command Line 

openprotocol<TAB>c:\screenworks\protocols\myprotocol.fmp<CR> 

 

Example Response 

ok<CR> or c30, error string <CR> 

 

Suggested Steps in Command Usage 
 

1. Make sure experiment is not running. 

2. Send openprotocol command. 

Response is OK, that confirming command executed or Condition code related to 

command, that confirming command could not execute. 

Command Specific Error Responses 
 

Experiment is runningCondition code is C25 

Protocol not foundCondition code is C30 

Protocol could not be openCondition code is C35 

Invalid protocol nameCondition code is C36 

Findprotocols<TAB>Folder<CR> 

Command Description 

This command returns all the protocols in the specified folder. The command will return a 

comma-delimited list containing all of the *.fmp type files saved in the indicated directory. 

Each of these files will NOT be checked to confirm that the protocols that they contain are 

valid for the current instrument configuration. 

Command Parameters 

There is one parameter, folder, for this command. 

The folder parameter identifies the folder for which a list of all *.fmp type files will be 

returned. The folder must be complete and in the correct Windows format, including the 

drive identifier and a closing backslash(\). 

Example Command Line 

findprotocols<TAB>c:\screenworks\protocols\<CR> 

 

Example Response 

[myprotocol1.fmp,myprotocol2.fmp,myprotocol3.fmp]<CR> or c45, error string 

<CR> 



Appendix A: Robotic Integration 

0112-0109 K 217 

 

 

 

 

Suggested Steps in Command Usage 
 

Send findprotocol command at any time. 

Response is a list of protocols separated by comma or Condition code related to 

command, that confirming command could not execute. 

Command Specific Error Responses 
 

Folder does not existCondition code is C45 

Invalid folder nameCondition code is C46 

Current document is not valid protocolCondition code is C50 

No protocols found in dirCondition code is C56 

Runexperiment<TAB>[Data File Name]<CR> 

Command Description 

This command will run the currently open protocol, if it is valid for the current instrument 

configuration. 

Running any protocol will create a data file and shift the software focus to this data file for 

the duration of the experiment. When running in Remote mode, the data file will be closed 

automatically when experiment is done and focus will automatically return to the protocol 

file. 

Command Parameters 

There is one optional parameter, data file name, for this command. 

If a data file name parameter is used with this command, the data file created by running the 

current protocol will be named data file name. The filename will be appended to the Data 

folder path specified in the protocol Settings screen in the ScreenWorks Software. Never 

specify data file name containing a full path. 

If the data file name parameter is not given, the data file created will be saved with auto save 

name as indicated in the Settings screen in the ScreenWorks Software. 

Example Command Line 

runexperiment<TAB>mydata10312003.fmd<CR> 

 

Example Response 

ok<CR> or c50, error string <CR> 

 

Suggested Steps in Command Usage 
 

1. Check if instrument is functioning fine. 

2. Make sure the experiment is not running. 
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3. Open protocol first by sending openprotocol command. 

4. Send runexperiment command. 

Response is OK, that confirming command started execution or Condition code related 

to command, that confirming command could not start execution. 

5. Monitor status for completion, and error status for any other kind of error. 
 

Command Specific Error Responses 
 

Instrument is not functionalCondition code is C00 

Experiment is runningCondition code is C25 

Current document is not valid protocolCondition code is C50 

Invalid data file nameCondition code is C47 

Stopexperiment<CR> 

Command Description 

This command will stop the current action being performed by the instrument. 

The stopexperiment command will stop the experiment immediately. This can halt the 

instrument pipettor in the midst of a motion. In this case, the instrument immediately 

enters a fault state and an instrument reset is required. In addition, the pipettor might not 

be in motion but might have tips that contain fluid or are in a source or target plate. In these 

cases, it might be possible to recover without resetting by washing the tips. Regardless, an 

instrument reset is recommended following the use of any stopexperiment command. 

Command Parameters 

There are no parameters associated with this command. 

Example Command Line 

stopexperiment<CR> 

 

Example Response 

ok<CR> or c55, error string <CR> 

 

Suggested Steps in Command Usage 
 

1. Check if instrument is functioning fine. 

2. Make sure experiment is running. 

3. Send stopexperiment command. 

Response is OK, confirming that command execution has begun, or a Condition code 

related to the command indicating that execution could not begin. 

4. Monitor status for completion, and error status for any other kind of error. 
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Command Specific Error Responses 
 

Instrument is not functionalCondition code is 00 

No experiment is runningCondition code is 55 

Clearerror<CR> 

Command Description 

Cleans error in case recoverable error occurred. 

Command Parameters 

There are no parameters associated with this command. 

Example Command Line 

clearerror<CR> 

 

Example Response 

ok<CR> 

 

Suggested Steps in Command Usage 
 

1. Check instrument status. 

2. Check if error is occurred. 

3. Send clearerror command. 

Response is OK confirming the software has attempted to clear the error. 

4. Monitor status for error is cleared. 

Loadtips<CR> 

Command Description 

This command loads the tips onto the pipettor head from position s1. 

This command executes when commanded if tips are not already loaded and any plate is in 

the tips position. The instrument is not capable of confirming that the plate in the tip load 

position is actually a tip rack. It is the responsibility of the user to ensure that the plate in 

that position is actually a tip rack. Attempting to load tips when a plate, rather than a tip 

rack, is in the tip load position results in an instrument fault and can result in damage to the 

plate, the instrument, or both. 

Command Parameters 

There are no parameters associated with this command. 
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Example Command Line 

loadtips<CR> 

 

Example Response 

ok<CR> 

 

Suggested Steps in Command Usage 
 

1. Make sure an experiment is not running. 

2. Check the instrument status to make sure tips are not already loaded. 

3. Place tiprack in tipload position via the loadplate command. 

4. Send loadtips command. 

Response is OK, confirming that command execution has begun, or a Condition code 

related to the command indicating that execution could not begin. 

5. Monitor status for completion, and error status for any other kind of error. 
 

Command Specific Error Responses 
 

Can't load tips, tips on pipettorCondition code is C58 

Unloadtips<CR> 

Command Description 

This command unloads the pipette tips from the pipettor head into an empty tip rack placed 

into the tip load position. 

This command will execute when commanded if tips are loaded and any plate is in the tips 

position. The instrument is not capable of confirming that the plate in the tip load position is 

actually an empty tip rack. It is the responsibility of the user to ensure that the plate in that 

position is actually an empty tip rack. Attempting to load tips when a plate or full tip rack, 

rather than an empty tip rack, is in the tip load position will likely result in an instrument fault 

and may result in damage to the plate, the instrument, or both. 

Command Parameters 

There are no parameters associated with this command. 

Example Command Line 

unloadtips<CR> 

 

Example Response 

ok<CR> 
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Suggested Steps in Command Usage 
 

1. Make sure an experiment is not running. 

2. Check the instrument status to make sure tips are currently loaded. 

3. Ensure that an empty tip rack is in tip load position. 

4. Send loadtips command. 

Response is OK, confirming that command execution has begun, or a Condition code 

related to the command indicating that execution could not begin. 

5. Monitor status for completion, and error status for any other kind of error. 
 

Command Specific Error Responses 
 

Can't unload tips, tips not on pipettorCondition code is C59 

Cyclecameratemp<CR> 

Command Description 

This operation cycles the camera temperature by setting the camera setpoint to 20 °C (68 °F), 

waiting for the camera to reach this setpoint, resetting the camera to -45 °C (-49 °F), and then 

waiting for the camera to return to this temperature. 

This command may be useful when transitioning from fluorescence to luminescence 

experiments. Cycling the camera temperature allows the camera CCD chip to recover from 

the high light levels present during fluorescence experiments and improves data quality in 

subsequent luminescence experiments. 

This command requires up to 15 minutes to complete execution. 

Command Parameters 

There are no parameters associated with this command. 

Example Command Line 

cyclecameratemp<CR> 

 

Example Response 

ok<CR> 

 

Suggested Steps in Command Usage 
 

1. Make sure an experiment is not running. 

2. Send cyclecameratemp command. 

Response is OK, confirming that command execution has begun, or a Condition code 
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related to the command indicating that execution could not begin. 

3. Monitor status for completion, and error status for any other kind of error. 

Tempcontrolonoff<TAB>Temp<CR> 

Command Description 

This command sets the temperature setting for the instrument chamber. After sending this 

command, the robotic controller should monitor the instrument temperature to confirm 

that the instrument reaches the setpoint. Some protocols will not execute until the required 

temperature is reached. 

Example Command Line 

tempcontrolonoff<TAB>12<CR> 

 

Example Response 

ok<CR> 

 

Suggested Steps in Command Usage 
 

1. Make sure an experiment is not running. 

2. Send tempcontrolonoff command. 

Response is OK, confirming that command execution has begun, or a Condition code 

related to the command indicating that execution could not begin. 

3. Monitor status until the instrument reports that it has reached the requested 

temperature. 

Command Specific Error Responses 
 

Temperature Control System is not functioningC60 

Washtips<TAB>Fluid Type, Wash Cycles, Volume/Stroke, Aspirate 

Speed, Pump Speed, Strokes, Hold Time, Dispense Speed<CR> 

Command Description 

This command is the equivalent of selecting Instrument> Manual Operation > Wash Tips 

from the main menu of the ScreenWorks Software. This selection washes the pipette tips 

with the parameters provided. 
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Command Parameters 

There are eight required parameters for this command. All eight parameters must be 

supplied for this command to properly execute. For some of the parameters, acceptable 

values can vary depending on the head type currently installed on the instrument. The 

following table lists the parameters, their purpose, and the appropriate range for the 

commands. 
 

Parameter Description Acceptable values or range 

96-well 384-well  1536- 

head  head well head 

Fluid type Indicates which wash fluid bottle to be used. a, b 

Wash Cycles Number of wash reservoir fill/drain cycles to 

complete. The requested # of strokes will be 

repeated for each cycle. 

1,2,3,4,5 

Volume/stroke Volume to be drawn into the pipette tip in each 

stroke. 

5–206 

(double) 

1–28 

(double) 

1–3 

(double) 

Aspirate speed Pipettor aspiration speed in micro liters per 

second. 

5.00, 

10.00, 

20.00, 

30.00, 

40.00, 

50.00, 

75.00, 

100.00, 

125.00 

0.50, 

1.00, 

2.00, 

5.00, 

7.00, 

10.00, 

15.00, 

20.00, 

25.00, 

30.00 

0.25, 

0.50, 

0.75, 

1.00, 

1.25, 

1.50, 

2.00, 

3.00, 

5.00, 

10.00 

Pump speed Speed to run the pumps which fill and drain the 

wash reservoir. Two speeds, fast and slow, are 

available. Slow is recommended for use with 

wash solvents which tend to bubble. 

fast, slow   

Strokes Number of times which the pipettor will fill and 

empty with the requested volume in each wash 

cycle. 

1–20 

(integer) 

  

Hold time Pause time in seconds at the top of the stroke of 

the pipettor 

0–15   

Dispense speed Pipettor aspiration speed in micro liters per 

second. 

5–200 

(double) 

1–50 

(double) 

1–10 

(double) 

Example Command Line 

washtips<TAB>a,2,28.0,20.00,fast,5,0.0,20.0<CR> 
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Example Response 

ok<CR> 

 

Suggested Steps in Command Usage 
 

1. Make sure an experiment is not running. 

2. Ensure that tips are loaded. 

3. Send washtips command. 

Response is OK, confirming that command execution has begun, or a Condition code 

related to the command indicating that execution could not begin. 

4. Monitor status until the wash is complete. 
 

Command Specific Error Responses 
 

Tips not loadedC68 

Configuration<CR> 

Command Description: 

The configuration command returns the configure of the instrument. The configuration 

response is an ASCII text string which includes: 

Information about the instrument type and firmware version. 

Pipettor head’s type. 

Tip washer’s type. 

Bar code reader installed or not. 

Plate handler installed or not. 

Cell Reservoir installed or not. 

Camera type installed. 

Chiller installed or not. 

LEDs installed. 

Emission filters’ wavelength. 
 

Example Command Line 

configuration<CR> 

 

Response format 

instrument<SP>name<TAB> 

version<SP>version#<TAB> 

pipettor<SP>96|384|1536|384pintool| 1536pintool|no<TAB> 
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tip_washer<SP>96|384|1536|no<TAB> 

bar_code<SP>installed|not installed<TAB> 

plate_handler<SP>installed|not installed<TAB> 

cell_reservoir<SP>installed|not installed<TAB> 

camera_installed<SP>emccd|iccd<TAB> 

chiller_installed<SP>installed|not installed<TAB> 

wave1<SP>no led|470-495 nm|510-545 nm|390-420 nm|420-455 

nm|610-626 nm|360-380 nm|525-550 nm|525-570 nm|570-595 

nm|590-614 nm|620-648 nm|495-505nm|360-380 nm <TAB> 

wave2<SP>no led|470-495 nm|510-545 nm|390-420 nm|420-455 

nm|610-626 nm|360-380 nm|525-550 nm|525-570 nm|570-595 

nm|590-614 nm|620-648 nm|495-505 nm|360-380 nm <TAB> 

emfilt1<SP>no filter|515-575 nm|565-625 nm|440-480 nm|475-535 

nm|646-706 nm|400-460 nm|570-630 nm|590-650 nm|615-675 

nm|634-694 nm|668-728 nm|526-585 nm|400-460 nm<TAB> 

emfilt2<SP>no filter|515-575 nm|565-625 nm|440-480 nm|475-535 

nm|646-706 nm|400-460 nm|570-630 nm|590-650 nm|615-675 

nm|634-694 nm|668-728 nm|526-585 nm|400-460 nm<TAB> 

emfilt3<SP>no filter|515-575 nm|565-625 nm|440-480 nm|475-535 

nm|646-706 nm|400-460 nm|570-630 nm|590-650 nm|615-675 

nm|634-694 nm|668-728 nm|526-585 nm|400-460 nm<TAB> 

<CR> 

 

Example Response 

Instrument<SP>tetra<TAB> 

version<SP>2.1.0.0<TAB> 

pipettor<SP>96<TAB> 

tip_washer<SP>96<TAB> 

bar_code<SP>installed<TAB> 

plate_handler<SP>installed<TAB> 

cell_reservoir<SP>installed<TAB> 

camera_installed<SP>emccd<TAB> 

chiller_installed<SP>installed<TAB> 

wave1<SP>470-495 nm<TAB> 

wave2<SP>510-545 nm<TAB> 

emfilt1<SP>515-575 nm<TAB> 

emfilt2<SP>515-575 nm<TAB> 

emfilt3<SP>515-575 nm<CR> 

Suggested Steps in Command Usage 
 

Send configuration command. 

Response is instrument configuration. 



FLIPR Tetra High Throughput Cellular Screening System User Guide 

226 0112-0109 K 

 

 

 

 

Statusex<CR> 

Command Description 

The statusex command is an extension of status command. It returns the status of the 

instrument in more details than the status command. The statusex response is an ASCII text 

string which includes all status command’s response information plus: 

Tip washer status 

Cell Reservoir status 

Camera chiller status 

Camera intensifier status 
 

Example Command line 

statusex<CR> 

 

Response format 

instrument <SP>instrument name<TAB> 

version<SP>mm/dd/yyyy<TAB> 

function<SP>ok|errorcode|fatalcode,[errorstring]<TAB> 

inst_ 

status<SP>busy|fault|error|resetting|abort|idle,remote|manual,offline|online<T 

AB> 

exp_running<SP>yes|no<TAB> 

readplate<SP>platename|none,have|empty<TAB> 

sourceplate1<SP>platename|none,have|empty<TAB> 

sourceplate2<SP>platename|none,have|empty<TAB> 

sourceplate3<SP>platename|none,have|empty<TAB> 

loadplates<SP>re[,s1,s2,s3,ti]|none<TAB> 

removeplates<SP>re[,s1,s2,s3,ti]|none<TAB> 

platehandler<SP>idle|busy_load|busy_remove<TAB> 

plate_on<SP>yes|no<TAB> 

camera_temp<SP>ok|not ok|off|busy|fault,temp,setpoint<TAB> 

chamber_temp<SP>ok|not_ok|fault|off|busy<TAB> 

waste_bottlea<SP>ok|full<TAB> 

waste_bottleb<SP>ok|full<TAB> 

fill_bottlea<SP>ok|empty<TAB> 

fill_bottleb<SP>ok|empty<TAB> 

tips<SP>on|off<TAB> 

outer_auto_door<SP>open|closed<TAB> 

tip_washer<SP>ok|not_ok|off|busy|fault<TAB> 

cell_reservoir<SP>ok|not_ok|off|busy|fault,stir rate<TAB> 

chiller_status<SP>ok|not_ok|off|busy|fault,temp,setpoint<TAB> 

intensifier_status ok|not_ok|off|busy|fault<CR> 
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Example Response 

instrument<SP> tetra<TAB> 

version<SP>2.1.0.0<TAB> 

function<SP>ok<TAB> 

inst_status<SP>idle,remote,online<TAB> 

exp_running<SP>no<TAB> 

readplate<SP>default96,have<TAB> 

sourceplate1<SP>default96,have<TAB> 

sourceplate2<SP>default96,have<TAB> 

sourceplate3<SP>default96,have<TAB> 

loadplates<SP>none<TAB> 

removeplates<SP>none<TAB> 

platehandler<SP>idle<TAB> 

plate_on<SP>no<TAB> 

camera<SP>temp ok,0,0<TAB> 

chamber_temp<SP>off,0,0<TAB> 

waste_bottlea<SP>ok<TAB> 

waste_bottleb<SP>ok<TAB> 

fill_bottlea<SP>ok<TAB> 

fill_bottleb<SP>ok<TAB> 

tips<SP>on<TAB> 

outer_auto_door<SP>open<TAB> 

tip_washer<SP>ok<TAB> 

cell_reservoir<SP>not_ok,0<TAB> 

chiller_status<SP>ok,18.0, 18.0<TAB> 

intensifier_status<SP>ok<CR> 

Cellflaskcontrol<TAB>Rate<CR> 

Command Description 

This command sets the stir-rate for the cell-flask control. After sending this command, the 

robotic controller should monitor the instrument stir-rate to confirm that the instrument 

reaches the setpoint. 

Command Parameters 

There is one required parameter, rate, for this command. 

If a value of zero is used for the rate parameter, the cell flask control will stop stirring. If a 

valid value for rate is used, the cell flask control will be turned on and stir at this rate. Valid 

values for rate are integers between 1–25. 

Example Command Line 

cellflaskcontrol<TAB>22<CR> 



FLIPR Tetra High Throughput Cellular Screening System User Guide 

228 0112-0109 K 

 

 

 

 

Example Response 

ok<CR> 

 

Suggested Steps in Command usage 
 

1. Make sure an experiment is not running. 

2. Send cellflaskcontrol command. 

Response is OK, confirming that command execution has begun, or a Condition code 

related to the command indicating that execution could not begin. 

3. Monitor status until the instrument reports that it has reached the requested stir-rate. 
 

Command Specific Error Responses 
 

C76–Cell flask stirring rate parameter was not sent 

C77–Parameter is out of range. Range is … 

Washcellreservoir<TAB>Fluid Type, Fill Speed, Drain Destination, 

Drain Speed, Wash Cycles, Hold Time, Volume Level<CR> 

Command Description 

This command is the equivalent of selecting Instrument > Manual Operation > Wash Cell 

Reservoir from the main menu of the ScreenWorks Software. This selection washes the Cell 

Reservoir with the parameters provided. 

Command Parameters 

There are seven required parameters for this command. All seven parameters must be 

supplied for this command to properly execute. The following table lists the parameters, 

their purpose, and the appropriate range for each parameter. 
 

Parameter Type Description Acceptable values or 

range 

Fluid type string Indicates the fluid bottle to be used. Fluid 1, fluid 2, fluid 3, 

fluid 4, cell flask. 

Fill speed integer Speed to run the pumps which fill the Cell 

Reservoir. Range from 1–10 where 1 is very 

slow, and 10 is very fast. 

1–10 

Drain 

destination 

string Indicate the bottle to drain fluid to. Fluid 1, fluid 2, fluid 3, 

fluid 4, cell flask, waste a, 

waste b. 
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Parameter Type Description Acceptable values or 

range 

Drain speed integer Speed to run the pumps which drain the Cell 

Reservoir. Range from 1–10 where 1 is very 

slow, and 10 is very fast. 

1–10 

Wash cycles integer Number of wash reservoir fill/drain cycles to 

complete. 

1,2,3,4,5 

Hold time float Pause time in seconds, leaving the fluid in the 

reservoir for desired period of time before 

draining it. 

0–300 

Volume string This indicate the level of fluid to be filled in the 

Cell Reservoir. 

low, high 

 

Example Command Line 

washcellreservoir<TAB>fluid 2, 6, waste a, 8, 1, 0, high<CR> 

 

Example Response 

Ok<CR> 

 

Suggested Steps in Command usage 
 

1. Make sure an experiment is not running. 

2. Ensure that tips are loaded. 

3. Send washcellreservoir command. 

Response is OK, confirming that command execution has begun, or a Condition code 

related to the command indicating that execution could not begin. 

4. Monitor status until the wash is complete. 
 

Command Specific Error Responses 
 

C77–Parameter is out of range. The range is ... 

C78–The number of parameters for wash Cell Reservoir commands is invalid. 

C79–Invalid volume parameter. It must be 'low' or 'high'. 

C72–Hold time is too small. 

C73–Hold time is too large. 
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Error Handling and Reporting 

Interface Errors 

Interface errors are errors that are generated by issuing a command. These errors are 

detected upon receipt of the command by ScreenWorks Software and are reported in the 

response to the command. These errors consist of a single alpha character and a two or 

three-digit code. Specific errors are listed with the command that can generate them in Table 

A-1. 

Table A-1: Interface Errors 

Error Description 

Code 

C01 Instrument is not in Remote Mode. Only ‘status’ command can be sent while instrument 

is in Manual Mode. 

C05 Invalid plate location. 

C10 Plate handler is busy. 

C15 Plate location already has a plate. 

C16 Plate location has no plate. 

C20 Landing pad has no plate. 

C21 Landing pad has plate. 

C25 Experiment is running. 

C35 Protocol could not be opened. 

C36 Invalid protocol name. 

C45 Folder does not exist. 

C46 Invalid folder name. 

C47 Invalid data file name. 

C50 Current document is not valid protocol.S 

C55 No experiment is running. 

C56 No protocols found in dir. 

C57 The temperature parameter (int) was not sent. 

C58 Can't load tips, tips on pipettor. 

C59 Can't unload tips, no tips on pipettor. 

C60 The temperature control system is not functioning. 

C61 The aspirate speed is out of range. 

C62 The pump speed can only be Slow or Fast. 



Appendix A: Robotic Integration 

0112-0109 K 231 

 

 

 

Table A-1: Interface Errors (continued) 

Error Description 

Code 

C63 Invalid number of wash strokes. 

C64 Invalid number of parameters for the wash tips command. 

C65 Invalid number of wash cycles. 

C66 Invalid protocol parameters discovered at runtime. 

C67 Invalid wash fluid parameter. 

C68 Can't wash tips, tips are not on. 

C69 Unrecognized or badly formatted command. 

C70 Volume stroke too large. 

C71 Volume stroke too small. 

C72 Hold time is too small. 

C73 Hold time is too large. 

C74 Dispense speed is too large. 

C75 Dispense speed is too small. 

C76 Cell flask stirring rate parameter was not sent. 

C77 Parameter is out of range. 

C78 The number of parameters for wash Cell Reservoir commands is invalid. 

C79 Invalid volume parameter. It must be 'low' or 'high'. 

Table A-2 documents the errors one might encounter when sending the runexperiment 

command. The errors explain how the currently opened protocol does not match 

instrument configure or instrument is not ready to run current protocol. 

Table A-2: runexperiment Command Errors 

Error Description 

Code 

E100 Invalid LED filter combination! Calibrate it or choose valid combination. 

E110 Plate does not exist in plate library. Choose existing plate or add it into plate library. 

E111 Plate is not present or is not in the proper location. 

E112 Door(s) are opened. Close the doors before start your experiment. 

E113 Load Tips position not checked! Check Load Tips position for auto load tips or manually load 

tips before running experiment. 

E114 The chamber temperature is not in range. 

E115 Experiment wash tips and there is no tip washer. 
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Table A-2: runexperiment Command Errors (continued) 

Error Description 

Code 

E116 Bottle A is empty! Refill it or use another bottle. 

E117 Bottle B is empty! Refill it or use another bottle. 

E118 Waste bottle A is full. Please empty the bottle to continue. 

E119 Waste bottle B is full. Please empty the bottle to continue. 

E120 Remove plates redundant. 

E121 Error relate to the data folder. The path is not valid, or cannot be accessed. Or there are not 

enough disk space. 

E122 Error relate to the export folder. The path is not valid, or cannot be accessed. Or there are 

not enough disk space. 

E123 The read interval is too short. Please check settings in Read views. 

E124 Invalid aspirate parameters [in the protocol]. 

E125 Invalid dispense parameters [in the protocol]. 

E126 The wash tips parameters are invalid. 

E127 Invalid fluid bottle specified in wash tips process. 

E128 Invalid Read Mode configuration. You tried to take fluorescence (with excitation) and 

luminescence (without excitation) reading in one protocol. This is not allowed. 

E129 Invalid Read Mode configuration. Camera gain or gate time is out of range. Please check 

your protocol settings. 

E130 The protocol has transfer cells and/or wash Cell Reservoir operations even though the Cell 

Reservoir is not installed. 

E131 Cell Reservoir is not ready. 

E132 Cell flask spinning rate could not be set. Please check your instrument status. 

 

Instrument Errors 

Instrument errors are errors that are generated by executing a command. These errors are 

detected during the execution of the command by the instrument. They are reported in the 

status response in the function line. These errors consist of a three-digit numeric code. 

Instrument errors fall into two general categories, recoverable and fatal errors. When fatal 

errors occur, the instrument will not be able to continue to do any operation. It aborts any 

pending operations. When recoverable errors occur with user interaction, the instrument 

can continue. 

The status command returns ERRORCODE or FATALCODE. 

Error codes 100–199 are call Molecular Devices Tech support errors. 

Error codes 200–299 are instrument recoverable errors. 
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Error codes 300–399 are instrument non-fatal errors. 

Error codes 400–499 are instrument fatal errors. 

Error codes 500–599 are instrument diagnostic errors. 

A full list of these errors can be found in Troubleshooting on page 169. 
 

Remote Interface Revision History 

V1.0 

First release. 

V1.1 

Added the following new commands: 

version 

loadtips 

unloadtips 

cyclecameratemp 

tempcontrolonoff 

washtips 

Error code response include text description after code, for example, c45, folder does not 
exist. 

V1.2 

Added Error Code: 

C01, Instrument is not in Remote Mode. Only status command can be sent while 

instrument is in Manual Mode. 

Bug Fix: 

Commands made to the remote interface could sometimes take a long time and cause the 

remote interface to not respond to the client application within an acceptable timeframe. 

Client applications were able to work around this bug with massive TCP/IP timeouts 

(minutes) which made a true hang or network dropout undetectable. This workaround is no 

longer required. 

The interface is unchanged, and if the client is correctly parsing the status response, no 

changes should be required in the client application, with the exception of reducing the 

TCP/IP timeout back to an acceptable value, for example, < 10 seconds. As always, rigorous 

regression testing of client code is encouraged. 

V1.3 

Added the following new commands to support new functionality in the Tetra Plus: 
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statusex 

configuration 

cellflaskcontrol 

washcellreservoir 

 

Barcode Specifications 

About Bar Codes 

The FLIPR Tetra system bar code scanner is an OEM module with decode capability to most 

commonly used bar code symbols in industry worldwide. The list includes: 

WPC (UPC /EAN/JAN 

IATA 

Code 39 

Interleaved 2 of 5 

Industrial 2 of 5 

Code 128 

Code 93 

MSI/Plessey 

Codabar (NW-7) 

Bar Code Recommendations 

The bar code reader implementation allows a bar code read down to 7.5 mil (0.20 mm) on 

photographic-quality symbols and ambient light < 450 ft-candles. 

We recommend, however, the user stay above 7.5 mil (0.26 mm) since most bar code 

printers might not have the resolution needed to match the required aspect ratio for a 

minimum of 3 mm-high symbol lines. Before adjusting the bar code scanner to the bar code 

label location on the microplate, some general guidelines to the preparation and quality of 

the bar code label need to be followed for optimum performance: 

The minimum height or size of the symbol bars depends on the code symbol and the 

density used. Try to keep the height of the symbol bars to more than 0.12 in. (3.0 mm). 

Do not change the aspect ratio required by the label printer. Do not force the bar code 

symbol size to fit on your label space i.e., maintain the aspect ratio free of distortion. 

Align the bars horizontally (side-to-side) and vertically (top-to-bottom) if possible, to 

keep space available on the bar code label. 

Note: Tips location has changed from the Source 3 location to the Source 1 location. 
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Keep a few millimeters (2–4) of empty dead or silent zone on both ends of the code- 

symbol lines. Keep all symbol lines away from the label corners and lifted edges. 

Optimize your characters so there is no need to cram a lot of lines on the label. 

Keep the longitudinal dimension of the labels/symbols to less that 1.25–1.50 in. (30–40 

mm). 

Choose the media (label substrate material or paper) print or transfer ink to give good 

contrast and optimal reflection. Metalized, very shiny or clear background labels may be 

less reliable. Test a sample if using a new color or surface material. 

Bar Code Specifications 
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Appendix B: Data Processing Algorithms 
 
 

This appendix uses results of a hypothetical experiment to describe the algorithms that can 

be used to adjust data. These options are all applied from the Correction dialog. 
 

Hypothetical Experiment 

Consider the results from an experiment consisting of wells A1–A9. The wells are classified 

into three groups: 

A1–A3: Negative Control Wells (–Ctrl). These wells contain the same dye-loaded cells and 

buffers as the other wells, yet are not exposed to a stimulus. 

A4–A6: Experimental Wells (Exp). These cells receive the experimental stimulus. 

A7–A9: Positive Control Wells. (+Ctrl). These cells either (1) receive a stimulus known to 

elicit a predetermined response or (2) demonstrate the maximal activity from an agonist. 

In the following experiment, six samples, also known as pictures, readings, or frames, were 

taken at five second intervals. After Sample 3 was taken, buffer, with or without stimulus, 

was added to the wells. 
 

Note: The longer time between readings 3 and 4. This time includes the time 

necessary for the 96-well pipettor to transfer liquids from the source plate to the cell 

plate and is automatically corrected for by the FLIPR Tetra system. 

The data presented is in the same format as the export data files generated using the 

FLIPR Tetra system software. In this example, only nine wells are considered. 

In Table B-1, the results of the experiment are presented without Spatial Uniformity 

Correction, Negative Control Correction, Positive Control Scaling, or Subtract Bias Value. 

Table B-1: Hypothetical Experiment 

Sample Time Well 

A1 – 

Ctrl 

 
 

A2 – 

Ctrl 

 
 

3 – 

Ctrl 

 
 

A4 Exp 

 
 

A5 Exp 

 
 

A6 Exp 

 
 

A7 + 

Ctrl 

 
 

A8 + 

Ctrl 

 
 

A9 + 

Ctrl 

1 0 8000 8500 9500 8200 9200 8800 1000 9500 8700 

2 5 8200 8600 9400 8300 9000 9000 9500 9700 9000 

3 10 8400 8500 9200 8500 9000 9100 9700 9700 9400 

4 20 8600 8400 9200 45000 50000 42000 57000 52000 54000 

5 25 8600 8800 9200 37000 42000 35000 53000 50000 50000 

6 30 8800 8500 9500 30000 25000 29000 50000 51000 50000 

B 
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An inspection of the fluorescence counts taken at Sample 1 (time = 0) shows some inter-well 

variability (range 8000–10000). Variability can be the result of differences in cell density or well 

positions (so-called ‘edge effects’ where cells on the outside of the plate are less dense than 

their internal neighbors), dye loading, non-uniform illumination, buffer variations or any 

other effect which is constant throughout the experimental run. These variations can 

complicate data interpretation. 
 

Determining Crosstalk Correction 

The crosstalk correction algorithm compensates for light from one well affecting the read out 

from a neighboring well. 

If the middle well in the drawing below was empty and the eight wells surrounding it would 

have signal, the middle well would show up as having a certain value based on the amount of 

light crossing over from each of it’s neighbors. The percentage of crosstalk from wells directly 

next to (B) the well of interest is assumed to be different from the percentage of the 

crosstalk from the wells diagonal (A) from the well of interest, therefore these two values are 

entered for the crosstalk correction. In this calculation, only the immediate neighboring wells 

are assumed to impact the middle well. 

When the crosstalk correction is applied, the Horizontal/Vertical factor and the Diagonal 

Factor are applied in a matrix, which automatically subtracts the percentage of each of the 

neighboring well’s value from the middle well’s value. If the crosstalk correction option is 

selected it will be the first correction applied to the data. Crosstalk correction is done in real 

time and no resulting data will be stored. it is recommended to test this correction during 

assay optimization. 
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Determining Spatial Uniformity Correction 

The spatial uniformity correction algorithm compensates, to a certain extent, for of the 

above-mentioned variations using a correction factor applied to all plate wells and samples. 

The correction factor is derived by calculating the mean fluorescence counts of all wells at 

Sample 1, for example: 

Table B-2: Correction Factor 

Sample Time Well 

A1 – 

Ctrl 

 
 

A2 – 

Ctrl 

 
 

A3 – 

Ctrl 

 
 

A4 

Exp 

 
 

A5 

Exp 

 
 

A6 

Exp 

 
 

A7 + 

Ctrl 

 
 

A8 + 

Ctrl 

 
 

A9 + 

Ctrl 

1 0 8000 8500 9500 8200 9200 8800 10000 9500 8700 

 

Mean (A1-A9) 8933          

Spatial Uniformity Correction Factor Calculation (Mean/Well) 

 

Well- Specific 

Correction Factor 

 A1 A2 A3 A4 A5 A6 A7 A8 A9 

 1.12 1.05 0.94 1.09 0.95 1.02 0.89 0.94 1.03 

 
Note: In actual practice, data from all 96 wells are included in the calculations, but in 

this example, data from only nine wells are presented, to simplify the example. 

Each well-specific spatial uniformity correction factor is calculated by dividing the mean 

fluorescence counts of all wells by the fluorescence counts of each well (taken at Sample 1.) 

The table above also presents the correction factor for wells A1–A9. 

All samples taken from a particular well are multiplied by their well-specific correction factor. 

For example, all samples from A1 are multiplied by 1.12, A2 by 1.05, and so on. 

The results of applying the spatial uniformity correction factor are presented in the table 

below. Note the decreased variability range of wells A1–A9 in Sample 1 (8900–8976) as 

compared to the same data prior to applying the correction algorithm (8000–10000). 

Table B-3: Spatial Uniformity Correction factor 

Sample Time Well 

A1 – 

Ctrl 

 
 

A2 – 

Ctrl 

 
 

3 – 

Ctrl 

 
 

A4 Exp 

 
 

A5 Exp 

 
 

A6 Exp 

 
 

A7 + 

Ctrl 

 
 

A8 + 

Ctrl 

 
 

A9 + 

Ctrl 

1 0 8960 8925 8930 8938 8924 8976 8900 8930 8961 

2 5 9194 9030 8836 9047 8730 9180 8455 9118 9270 

3 10 9408 8925 8648 9265 8730 9282 8633 9118 9682 

4 20 9632 8820 8648 49050 48500 42840 50730 48880 55620 
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Table B-3: Spatial Uniformity Correction factor (continued) 

Sample Time Well 

A1 – 

Ctrl 

 
 

A2 – 

Ctrl 

 
 

3 – 

Ctrl 

 
 

A4 Exp 

 
 

A5 Exp 

 
 

A6 Exp 

 
 

A7 + 

Ctrl 

 
 

A8 + 

Ctrl 

 
 

A9 + 

Ctrl 

5 25 9632 9240 8648 40330 40740 35700 47170 47000 51500 

6 30 9856 8925 8930 32700 33950 29580 44500 47940 51500 

If the spatial uniformity correction factor is applied to plates with empty wells, non dye- 

loaded cells, or a panel of cells containing different dyes and/or dye concentrations, the well- 

specific fluorescence counts are skewed by the correction factor. However, the EC50 of the 

agonists tested are not affected. 
 

Determining Negative Control Correction 

The negative control correction algorithm corrects for changes in fluorescence that occur in 

all wells over the course of the experiment. Causes for these changes in fluctuations in 

fluorescence include dye leakage from cells, fluid addition artifacts, changes in illumination 

power, dye photo-bleaching, and temperature drifts. 

The negative control correction factor is derived by first calculating the mean fluorescence of 

each of the samples of the negative control wells. 
 

Sample Time Well 

A1 – Ctrl 

 
 

A2 – Ctrl 

 
 

3 – Ctrl 

 
 

Mean 

 
 

Correction Factor 

1 0 8960 8925 8930 8938 1.00 

2 5 9194 9030 8836 9017 0.99 

3 10 9408 8925 8648 8994 0.99 

4 20 9632 8820 8648 9033 0.99 

5 25 9632 9240 8648 9173 0.97 

6 30 9856 8925 8930 9237 0.997 

The mean of Sample 1 is divided by the mean of each of the samples to give the sample- 

specific correction factor. Each sample is multiplied by its sample-specific correction factor. 
 

Sample Time Well 

A1 – 

Ctrl 

 
 

A2 – 

Ctrl 

 
 

3 – 

Ctrl 

 
 

A4 Exp 

 
 

A5 Exp 

 
 

A6 Exp 

 
 

A7 + 

Ctrl 

 
 

A8 + 

Ctrl 

 
 

A9 + 

Ctrl 

1 0 8960 8925 8930 8938 8924 8976 8900 8930 8961 

2 5 9194 8940 8748 8957 8643 9088 8370 9027 9177 

3 10 9314 8836 8562 9172 8643 9189 8547 9027 9585 

4 20 9536 8732 8562 48560 48015 42412 50223 48391 55064 
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Sample Time Well 

A1 – 

Ctrl 

 
 

A2 – 

Ctrl 

 
 

3 – 

Ctrl 

 
 

A4 Exp 

 
 

A5 Exp 

 
 

A6 Exp 

 
 

A7 + 

Ctrl 

 
 

A8 + 

Ctrl 

 
 

A9 + 

Ctrl 

5 25 9343 8963 8389 39120 39518 34629 45755 45590 49955 

6 30 9560 8657 8662 31719 32932 28693 43165 46502 49955 

For example, A1 Sample 1 is multiplied by 1.00. 
 

Note: The negative control correction factor wells contain the same cells and dyes as 

the experimental and positive control wells. 
 

Determining Positive Control Scaling 

The positive control algorithm compares the percent change in fluorescence counts of the 

positive control wells with all wells. This algorithm facilitates comparisons of results between 

data runs, such as different plates, by controlling factors such as cell density, cell response, 

laser power, or exposure time. This algorithm also makes EC50 comparisons easier. 

Calculate the means of all samples of the positive control wells. 
 

Sample Time Well 

A7 + Ctrl 

 
 

A8 + Ctrl 

 
 

A9 + Ctrl 

Mean Difference from Sample 1S 

1 0 8900 8930 8961 8930 0 

2 5 8370 9027 9177 8858 -72 

3 10 8547 9027 9053 9053 123 

4 20 50223 48391 55064 51226 42296 

5 25 45755 45590 49955 47100 38170 

6 30 43165 46502 49955 46541 37610 

The difference in fluorescence counts between Sample 1 and all of the samples is calculated. 

The greatest difference is determined. 100 is divided by the greatest difference in 

fluorescence counts to give the positive control correction factor, for example, 100/42296 = 

0.0024. All samples are multiplied by the correction factor 0.0024. 
 

Sample Time Well 

A1 – 

Ctrl 

 
 

A2 – 

Ctrl 

 
 

A3 – 

Ctrl 

 
 

A4 

Exp 

 
 

A5 

Exp 

 
 

A6 

Exp 

 
 

A7 + 

Ctrl 

 
 

A8 + 

Ctrl 

 
 

A9 + 

Ctrl 

1 0 21 21 21 21 21 21 21 21 21 

2 5 21 21 21 21 20 21 20 21 23 

3 10 22 21 20 22 20 22 20 21 23 

4 20 23 21 20 115 113 100 119 114 130 

5 25 22 21 20 92 93 82 108 108 118 
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Sample Time Well 

A1 – 

Ctrl 

 
 

A2 – 

Ctrl 

 
 

A3 – 

Ctrl 

 
 

A4 

Exp 

 
 

A5 

Exp 

 
 

A6 

Exp 

 
 

A7 + 

Ctrl 

 
 

A8 + 

Ctrl 

 
 

A9 + 

Ctrl 

6 30 23 20 20 75 78 68 1021 110 118 

 

Note: All wells, at samples 1–3, range from 20 to 23%. The positive control wells at 

Sample 4 range from 114 to 130% while the negative control wells remain at around 

20% throughout the experiment. 
 

Determining Subtract Bias 

The subtract bias algorithm determines the change in fluorescence over background 

fluorescence. The user determines the sample number chosen as background. This 

algorithm, by default, is always switched on and subtracts from Sample 1. The choice in the 

sample number to use as background depends on the assay conditions. For example, the 

addition of agonist can dilute the fluorescence signal in the supernatant, which would appear 

as a drop in fluorescence. In this case, the best choice for background is the sample taken at 

the bottom of this drop in fluorescence. 

In our example, the percent positive fluorescence at Sample 1 is around 20% for all wells. 

Subtracting the background at Sample 1 would make the data easier to interpret. 

Sample 1 (or any sample chosen by the operator) from each well is subtracted from the 

samples from the same well. 
 

Time Well A1 – 

Ctrl 

A2 – 

Ctrl 

A3 – 

Ctrl 

A4 Exp A5 Exp A6 Exp A7 + 

Ctrl 

A8 + 

Ctrl 

A9 + 

Ctrl 

1 0          

2 5         1 

3 10 1   1     1 

4 20 1   94 92 79 98 93 109 

5 25 1   71 72 61 87 87 97 

6 30 1   54 57 47 81 89 97 

The results show only numbers above zero. The subtract bias algorithm places the data in a 

readily interpretable form. The positive control wells at Sample 4 range from 93–109% 

positive. In contrast, the negative control wells remain close to zero percent positive 

throughout the experiment. The experimental wells show two wells with about 90% activity 

and one with 79% activity at Sample 4. 
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Determining Response Over Baseline 

The response over baseline correction algorithm compensates, to a certain extent, for 

variations within a single well. 

The correction factor is derived by calculating the mean fluorescence counts in each well 

between the baseline start and end samples. 
 

Sample Time Well 

A1 – 

Ctrl 

 
 

A2 – 

Ctrl 

 
 

A3 – 

Ctrl 

 
 

A4 

Exp 

 
 

A5 

Exp 

 
 

A6 

Exp 

 
 

A7 + 

Ctrl 

 
 

A8 + 

Ctrl 

 
 

A9 + 

Ctrl 

1 0 8000 8500 9500 8200 9200 8800 10000 9500 8700 

2 5 8200 8600 9400 8300 9000 9000 9500 9700 9000 

3 10 8400 8500 9200 8500 9000 9100 9700 9700 9400 

Mean 8200 8533 9367 8333 9067 8967 9733 9633 9033 

 

Note: In actual practice, data from all 96-wells are included in the calculations, but in 

this example, data from only nine wells are presented, to simplify the examples. 

All samples taken from a particular well are divided by their well-specific mean baseline 

correction factor. For example, all samples from A1 are divided by 8200, A2 by 8533, and so 

on. 

The results of applying the response over baseline correction factor are presented in the 

table below. Note the data is displayed is displayed as a fold increase of the response 

compared to the baseline with Sample values ranging in the single digits (0–6). 
 

Sample Time Well 

A1 – 

Ctrl 

 
 

A2 – 

Ctrl 

 
 

A3 – 

Ctrl 

 
 

A4 

Exp 

 
 

A5 

Exp 

 
 

A6 

Exp 

 
 

A7 + 

Ctrl 

 
 

A8 + 

Ctrl 

 
 

A9 + 

Ctrl 

1 0 0.98 1.00 1.01 0.98 1.01 0.98 1.03 0.99 0.96 

2 5 1.00 1.01 1.00 1.00 0.99 1.00 0.98 1.01 1.00 

3 10 1.02 1.00 0.98 1.02 0.99 1.00 0.98 1.01 1.00 

4 20 1.05 0.98 0.98 5.4 5.51 4.68 5.86 5.40 5.98 

5 25 1.05 1.03 0.98 4.44 4.63 3.90 5.45 5.195 5.54 

6 30 1.07 1.00 1.01 3.60 2.76 3.23 5.14 5.29 5.54 
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Appendix C: Consumables and Accessories 
 
 

This following catalogs consumables used with the FLIPR Tetra system, including: 

System Accessories on page 245 

Plates on page 248 

Assays on page 252 

Recommended Assay Equipment and Supplies on page 253 
 

System Accessories 

Field Installations 

Table C-1: 

Item Suggested Supplier    Phone Number Item Number 

FLIPR® Tetra system Camera 

Conversion Kit, EMCCD to ICCD 

Molecular Devices +1-800-635-5577 0310-5285 

FLIPR® Tetra system Cell 

Suspension, Field Installation Kit 

Molecular Devices +1-800-635-5577 0310-5339 

FLIPR® Tetra system TETRAcycler Molecular Devices +1-800-635-5577 Tetra+Cycler 

 

Pipettor Heads 

Table C-2: 

Item Suggested Supplier Phone Number Item Number 

FLIPR® Tetra system Pipettor Head Molecular Devices +1-800-635-5577 0200-6071 

Kit, 96  +1-408-747-1700  

FLIPR® Tetra system Pipettor Head Molecular Devices +1-800-635-5577 0200-6072 

Kit, 384  +1-408-747-1700  

FLIPR® Tetra system Pipettor Head Molecular Devices +1-800-635-5577 0200-6073 

Kit, 1536  +1-408-747-1700  

1 

FLIPR® Tetra system Pin Tool Head Molecular Devices +1-800-635-5577 384 Pin Tool Head 

Kit, 384  +1-408-747-1700 Kit 
1 

FLIPR® Tetra system Pin Tool Head Molecular Devices +1-800-635-5577 1536 Pin Tool Head 

Kit, 1536  +1-408-747-1700 Kit 

1. Contact your local Molecular Devices Sales Representative for details regarding this 

configure-to- order item. 

C 
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Optics Consumables 

Table C-3: 

Item Suggested Supplier Phone Number Item Number 

FLIPR® Tetra system Calcium Molecular Devices +1-800-635-5577 0200-6206 

Optics Kit  +1-408-747-1700  

FLIPR® Tetra system Membrane Molecular Devices +1-800-635-5577 0200-6207 

Potential Optics Kit  +1-408-747-1700  

FLIPR® Tetra system Voltage Molecular Devices +1-800-635-5577 0200-6208 

Sensor Probes (VSP) Optics Kit  +1-408-747-1700  

FLIPR® Tetra system Fura-2 Optics Molecular Devices +1-800-635-5577 0200-6271 

Kit  +1-408-747-1700  

FLIPR® Tetra system LED Module, Molecular Devices +1-800-635-5577 0200-6272 

335–345 nm (UV)  +1-408-747-1700  

FLIPR® Tetra system LED Module, Molecular Devices +1-800-635-5577 0200-6178 

360–380 nm  +1-408-747-1700  

FLIPR® Tetra system LED Module, Molecular Devices +1-800-635-5577 0200-6273 

380–390 nm (UV)  +1-408-747-1700  

FLIPR® Tetra system LED Module, Molecular Devices +1-800-635-5577 0200-6135 

390–420 nm (VSP)  +1-408-747-1700  

FLIPR® Tetra system LED Module, Molecular Devices +1-800-635-5577 0200-6148 

420–455 nm  +1-408-747-1700  

FLIPR® Tetra system LED Module, Molecular Devices +1-800-635-5577 0200-6128 

470–495 nm (Calcium)  +1-408-747-1700  

FLIPR® Tetra system LED Module, Molecular Devices +1-800-635-5577 0200-6175 

495–505 nm  +1-408-747-1700  

FLIPR® Tetra system LED Module, Molecular Devices +1-800-635-5577 0200-6127 

510–545 nm (Membrane  +1-408-747-1700  

Potential)    

FLIPR® Tetra system LED Module, Molecular Devices +1-800-635-5577 0200-6150 

610–626 nm  +1-408-747-1700  

FLIPR® Tetra system Emission Molecular Devices +1-800-635-5577 0200-6213 

Filter, 400–460 nm  +1-408-747-1700  

FLIPR® Tetra system Emission Molecular Devices +1-800-635-5577 0200-6205 

Filter, 440–480 nm (VSP)  +1-408-747-1700  

FLIPR® Tetra system Emission Molecular Devices +1-800-635-5577 0200-6211 

Filter, 475–535 nm  +1-408-747-1700  
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Table C-3: (continued) 

Item Suggested Supplier Phone Number Item Number 

FLIPR® Tetra system Emission Molecular Devices +1-800-635-5577 0200-6203 

Filter, 515–575 nm (Calcium)  +1-408-747-1700  

FLIPR® Tetra system Emission Molecular Devices +1-800-635-5577 0200-6212 

Filter, 526–586 nm  +1-408-747-1700  

FLIPR® Tetra system Emission Molecular Devices +1-800-635-5577 0200-6204 

Filter, 565–625 nm (Membrane  +1-408-747-1700  

Potential and VSP)    

FLIPR® Tetra system Emission Molecular Devices +1-800-635-5577 0200-6214 

Filter, 646–706 nm  +1-408-747-1700  

FLIPR® Tetra system Custom Filter Molecular Devices +1-800-635-5577 0200-6221 

Set (3)  +1-408-747-1700  

FLIPR® Tetra system Single Custom Molecular Devices +1-800-635-5577 0200-6276 

Filter Holder (1)  +1-408-747-1700  

 

Pipetting Consumables 

Table C-4: 

Item Suggested Supplier Phone Number Item Number 

FLIPR® Tetra system pipette tips, Molecular Devices +1-800-635-5577 9000-0762 

black, non-sterile, 96-well, 50  +1-408-747-1700  

racks/case    

FLIPR® Tetra system pipette tips, Molecular Devices +1-800-635-5577 9000-0761 

clear, non-sterile, 96-well, 50  +1-408-747-1700  

racks/case    

FLIPR® Tetra system non-sterile, Molecular Devices +1-800-635-5577 9000-0764 

384-well, 50 racks/case  +1-408-747-1700  

FLIPR® Tetra system pipette tips, Molecular Devices +1-800-635-5577 9000-0763 

clear, non-sterile, 384-well, 50  +1-408-747-1700  

racks/case    

FLIPR® Tetra system 1536 tip Molecular Devices +1-800-635-5577 9000-0746 

gasket, nonsterile, 40 racks/case  +1-408-747-1700  

FLIPR® Tetra system 1536 tip block Molecular Devices +1-800-635-5577 

+1-408-747-1700 

0200-6112 

1 

FLIPR® Tetra system Pin Tool, 384 Molecular Devices +1-800-635-5577 384 Pin Tool 

  +1-408-747-1700  
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Table C-4: (continued) 

Item Suggested Supplier Phone Number Item Number 
1 

FLIPR® Tetra system Pin Tool, Molecular Devices +1-800-635-5577 1536 Pin Tool 

1536  +1-408-747-1700  

1. Contact your local Molecular Devices Sales Representative for details regarding this 

configure-to- order item. 

 

Cell Reservoir Consumables 

Table C-5: 

Item Suggested Supplier Phone Number Item Number 

FLIPR® Tetra system Cell 

Suspension Reservoir 

Molecular Devices +1-800-635-5577 

+1-408-747-1700 

0200-6222 

FLIPR® Tetra system 250 mL 

Spinner Flask Assembly 

Molecular Devices +1-800-635-5577 

+1-408-747-1700 

0200-6223 

FLIPR® Tetra system 500 mL 

Spinner Flask Assembly 

Molecular Devices +1-800-635-5577 

+1-408-747-1700 

0200-6224 

FLIPR® Tetra system 1 L Spinner 

Flask Assembly 

Molecular Devices +1-800-635-5577 

+1-408-747-1700 

0200-6225 

FLIPR® Tetra system 3 L Spinner 

Flask Assembly 

Molecular Devices +1-800-635-5577 

+1-408-747-1700 

0200-6226 

FLIPR® Tetra system 1 L Spinner 

Flask Assembly 

Molecular Devices +1-800-635-5577 

+1-408-747-1700 

0200-6227 

 

Plates  

96-Well Read Plates 

Table C-6: 

96-Well Read Plates Suggested Supplier Phone Number Item Number 

Black, clear, tissue culture 

treated, sterile 

Becton Dickinson +1-800-343-2035 353948 

Corning/Costar +1-800-492-1110 3603 

Greiner (distributed 

by E&K) 

+1-408-378-2013 655090 

Nalge/Nunc +1-800-766-7000 165305 

Black, clear, tissue culture 

treated, sterile, poly-D-lysine 

coated 

Becton Dickinson +1-800-343-2035 356640 

Corning/Costar +1-800-492-1110 3667 



0112-0109 K 249 

Appendix C: Consumables and Accessories 
 

 

 

Table C-6: (continued) 

96-Well Read Plates Suggested Supplier Phone Number Item Number 

Black, clear, tissue culture 

treated, sterile, collagen coated 

Becton Dickinson +1-800-492-1110 356649 

White, clear, tissue culture 

treated, sterile 

Becton Dickinson +1-800-343-2035 353947 

Corning/Costar +1-800-492-1110 3903 

Greiner (distributed 

by E&K) 

+1-408-378-2013 655098 

Nalge/Nunc +1-800-766-7000 165306 

 

96-Well Read Plate Masks 

Table C-7: 

96-Well Read Plate Masks Manufacturer Item # 

96-well slit mask Becton Dickinson 0200-6143 

Corning/Costar 2300-1362 

Nalge/Nunc 0200-6142 

 

96-Well Source Plates 

Table C-8: 

96-Well Source Plates Suggested Supplier Phone Number Item Number 

V-bottom plate, 96-well Becton Dickinson +1-800-343-2035 353263 

polypropylene 

Greiner (distributed 

by E&K) 

+1-408-378-2013 651201 

polypropylene 

Nalge/Nunc +1-800-766-7000 249944 

U-bottomed plate, 96-well Becton Dickinson +1-800-343-2035 351190 

polypropylene 

Corning/Costar +1-800-492-1110 3365 polypropylene 

Nalge/Nunc +1-800-766-7000 267245 

Greiner (distributed 

by E&K) 

+1-408-378-2013 650201 

polypropylene 
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Table C-8: (continued) 

96-Well Source Plates Suggested Supplier Phone Number Item Number 

Deep-well plate, 96-well Becton Dickinson +1-800-343-2035 353966 

polypropylene 

Greiner (distributed 

by E&K) 

+1-408-378-2013 780270 

polypropylene 

Nalge/Nunc +1-800-766-7000 278752 

polypropylene 

 

384-Well Read Plates 

Table C-9: 

384-Well Read Plates Suggested Supplier Phone Number Item Number 

Black, clear, tissue culture 

treated, sterile 

Becton Dickinson +1-800-343-2035 353262 

Corning/Costar +1-800-492-1110 3712 

Greiner with lids 

(distributed by E&K) 

+1-408-378-2013 781091 

Matrical +1-509-343-6225 MGB101-1-2 

Matrical +1-509-343-6225 MGB101-1-3 0.17 

mm-thick glass 

Nalge/Nunc +1-800-766-7000 142761 

Black, clear bottom, tissue 

culture treated, sterile, poly-D- 

lysine coated 

Becton Dickinson +1-800-343-2035 356663 

Corning/Costar  3664 

Black, clear, tissue culture 

treated, sterile, collagen coated 

Becton Dickinson +1-800-343-2035 356667 

White, clear, tissue culture 

treated, sterile 

Becton Dickinson +1-800-343-2035 353963 

Corning/Costar +1-800-492-1110 3707 

Greiner (distributed 

by E&K) 

+1-408-378-2013 781098 

Nalge/Nunc +1-800-766-7000 142762 

Low volume black, clear, tissue 

culture treated, sterile 

Corning/Costar +1-800-492-1110 3542 

Greiner (distributed 

by E&K) 

+1-408-378-2013 788092 
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384-Well Source Plates 

Table C-10: 

384-Well Source Plates Suggested Supplier Phone Number Item Number 

Flat bottom plate Becton Dickinson +1-800-343-2035 353265 

polypropylene 

Corning/Costar +1-800-492-1110 3702 polystyrene 

Greiner (distributed 

by E&K) 

+1-408-378-2013 781201 

polypropylene 

Nalge/Nunc +1-800-766-7000 265496 polystyrene 

UV-bottom plate Corning/Costar +1-800-492-1110 3657 polypropylene 

Greiner (distributed 

by E&K) 

+1-408-378-2013 781280 

polypropylene 

Nalge/Nunc +1-800-766-7000 264573 

polypropylene 

Deep-well plate Becton Dickinson +1-800-343-2035 353996 

polypropylene 

Corning/Costar +1-800-492-1110 3965 polypropylene 

Greiner (distributed 

by E&K) 

+1-408-378-2013 781270 

polypropylene 

Matrical +1-509-343-6225 MP102 

polypropylene 

 

1536-Well Read Plates 

Table C-11: 

1536-Well Read Plates Suggested Supplier Phone Number Item Number 

Black/Clear, tissue culture treated, Greiner with lids +1-408-378- 783092 

sterile (distributed by E&K) 2013  

White/Clear, tissue culture treated, Greiner (distributed by +1-408-378- 781098 

sterile E&K) 2013  

 

1536-Well Source Plates 

Table C-12: 

1536-Well Source Plates Suggested Supplier Phone Number Item Number 

Deep-well plate Greiner (distributed 

by E&K) 

+1-408-378-2013 782270 

polypropylene 



FLIPR Tetra High Throughput Cellular Screening System User Guide 

252 0112-0109 K 

 

 

 

 

Source Reservoirs 

Table C-13: 

Source Reservoirs Suggested Supplier Phone Number Item Number 

Omni tray Nalge/Nunc +1-800-786-7000 2428110 

polystyrene 

 

Assays  

Calcium Flux Consumables 

Table C-14: 

Item Suggested Supplier Phone Number Item Number 

FLIPR® Calcium 5 Assay Kit: Molecular Devices +1-800-635-5577  

Bulk Kit  +1-408-747-1700 R8186 

Explorer Kit   R8185 

Express Kit   R8187 

FLIPR® Calcium 4 Assay Kit: Molecular Devices +1-800-635-5577  

Bulk Kit  +1-408-747-1700 R8141 

Explorer Kit   R8142 

Express Kit   R8143 

FLIPR® Calcium 3 Assay Kit: Molecular Devices +1-800-635-5577  

Bulk Kit  +1-408-747-1700 R8090 

Explorer Kit   R8091 

Express Kit   R8108 

FLIPR® Calcium Assay Kit: Molecular Devices +1-800-635-5577  

Bulk Kit  +1-408-747-1700 R8033 

FLIPR® Tetra system Calcium Optics 

Kit: 

Molecular Devices +1-800-635-5577 

+1-408-747-1700 

0200- 6206 

FLIPR® Tetra system LED Module, 

470-495 nm 

FLIPR® Tetra system Emission Filter, 

515-575 nm 

   

Hank’s Balanced Salt Solution (10X 

stock) 

Gibco +1-800-828-6686 14065- 056 

HEPES buffer solution 1X Irvine Scientific +1-800-437-5706 9319 

Probenecid, crystalline Sigma +1-800-325-3010 P8761 

Carbachol (receptormediated 

positive control) 

Sigma +1-800-325-3010 C4382 



Appendix C: Consumables and Accessories 

0112-0109 K 253 

 

 

 

Table C-14: (continued) 

Item Suggested Supplier Phone Number Item Number 

UTP, Na salt (receptormediated 

positive control) 

Sigma +1-800-325-3010 U6625 

Ionomycin (positive control) CalBiochem +1-800-854-3417 407950 

 

Membrane Potential Assay Kit Consumables 

Table C-15: 

Item Suggested Supplier Phone Number Item Number 

FLIPR® Membrane Potential Assay Molecular Devices +1-800-635-5577 R8034 (BLUE) 

Kit  +1-408-747-1700 R8123 (RED) 

FLIPR® Tetra system Membrane 

Potential Kit: 

Molecular Devices +1-800-635-5577 

+1-408-747-1700 

0200-6207 

FLIPR® Tetra system LED Module, 

470–495 nm 

FLIPR® Tetra system Emission 

Filter, 515–575 nm 

   

Hank’s Balanced Salt Solution (10X 

stock) 

Gibco +1-800-828-6686 14065-056 

HEPES buffer solution 1X Irvine Scientific +1-800-437-5706 9319 

Carbachol (receptor-mediated 

positive control) 

Sigma +1-800-325-3010 C4382 

 

Recommended Assay Equipment and Supplies 
 

AquaMax® DW4 96/384/1536 Dispenser/Washer, Molecular Devices 

5 mL, 10 mL, 25 mL sterile serological pipettes 

Rechargeable pipettor for 2–25 mL pipettes 

Sterile tissue culture water. 

Gloves 

Culture medium to grow cells 

EDTA and Trypsin/EDTA to lift cells 

Hemacytometer and counter 

Sterile test tubes 15 mL and 50 mL or smaller tubes for compounds dilutions 

1 N NaOH solution to dissolve probenecid 
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Appendix D: Using AquaMax Sterilant 
 
 

AquaMax Sterilant can be used to clean and sterilize the fluid paths in the Cell Reservoir and 

Cell Suspension module. 
 

Principle of Use 

Accumulated residues and contaminating microorganisms have the potential for causing 

significant adverse effects on the operation of liquid handling equipment. Proteins in cell 

culture media, salts and minerals in buffers and other reagent components used in liquid 

handling equipment can build up on fluid path surfaces, clogging channels and probes 

resulting in incomplete or inaccurate dispensing and aspiration of liquids. In addition, 

microorganisms such as bacteria, fungi and molds can also accumulate in the fluid path 

creating similar fouling problems. Simply flushing the fluid path with water or ethanol/water 

solutions is often ineffective in the removal of residue. 

AquaMax Sterilant was developed for the purpose of removing organic and inorganic 

material, and killing microorganisms, including endospores, in liquid handling instrument 

fluid paths. In addition, AquaMax simultaneously removes endotoxin from the fluid paths. 

Endotoxin is a substance produced by Gram negative bacteria that is known to cause a 

variety of significant cellular reactions in vitro, including cell activation and death. Thus 

minimizing the amount of endotoxin in fluid paths is necessary in order to avoid detachment 

and adverse effects on mammalian cells during the course of subsequent experiments. A 

two-hour treatment with AquaMax will substantially remove endotoxin adhering to interior 

fluid path surfaces. 
 

Contents 
 

4X Concentrated Solution A: detergent in buffered aqueous solution (2 x 1 L bottles) 

Solution B: sodium hypochlorite in aqueous solution (2 x 14 mL bottles) [16 500 mL DW4 

washes] 

 

Materials Required but Not Provided 
 

Deionized water 

250 mL graduated cylinder 

1 L beaker, bottle or flask 

2 mL pipettor 

D 
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Storage  
 

The unopened kit package can be stored at room temperature (between 10 °C/50 °F and 40 

°C/104 °F). 

After opening the kit, store 4X Concentrated Solution A and 1X Solution A (prepared by 

mixing 1 volume of 4X Concentrate Solution A with 3 volumes of deionized water) between 

10 °C/50 °F and 40 °C/104 °F. 

After opening the kit, store the tightly capped bottle of Solution B between 2 °C/35.6 °F and 8 

°C/46.4 °F. Avoid freezing any of the solutions. 
 

Reagent Preparation 

500 mL Sterilant is sufficient to run the automated cleaning cycle on the AquaMax DW4 liquid 

handling system. 

1X Solution A can be stored for 30 days in a capped bottle between 10 °C/50 °F and 40 °C/104 

°F. 

Preparation of 500 mL 1X Solution A 

Combine 125 mL of 4X Concentrate Solution A and 375 mL deionized water in a 1 L beaker, 

bottle or flask and mix thoroughly. 

For other needed volumes: 

Add 1 part of 4X Concentrate Solution A and 3 parts deionized water. 

Preparation of Complete Sterilant: 

Within 1 hour of use, add 0.2% (final v/v) Solution B to 1X Solution A and mix thoroughly. 

For 500 mL of complete Sterilant: 

Use 1 mL of Solution B. 
 

Reagent Use 

Follow the recommended cleaning procedures in the user guide for the specific liquid 

handling instrument to be cleaned. 

For stubborn cleaning situations, the Sterilant must sit static in the fluid path for 30 minutes 

half-way through the cleaning cycle before continuing to completion. 

For endotoxin removal, the Sterilant must sit static in the fluid path for 2 hours half-way 

through the cleaning cycle before continuing to completion. 

Rinse the fluid path with at least twice the volume of deionized water immediately after 

cleaning. 
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Warnings, Precautions and Limitations 

For research use only. 

When handling these reagents, gloves and eye protection must be worn. 

Do not ingest. 

Use in a well ventilated environment. 

For more safety information, see the Material Safety Data Sheet for Solutions A and B. 

As supplied, Solution A might not be sterile. 

The following information is being provided in compliance with Worker and Community 

Right-To-Know Regulations: 

Solution A, 4X Concentrate 

Chemical Composition 

The chemical composition of this solution is a trade secret and proprietary property of 

Molecular Devices. 

Solution B 

Chemical Composition, CAS # 

Sodium Hypochlorite, Solution, 7681-52-9 
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Appendix E: Electromagnetic Compatibility 
 
 

Regulatory for Canada (ICES/NMB-001:2006) 

This ISM device complies with Canadian ICES-001. 

Cet appareil ISM est confomre à la norme NMB-001 du Canada. 

ISM Equipment Classification (Group 1, Class A) 

This equipment is designated as scientific equipment for laboratory use that intentionally 

generate and/or use conductively coupled radio-frequency energy for internal functioning, 

and are suitable for use in all establishments, other than domestic and those directly 

connected to a low voltage power supply network which supply buildings used for domestic 

purposes. 

Information to the User (FCC Notice) 

This equipment has been tested and found to comply with the limits for a Class A digital 

device, pursuant to part 18 of the FCC Rules. These limits are designed to provide reasonable 

protection against harmful interference when the equipment is operated in a commercial 

environment. This equipment generates, uses, and can radiate radio frequency energy and, 

if not installed and used in accordance with the instruction manual, may cause harmful 

interference to radio communications. Operation of this equipment in a residential area is 

likely to cause harmful interference in which case the user will be required to correct the 

interference at their own expense. Changes or modifications made to this equipment not 

expressly approved by the party responsible for compliance may void the FCC authorization 

to operate this equipment. 
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